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Preface
This manual explains for the following program products, focusing on their remote control facilities and how to use them.

• Job Management Partner 1/Remote Control Manager

• Job Management Partner 1/Remote Control Agent

• Job Management Partner 1/Software Distribution Manager

• Job Management Partner 1/Software Distribution Client

Note
In this manual, JP1 is an abbreviation for Job Management Partner 1.

This manual refers to JP1/Remote Control Manager and JP1/Remote Control Agent as JP1/Remote Control collectively. It
also refers to JP1/Software Distribution Manager and JP1/Software Distribution Client as JP1/Software Distribution
collectively.

■ Intended readers
This manual is intended for the following persons:

• Remote Control or JP1/Software Distribution users who perform remote control operations on remote machines from a
local machine via a network.

• Users who have a basic knowledge of Microsoft Windows operations

■ Organization of this manual
This manual is organized as follows:

1. Overview
Gives an overview of remote control operations, including remote control features and characteristics.

2. Installation
Describes the installation prerequisites as well as how to install/uninstall JP1/Software Distribution (the remote control
component) and JP1/Remote Control.

3. Environment Setup
Describes the environment setup required for using the remote control facility.

4. Controller Operations
Describes how to operate the controller and provides items to be noted when remote control is in use.

5. Agent Operations
Describes how to operate the agent.

6. Using Chat
Describes the chat function, including an overview of the chat function and the method used when sending and receiving
messages. The chat component needs to be installed before the chat function can be used.

A. Menus
Describes the operations of the window menus in JP1/Remote Control.

B. Troubleshooting
Describes how to resolve problems and how to obtain the logs.

C. How to Use the Find Agent Facility
Describes the detailed settings required for using the Find Agent facility.

D. Notes on Using JP1/Remote Control in a Cluster System
Describes information to be noted when using JP1/Remote Control on a cluster system.

I



E. Available NAT Function
Describes the NAT function available in JP1/Remote Control.

F. Process Information
Describes information that is required when JP1/Performance Management/SNMP System Observer monitors JP1/Remote Control
processes.

G. Port Numbers
Describes port numbers that are used in JP1/Remote Control.

H. Combinations of Display Board Chip Sets and Drivers
Lists the combinations of display board chip sets and drivers for each OS compatible with the Agent.

I. Connection with a Security PC
Describes the operation of an agent to which a security PC has connected.

J. Setting Permissions for Access via the Network
Describes how to use Windows functions to set permissions for accessing Windows users and groups via a network.

K. Logging Format and Output Information
Describes the format of logs and the types of the output information.

L. Version Changes
Describes the changes of each version.

M. Glossary
Explains terms used in this manual.

■ Related publications
This manual is part of a related set of manuals. The manuals in the set are listed below (with the manual numbers):

• Job Management Partner 1/Software Distribution Description and Planning Guide (3020-3-S79(E)), for Windows
systems

• Job Management Partner 1/Software Distribution Setup Guide (3020-3-S80(E)), for Windows systems

• Job Management Partner 1/Software Distribution Administrator's Guide Volume 1 (3020-3-S81(E)), for Windows
systems

• Job Management Partner 1/Software Distribution Administrator's Guide Volume 2 (3020-3-S82(E)), for Windows
systems

• Job Management Partner 1/Performance Management/SNMP System Observer Description, Operator's Guide and
Reference (3020-3-T11(E))

■ About online help
JP1/Remote Control provides the online help. The contents of the online help are the same as this manual. From the online
help, you can search for items in the entire manual.

You can launch the online help from the Help menu of each window or the Help button of each dialog box in JP1/Remote
Control. You can view the online help as long as Microsoft Internet Explorer 5.01 or later is installed.

■ Conventions: Abbreviations for product names
This manual uses the following abbreviations for product names:

Abbreviation Full name or meaning

InstallShield InstallShield(R)

Itanium 2 Intel(R) Itanium(R) 2 processor
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Abbreviation Full name or meaning

JP1/IM JP1/IM - Manager Job Management Partner 1/Integrated
Management - Manager

JP1/IM - View Job Management Partner 1/Integrated
Management - View

JP1/Software Distribution JP1/Software Distribution Client Job Management Partner 1/Software
Distribution Client

JP1/Software Distribution
Manager

Job Management Partner 1/Software
Distribution Manager

Microsoft Internet Explorer Microsoft(R) Internet Explorer(R)

Windows(R) Internet Explorer(R)

Pentium Intel Pentium(R)

Windows Windows 2000 Windows 2000 Advanced
Server

Microsoft(R) Windows(R) 2000 Advanced
Server Operating System

Windows 2000 Datacenter
Server

Microsoft(R) Windows(R) 2000 Datacenter
Server Operating System

Windows 2000 Professional Microsoft(R) Windows(R) 2000 Professional
Operating System

Windows 2000 Server Microsoft(R) Windows(R) 2000 Server
Operating System

Windows 7 Microsoft(R) Windows(R) 7 Enterprise

Microsoft(R) Windows(R) 7 Professional

Microsoft(R) Windows(R) 7 Ultimate

Windows 8 Microsoft(R) Windows(R) 8

Microsoft(R) Windows(R) 8 Enterprise

Microsoft(R) Windows(R) 8 Pro

Windows 98 Microsoft(R) Windows(R) 98 Operating System

Windows Me Microsoft(R) Windows(R) Millennium Edition
Operating System

Windows NT 4.0 Windows NT Server 4.0 Microsoft(R) Windows NT(R) Server Network
Operating System Version 4.0

Windows NT Server Enterprise
Edition 4.0

Microsoft(R) Windows NT(R) Server Enterprise
Edition Version 4.0

Windows NT Workstation 4.0 Microsoft(R) Windows NT(R) Workstation
Operating System Version 4.0

Windows Server 2003 Windows Server 2003 Microsoft(R) Windows Server(R) 2003 R2,
Datacenter Edition

Microsoft(R) Windows Server(R) 2003 R2,
Enterprise Edition

Microsoft(R) Windows Server(R) 2003 R2,
Standard Edition

Microsoft(R) Windows Server(R) 2003,
Datacenter Edition

Microsoft(R) Windows Server(R) 2003,
Enterprise Edition
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Abbreviation Full name or meaning

Windows Windows Server 2003 Windows Server 2003 Microsoft(R) Windows Server(R) 2003,
Standard Edition

Windows Server 2003 (IPF) Microsoft(R) Windows Server(R) 2003,
Datacenter Edition for Itanium-based Systems

Microsoft(R) Windows Server(R) 2003,
Enterprise Edition for Itanium-based Systems

Windows Server 2003 (x64) Microsoft(R) Windows Server(R) 2003 R2,
Datacenter x64 Edition

Microsoft(R) Windows Server(R) 2003 R2,
Enterprise x64 Edition

Microsoft(R) Windows Server(R) 2003 R2,
Standard x64 Edition

Microsoft(R) Windows Server(R) 2003,
Datacenter x64 Edition

Microsoft(R) Windows Server(R) 2003,
Enterprise x64 Edition

Microsoft(R) Windows Server(R) 2003,
Standard x64 Edition

Windows Server 2008# Windows Server 2008 Microsoft(R) Windows Server(R) 2008
Datacenter

Microsoft(R) Windows Server(R) 2008
Datacenter without Hyper-V(R)

Microsoft(R) Windows Server(R) 2008
Enterprise

Microsoft(R) Windows Server(R) 2008
Enterprise without Hyper-V(R)

Microsoft(R) Windows Server(R) 2008
Standard

Microsoft(R) Windows Server(R) 2008
Standard without Hyper-V(R)

Windows Server 2008 R2 Microsoft(R) Windows Server(R) 2008 R2,
Datacenter

Microsoft(R) Windows Server(R) 2008 R2,
Enterprise

Microsoft(R) Windows Server(R) 2008 R2,
Standard

Windows Server 2012 Microsoft(R) Windows Server(R) 2012
Datacenter

Microsoft(R) Windows Server(R) 2012
Standard

Windows Vista Microsoft(R) Windows Vista(R) Business

Microsoft(R) Windows Vista(R) Enterprise

Microsoft(R) Windows Vista(R) Ultimate

Windows XP Windows XP Home Edition Microsoft(R) Windows(R) XP Home Edition
Operating System
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Abbreviation Full name or meaning

Windows Windows XP Windows XP Professional Microsoft(R) Windows(R) XP Professional
Operating System

Windows Media Player Windows Media(R) Player

#:
The Server Core version is not supported.

This manual uses Windows XP menu names to refer to menu names in Windows. Also note that there is no Start menu in
Windows 8 and Windows Server 2012; use All apps on the Start screen instead.

■ Conventions: Acronyms
This manual also uses the following acronyms:

Acronym Full name or meaning

AVI Audio - Video Interleaved

CD-ROM Compact Disc - Read Only Memory

CPU Central Processing Unit

CSV Comma Separated Values

DHCP Dynamic Host Configuration Protocol

DNS Domain Name System

GUI Graphical User Interface

IPF Itanium(R) Processor Family

LAN Local Area Network

NAT Network Address Translation

OS Operating System

PC Personal Computer

RAM Random Access Memory

RAS Remote Access Service

TCP/IP Transmission Control Protocol/Internet Protocol

TSV Tab Separated Values

VGA Video Graphics Array

WAN Wide Area Network

■ Conventions: Diagrams
This manual uses the following conventions in diagrams:
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■ Conventions: Fonts and symbols
The following table explains the fonts used in this manual:

Font Convention

Bold Bold type indicates text on a window, other than the window title. Such text includes menus, menu
options, buttons, radio box options, or explanatory labels. For example:

• From the File menu, choose Open.

• Click the Cancel button.

• In the Enter name entry box, type your name.

Italics Italics are used to indicate a placeholder for some actual text to be provided by the user or system. For
example:

• Write the command as follows:
copy source-file target-file

• The following message appears:
A file was not found. (file = file-name)

Italics are also used for emphasis. For example:

• Do not delete the configuration file.

Code font A code font indicates text that the user enters without change, or text (such as messages) output by the
system. For example:

• At the prompt, enter dir.

• Use the send command to send mail.

• The following message is displayed:
The password is incorrect.

The following table explains the symbols used in this manual:

Symbol Convention

| In syntax explanations, a vertical bar separates multiple items, and has the meaning of OR. For
example:
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Symbol Convention

| A|B|C means A, or B, or C.

{ } In syntax explanations, curly brackets indicate that only one of the enclosed items is to be selected.
For example:

{A|B|C} means only one of A, or B, or C.

[ ] In syntax explanations, square brackets indicate that the enclosed item or items are optional. For
example:

[A] means that you can specify A or nothing.

[B|C] means that you can specify B, or C, or nothing.

... In coding, an ellipsis (...) indicates that one or more lines of coding are not shown for purposes of
brevity.

In syntax explanations, an ellipsis indicates that the immediately preceding item can be repeated as
many times as necessary. For example:

A, B, B, ... means that, after you specify A, B, you can specify B as many times as
necessary.

■ Conventions: KB, MB, GB, and TB
This manual uses the following conventions:

• 1 KB (kilobyte) is 1,024 bytes.

• 1 MB (megabyte) is 1,0242 bytes.

• 1 GB (gigabyte) is 1,0243 bytes.

• 1 TB (terabyte) is 1,0244 bytes.

■ Conventions: Version numbers
The version numbers of Hitachi program products are usually written as two sets of two digits each, separated by a hyphen.
For example:

• Version 1.00 (or 1.0) is written as 01-00.

• Version 2.05 is written as 02-05.

• Version 2.50 (or 2.5) is written as 02-50.

• Version 12.25 is written as 12-25.

The version number might be shown on the spine of a manual as Ver. 2.00, but the same version number would be written in
the program as 02-00.
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1 Overview
This chapter gives an overview of the remote control facility provided by JP1/Remote
Control.
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1.1 What is remote control?
One offshoot of the rapid proliferation of PCs is the growing number of users who are unaccustomed to performing
procedures such as application setup and troubleshooting. In corporations, PC-related tasks like these are usually left
to system administrators with specialized knowledge of computers. However, when several offices are involved, or
when the system administrator is busy, it becomes difficult to respond rapidly to problems.

In such situations, problems can be resolved faster if the system administrator can operate the problem machine via
remote control from his or her own PC via a computer network. JP1/Remote Control offers a remote control facility
that allows you to call up the screen of a remote PC onto the desktop of your own PC via a telephone line or LAN, and
perform operations via remote control.

Using the remote control facility allows you to perform keyboard or mouse operations on the remote PC screen just as
if it were your local PC. You can even shut down or reboot the remote PC. You can also issue an instruction to shut
down and switch off a remote PC if the PC is equipped with a power-off functionality.

The following figure shows an overview of the remote control facility.

Figure 1‒1: Overview of the remote control facility

Use of this facility will facilitate the following kinds of operations:

• Troubleshooting a remote PC from a local PC
In the event of an error in a program running on a remote PC, you can investigate the cause of the error and
troubleshoot from a local PC without actually traveling to the remote location.

• Performing remote maintenance on a remote PC
You can use a local PC to set up, uninstall, or modify setup information of a program installed on a PC at a remote
location.

1. Overview
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1.2 The remote control facility
In JP1/Remote Control, the machine used to perform a remote control operation is called the controller, and the
machine subject to remote control is called the agent.

Programs installed on the controller are collectively called Remote Control Manager, and programs installed on an
agent are collectively called Remote Control Agent.

The following figure shows the relationship.

Figure 1‒2: Relationship between the controller, agent, Remote Control Manager, and Remote Control
Agent

When the controller uses the remote control facility, it can:

• operate the agent screen,

• transfer files,

• supervise agents, and

• record and play back the agent screen display.

The following functions are useful in various situations, such as when you access the help desk.

• Chat function

• Function that allows connection requests to be issued from an agent to a controller

This section outlines these functions. JP1/Remote Control is linked with JP1/IM. Therefore, you can use the remote
control functions even from JP1/IM - View, which is the viewer of JP1/IM.

1.2.1 Operating the agent screen
You can connect the controller to the agent and call up its screen, thus allowing you to perform operations in the
window. The following figure shows the agent screen called up in a Remote Control Manager window (the Remote
Control window).

1. Overview
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Figure 1‒3: Remote Control window

The controller can perform the following operations on the agent. For details on each operation, see 4.2 Performing
remote control operations.

Keyboard and mouse operations
You can enter text, drag icons, and perform other keyboard and mouse operations on the agent screen, just as if
you were using your local PC screen. However, for shortcut keys, e.g., Ctrl + Tab, you will need to assign
buttons as action keys rather than using the actual shortcut keys on your keyboard.

Shutting down and rebooting the agent
You can shut down or reboot the agent from the controller. You can also issue an instruction to shut down and
switch off a remote agent PC if the agent PC is equipped with a power-off functionality. If you specify the
command to reconnect to the agent upon restart, the controller will reconnect the agent automatically, thus
allowing you to continue remote control operations.

Transferring clipboard data
You can transfer clipboard data between the controller and agent. This facility allows you to cut and paste text or
bitmap images between a document on the controller and a document on the agent, just as if they were on the
same machine.

Aborting applications and processes on the agent
For agents on Windows Me or Windows 98, when agent applications and processes hang up while Remote
Control is active, you can abort the agent applications and processes from the controller using the Remote Control
Process Viewer window displayed on the agent.

1.2.2 Transferring files
Remote Control Manager's File Transfer window allows you to transfer files between the controller and agent, or
between different agents, with a simple drag and drop operation. Compressing the transferred data will provide for
more efficient and safer file transmission.

The following figure shows an example of the File Transfer window. For details on the operations in this window, see
4.3 Transferring files.

1. Overview
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Figure 1‒4: File Transfer window

1.2.3 Supervising the agent
You can use the following two functions in the Agent Manager window of Remote Control Manager.

Managing the agent configuration
You can use the GUI to arrange and maintain agent configuration information eligible for remote control. You can
manage a large number of agents efficiently because you can assign desired names to agents and group agents in a
hierarchy. You can also search the network for machines that are running Remote Control Agent and add any
found agents to the Agent Manager list.

Receiving connection requests from agents
You can receive connection requests from agents. Using the Agent Manager window, you can connect to an agent
that has issued a connection request and you can also respond quickly to problems that occur on the agent.

The following figure shows an example of the hierarchical management of agents in the Agent Manager window. For
details on the operations in this window, see 4.4 Managing agents.

Figure 1‒5: Agent Manager window

1.2.4 Recording and playing back the agent screen display
You can track operations performed on an agent connected to the controller by recording the agent screen display in a
file. You can easily play back this file by using Remote Control Player, which is a controller-provided facility. The
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saved file can also be converted to an AVI file, which can be played back in an environment where the controller is
not available.

The following figure shows an example of a screen display played back by using Remote Control Player (the Remote
Control Player window).

Figure 1‒6: Remote Control Player

For further information on how to record and play back the agent screen display, see 4.5 Recording and playing back
the agent screen display.

1.2.5 Using chat
You can use the chat function as a means for interaction with Remote Control. If, for example, a problem occurs on an
agent, you can use the chat function to exchange information about the problem with the agent, the action to be taken,
and other details. This will help resolve the problem quickly.

The following figure shows the Chat window used for chatting.
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Figure 1‒7: Chat window

For information on using the chat function, see 6. Using Chat.

1.2.6 Issuing a connection request from an agent to a controller
Agents can issue connection requests to controllers (connect to the controllers), as opposed to ordinary connections.
The agent that has issued a connection request is displayed as an icon in the Agent Manager window on the controller.
Simply double-clicking this icon on the controller starts Remote Control on the agent. This enables you to quickly
service requests from agents. In various situations, such as when you access the help desk, you can issue a connection
request from the agent to multiple controllers simultaneously. This helps reduce the time required to solve a problem
because the agent can connect to the controller best able to service your request more quickly.

The advantages of this feature are as follows:

• Communication charges on the agent
Since the agent initiates the connection procedure, the agent can shoulder the communication charges required for
support.

• Enhanced security
Since this feature is independent of the ordinary connection function, you need not start the agent in order to issue
a connection request to the controller. The agent only connects to the controller to which it has issued a request to
start Remote Control. This helps prevent illegal access to Remote Control.

• RAS environment and DHCP environment (environment in which IP addresses are assigned dynamically)
If an agent is in an RAS or DHCP environment and has no fixed IP address, you must report the agent's IP address
to the controller by telephone or mail. This task is not required when an agent issues a connection request to the
controller.

Before you can use this feature, you must set up the controller and agents as described in the following figure.
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Figure 1‒8: Settings needed for an agent to issue a connection request to a controller

For information about the settings on the controller, see 4.4.4 Receiving connection requests from agents. For
information about the setting on the agent, see 5.3 Connection requests issued to controllers.
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2 Installation
This chapter provides an overview of the programs required to use the remote control
facility, outlines the preconditions required for installation, and describes the
installation and uninstallation methods.
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2.1 Programs required for use of the remote control
facility

This section describes programs required for use of the remote control facility, and points you should keep in mind
during the installation process.

2.1.1 Types of programs
There are two types of programs required for use of the remote control facility.

• Remote Control Manager
This is a generic name for programs used by the remotely-controlling side. It calls up the screen of a remote PC
(agent) and performs operations on it.
A machine which has this facility installed is called a controller.

• Remote Control Agent
This is a generic name for programs used by the remotely-controlled side. It provides screen information from the
local computer to the controller, and executes operations as instructed based on commands entered by the
controller.
A machine which has this facility installed is called an agent.

2.1.2 Program list
The table below lists the programs that provide the remote control facility, and shows which programs offer the
Remote Control Manager and Remote Control Agent facilities. JP1/Remote Control is a program that offers these
facilities, whereas, for JP1/Software Distribution, you must select these facilities as components when performing the
installation.

Any of these programs can coexist on a single network. You can also install both manager and agent facilities on a
single machine.

Table 2‒1: Remote control programs

Program name Remote Control Manager Remote Control Agent

JP1/Remote Control Manager Y N

JP1/Remote Control Agent N Y

JP1/Software Distribution Manager Y Y#

JP1/Software Distribution Client N Y

Legend:
Y: Offers this facility
N: Does not offer this facility

#
This can be installed only when it is to be used as a relay manager/system.

2.1.3 Version compatibility
The table below indicates the compatibility between different versions of Remote Control Manager and Remote
Control Agent.
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Table 2‒2: Compatibility between different versions of Remote Control Manager and Remote Control
Agent

Remote Control Manager

Remote Control Agent

05-10 05-23, 06-00, 06-51, 06-53, 06-71, 07-00, 07-50#2, 08-00,
08-10, 08-51, 09-00, 09-50, 09-51

05-10 Y N

05-23 Y Y

06-00, 06-51, 06-53, 06-71, 07-00, 07-11#1,
08-00, 08-10, 08-51, 09-00, 09-50, 09-51

N Y

Legend:
Y: Compatible
N: Incompatible

#1
This version can be installed only from JP1/Software Distribution 07-11. The functions are the same as in JP1/Remote Control
07-00.

#2
This version can be installed only from JP1/Software Distribution 07-50. The functions are the same as in JP1/Remote Control
07-00.

2.1.4 Notes on using the English version of JP1/Remote Control together
with the Japanese version

Note the following points when using the English version of JP1/Remote Control together with the Japanese version.

• The English version of JP1/Remote Control Agent can connect to the Japanese version of JP1/Remote Control
Manager.
If you are using the English version of JP1/Remote Control Manager, make sure that you use the English version
of JP1/Remote Control Agent to configure the system.

• If you go to the Properties dialog box's Optimize Transaction page, and then select the Use local font option, the
characters can become garbled if the font used in the agent PC does not exist in the controller PC.

• If the type of the keyboard used in the controller PC is different from the one used in the agent PC, you may not
be able to type correctly.

• If a file with a file name or path name that contains 2-byte characters is transferred by using the file transmission
functionality, the file might not be transferred correctly.

2.1.5 Notes on installation
This subsection describes points you should keep in mind when installing remote control programs.

• Do not install Remote Control Agent on a machine that already has another company's program(s) providing the
remote control facility. Before installing Remote Control Agent, make sure the machine has no such program(s)
installed.

• Do not install the remote control facility of JP1/Software Distribution and JP1/Remote Control facilities on the
same PC.

• When remote control is in use, the controller cannot display correct information unless the agent machine has a
display board chip set and a display driver in one of the correct combinations. See H. Combinations of Display
Board Chip Sets and Drivers for the combinations allowed. If the agent uses a different display board, the
personal computer on which Remote Control Manager or Remote Control Agent is installed may not work
normally.
If the agent is on Windows 8, Windows Server 2012, Windows 7, Windows Server 2008, Windows Vista,
Windows Server 2003, Windows XP, or Windows 2000, there are no longer any restrictions on the combination of
the chip set on the display board and the driver.
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• The setting of the Windows Driver Signing Options is temporarily changed to Warning during installation of a
remote control program. In Windows Server 2003 and Windows XP, the setting might still be Warning even after
the installation has been completed. If so, reset the Driver Signing Options manually.

• If you intend to install other products after you have installed Remote Control Agent, restart the computer before
installing them.

• If you want to upgrade the OS, uninstall the remote control products before upgrading the OS. For details about
how to uninstall the remote control products, see 2.3.4 Uninstallation.

• If you want to link JP1/IM, install Remote Control Manager on the PC on which JP1/IM - View is installed.

• Do not install a remote control product in Windows XP Mode in Windows 7.

• Installing Remote Control Agent in Windows Vista might disable the Windows Aero features. If Windows Aero is
disabled, restart the computer to enable the Windows Aero settings again.

• After you install Remote Control Agent on Windows Server 2008, Windows Server 2008 R2, or Windows Server
2012, the message below might be output to the Windows event (system) log. This does not affect operation.

• The Remote Control Agent service is marked as an interactive service. However, the system is configured to
not allow interactive services. This service may not function properly.

2.1.6 Overwrite installation
You can perform an overwrite installation of the remote control program if you are installing the same version or a
later version. If you perform an overwrite installation with the same version, you can change the installation contents
or perform a repair installation using the same settings. You can use the maintenance wizard to change the installation
contents or to perform a repair installation. For more details, see 2.3.3 Changing the installation contents.

You cannot perform an overwrite installation using a version of the remote control program that is older than the one
already installed. Especially, do not perform an overwrite installation of the following because the uninstallation may
not succeed:

• Do not perform an overwrite installation of JP1/Remote Control 06-51 or earlier after installing JP1/Remote
Control 06-53 or later.

• Do not perform an overwrite installation of JP1/Software Distribution 06-71 or earlier after installing JP1/
Software Distribution 07-00 or later.
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2.2 Estimation for hardware
This section describes hardware specifications recommended for use as a controller or agent, and the method used to
calculate memory requirements.

2.2.1 CPU performance and hard disk requirements
Tables 2-3 and 2-4 list the CPU performance and hard disk requirements for the controller and agent.

Table 2‒3: Controller CPU performance and hard disk requirements

Item Minimum value Recommended value

CPU 300MHz 1GHz or better

Hard disk size 10 megabytes 12 megabytes or more

Table 2‒4: Agent CPU performance and hard disk requirements

Item Minimum value Recommended value

CPU 300MHz 1GHz or better

Hard disk size 10 megabytes 12 megabytes or more

2.2.2 Memory requirements
The table below shows the memory size required for using the remote control facility. Additional memory represented
by +d+e is required only when using chat. Note that the virtual memory size indicated in the table is the memory
requirement for the virtual memory area and not the virtual memory you can specify in the System Properties dialog
box in Windows Me and Windows 98.

Table 2‒5: Memory requirements

Facility

Memory requirement

(unit: megabytes)

Built-in memory Virtual memory

Remote Control Manager

(for Windows NT 4.0, Windows Me, or Windows 98)

40+a+b+d+e 16+a+b+d+e

Remote Control Manager

(for Windows 2000 Professional)

40+a+b+d+e 16+a+b+d+e

Remote Control Manager

(for Windows Server 2003, Windows XP, Windows 2000 Server,
or Windows 2000 Advanced Server)

128+a+b+d+e 16+a+b+d+e

Remote Control Manager

(for Windows Server 2012, Windows Server 2008 or Windows
Vista)

512+a+b+d+e 16+a+b+d+e

Remote Control Manager

(for Windows 8 or Windows 7)

1,000+a+b+d+e 16+a+b+d+e

Remote Control Agent

(for Windows NT 4.0)

36+a+b+c+d+e 8+a+b+c+d+e

Remote Control Agent 28+a+b+c+d+e 8+a+b+c+d+e
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Facility

Memory requirement

(unit: megabytes)

Built-in memory Virtual memory

(for Windows Me or Windows 98) 28+a+b+c+d+e 8+a+b+c+d+e

Remote Control Agent

(for Windows 2000 Professional)

36+a+b+c+d+e 8+a+b+c+d+e

Remote Control Agent

(for Windows Server 2003, Windows XP, Windows 2000 Server,
or Windows 2000 Advanced Server)

128+a+b+c+d+e 8+a+b+c+d+e

Remote Control Agent

(for Windows Server 2012, Windows Server 2008 or Windows
Vista)

512+a+b+c+d+e 8+a+b+c+d+e

Remote Control Agent

(for Windows 8 or Windows 7)

1,000+a+b+c+d+e 8+a+b+c+d+e

Legend:
a: Temporary buffer for drawing (For typical applications each controller requires 5 megabytes x the number of connected agents
and each agent requires 5 megabytes.)
b: Temporary buffer for file transmission (2 megabytes)
c: Connection buffer (1 megabytes x number of connection destinations)
d: Chat server buffer (2 + (0.1 x the number of connections) megabytes)
e: Chat client buffer (2 + (0.2 x the number of connections) megabytes)

2.2.3 Notes on files that depend on the user environment
In Remote Control Manager, certain files may grow indefinitely depending on the user's environment settings. These
user environment dependent files are as follows. These files should be deleted at appropriate times and/or intervals.

Temporary files after file transfer
If the Delete local copy on the controller check box is cleared on the File page in the Transfer Options dialog
box, the files on the controller will not be deleted. Instead, they remain in the folder that is specified in the Work
folder field on the Transfer page in the Transfer Options dialog box.

Recording files
Recording files, which contain records about agent screens, are not deleted automatically. The locations where
recording files are created and stored are up to the user. The recording file size also varies depending on the user's
operations.
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2.3 Installation and uninstallation methods
The installation procedures of the remote control program differ between JP1/Remote Control and JP1/Software
Distribution. The following section describes the installation procedures for each case, and the procedures for
changing the installation contents and for uninstallation.

2.3.1 Installing JP1/Remote Control
This subsection explains how to install JP1/Remote Control. The figure below shows the installation procedure.

Figure 2‒1: Installation procedure (for JP1/Remote Control)

Administrator privileges are required for installation.

Installer windows and items shown on each window vary from program to program. This manual shows the installer
for JP1/Remote Control Agent unless otherwise specified.

(1) Starting the installer
Insert the provided CD-ROM into the CD-ROM drive, and then follow the instructions of the displayed installer.

When the installer starts, the installation program of JP1/Remote Control starts and displays the Setup dialog box.
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Figure 2‒2: Remote Control Agent Setup dialog box

To continue the installation, click the Next button. To cancel the installation, click the Cancel button.

(2) Read the notes (for JP1/Remote Control Agent only)
When installing JP1/Remote Control Agent for the first time, the Notes dialog box is displayed. Depending on the OS
you are installing to, the contents of the Notes dialog box will vary as described below:

• If the operating system is Windows 8, Windows Server 2012, Windows 7, Windows Server 2008, Windows Vista,
Windows Server 2003, Windows XP, or Windows 2000:
In the Notes dialog box, verify if another vendor's remote control product is installed on the personal computer.
This check is required to ensure normal agent operation.

Figure 2‒3: Notes dialog box (if the operating system is Windows 8, Windows Server 2012, Windows 7,
Windows Server 2008, Windows Vista, Windows Server 2003, Windows XP, or Windows
2000)
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If no other vendor's remote control product is installed on the personal computer, click the Next button to continue
installation. To cancel the installation, click the Cancel button.

• If the operating system is Windows NT 4.0, Windows Me, or Windows 98:
In the Notes dialog box, confirm that Remote Control Agent functions normally when combined with the display
driver on this personal computer and determine if another vendor's remote control product is installed on the
personal computer. This check is required to ensure normal agent operation.

Figure 2‒4: Notes dialog box (If the operating system is Windows NT 4.0, Windows Me, or Windows
98)

On each personal computer where JP1/Remote Control Agent is installed, confirm that a display driver compatible
with JP1/Remote Control is used. If the display driver used on the personal computer is not compatible with JP1/
Remote Control, the personal computer or Remote Control Agent may malfunction after JP1/Remote Control
Agent is installed.
Clicking the Driver List button displays a list of display drivers compatible with JP1/Remote Control. Confirm
that the display driver used on the personal computer is compatible with JP1/Remote Control and select the I
confirmed the above Notes check box. If the personal computer runs Windows Me or Windows 98, the name of
the driver chip set used on the personal computer might not be displayed.
After selecting the I confirmed the above Notes check box, you can click Next to continue installation.

(3) Registering as a user
In this step, you register your name and company name.
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Figure 2‒5: Register User dialog box

Enter the necessary information, and click the Next button. Clicking the Back button will return you to the Setup
dialog box.

(4) Setting the installation directory
Specify the directory in which you want to install JP1/Remote Control.

This dialog box is displayed for the first installation only. When you perform an overwrite installation, the installation
is automatically directed to the existing installation directory.

Figure 2‒6: Specify Installation Directory dialog box

The default installation destinations are the following (C: is the name of the drive where the OS is installed).

• For JP1/Remote Control Manager
C:\Program Files\Hitachi\jp1rcmgr
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• For JP1/Remote Control Agent
C:\Program Files\Hitachi\jp1rcagt

Note, however, that when you install JP1/Remote Control on a computer running Windows Server 2012, 64-bit
Editions of Windows 8 or 64-bit Editions of Windows 7 or Windows Server 2008 R2 (x64), 64-bit Editions of
Windows Server 2008, 64-bit Editions of Windows Vista or Windows Server 2003 (x64), the installation paths
contain Program Files (x86) instead of Program Files.

Click the Next button to continue installation.

(5) Selecting the components to be installed
In this step, you select the installation components and subcomponents. This dialog box is not displayed when
performing an overwrite installation over versions 06-51 or earlier. All components are installed.

Figure 2‒7: Select Components dialog box

Select one of the following components to be installed.

• Remote Control Manager or Remote Control Agent

• Chat

• Online Help

You cannot select Chat or Online Help without selecting Remote Control Manager or Remote Control Agent.

Click the Next button to continue installation.

(6) Specifying the program folder
In this step, you specify the program folder where the program icon will be registered. You can change the default
folder and select one of the existing program folders. You can also specify program folders in a hierarchical structure
by separating folder names with a back slash (\).

This dialog box is displayed for the first installation only. When you upgrade the version, the existing program folder
is used automatically.
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Figure 2‒8: Specify Program Folder dialog box

Click the Next button to continue installation.

(7) Checking settings for installation
The information that will be used to copy the remote control program files is displayed.

Figure 2‒9: Confirm Installation dialog box

Check the settings. If any modifications are required, click the Back button. In case of an overwrite installation, some
settings may not be modified.

If all settings are correct, click the Next button. A dialog box appears and file copying starts. The progress of the
installation is shown in this dialog box.
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(8) Completing installation
When all files are copied, the Installation Complete dialog box appears.

Figure 2‒10: Installation Complete dialog box

When installing Remote Control Agent, you should select the Start Setup check box in order to launch the setup
program immediately following installation.

Depending on the condition of your personal computer, a message may appear stating that the system must be
restarted in order to complete installation. If this message appears, follow the displayed instructions to specify whether
to restart the system immediately or later.

Click the Finish button to finish the installation.

2.3.2 Installing the remote control program from JP1/Software
Distribution

This subsection describes how to install the remote control program from JP1/Software Distribution. The figure below
shows the installation procedure.
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Figure 2‒11: Installation procedure (for JP1/Software Distribution)

Administrator privileges are required in order to perform the installation. The settings you select for the steps through
to Specify the program folder are common to all JP1/Software Distribution components.

Note that the windows and displayed items of the installer may vary slightly for each program. Unless there is a need
to explain a specific program or function, the following subsection will display screenshots of the JP1/Software
Distribution installer.

(1) Starting the installer
Insert the provided CD-ROM into the CD-ROM drive, and then follow the instructions of the displayed installer.

When the installer starts, the installation program of JP1/Software Distribution starts and displays the Setup dialog
box.
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Figure 2‒12: Software Distribution Manager Setup dialog box

To continue the installation, click the Next button. To cancel the installation, click the Cancel button.

(2) Registering as a user
In this step, you register your name and company name.

Figure 2‒13: Register User dialog box

Enter the necessary information, and click the Next button. Clicking the Back button will return to the Setup dialog
box.

(3) Setting the installation directory
In this step, you set the installation directory of Remote Control Manager or Remote Control Agent. This dialog box is
displayed only for the first installation of JP1/Software Distribution. When you perform an overwrite installation, the
installation is automatically directed to the existing installation directory.
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Figure 2‒14: Specify Installation Directory dialog box

The default installation destination is C:\Program Files\Hitachi\NETMDM (C: is the name of the drive
where the OS is installed). Note, however, that when you install the JP1/Remote Control product on a computer
running Windows Server 2012, 64-bit Editions of Windows 8, or 64-bit Editions of Windows 7 or Windows Server
2008 R2 (x64), 64-bit Editions of Windows Server 2008, 64-bit Editions of Windows Vista or Windows Server 2003
(x64), the default installation destination will be C:\Program Files (x86)\Hitachi\NETMDM.

Note the following points when modifying the installation destination directory shown by default.

• To specify an installation destination directory, you can use alphanumeric characters, spaces, and the following
symbols:
_ \ . : ( )

• Do not add a backslash (\) after the installation destination directory. For example, do not specify C:\NETMDM\.

• Do not specify an installation destination directory that consists only of a drive name. For example, do not specify
C:.

Click the Next button to continue installation.

(4) Selecting a manager type
In the Select Manager Type dialog box, you specify whether the program will be used as a central manager or a relay
manager when installing a remote control program from JP1/Software Distribution Manager.
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Figure 2‒15: Select Manager Type dialog box

If you select Central manager, only Remote Control Manager is installed. If you select Relay manager, Remote
Control Manager and Remote Control Agent are installed. You also need to enter the host name and the IP address of
the higher system according to the connection destination's ID key for operations.

When you install a remote control program from JP1/Software Distribution Client, specify whether the program will
be used as a relay system or a client. With JP1/Software Distribution Client, you can only install Remote Control
Agent. Specify the host name or IP address of the higher system according to the ID key for operations of the
connection destination.

Click the Next button to proceed with the installation.

(5) Selecting the components to be installed
In this step, you select the installation components and subcomponents. When upgrading to a newer version, you can
add components and subcomponents, but you cannot remove ones that are already installed.

Figure 2‒16: Select Components dialog box
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The components that are displayed vary depending on the environment you are installing to and the server type. For
JP1/Software Distribution Manager (Relay Manager), you can simultaneously select both Remote Control Manager
and Remote Control Agent.

The subcomponents are displayed in a tree view below the component name. From the following two types of
components, select the components to be installed:

• Remote Control Manager or Remote Control Agent

• Chat

You cannot select Chat without selecting Remote Control Manager or Remote Control Agent.

Whether the online help is installed varies depending on the JP1/Software Distribution product, as follows:

• For JP1/Software Distribution Manager and JP1/Software Distribution Client (relay system):
The remote control program's online help is installed.

• For JP1/Software Distribution Client (client):
If you select Online help for JP1/Software Distribution Client, the remote control program's online help is
installed along with the help files of the JP1/Software Distribution's client functions.

(6) Specifying the program folder
In this step, you specify the program folder where the program icon is to be registered. You can change the default
folder and select one of the existing program folders. However, you cannot specify a folder name including a back
slash (\) for the program folder.

Figure 2‒17: Specify Program Folder dialog box

This dialog box is displayed only for the first installation of JP1/Software Distribution, or when you perform an
overwrite installation in an environment where the program folder has not been created. If you are installing JP1/
Software Distribution in an environment where the program file is already created, the existing program folder is
automatically used.

Click the Next button to proceed with the installation. If you are installing components other than the remote control
program, the Setup window is displayed next.

(7) Read the notes (only when installing Remote Control Agent)
When installing Remote Control Agent for the first time, the Notes dialog box is displayed. Depending on the OS you
are installing to, the contents of the Notes dialog box will vary as described below:
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• If the operating system is Windows 8, Windows Server 2012, Windows 7, Windows Server 2008, Windows Vista,
Windows Server 2003, Windows XP, or Windows 2000:
In the Notes dialog box, determine if another vendor's remote control product is installed on the personal
computer. This check is required to ensure normal agent operation.

Figure 2‒18: Notes dialog box (if the operating system is Windows 8, Windows Server 2012, Windows
7, Windows Server 2008, Windows Vista, Windows Server 2003, Windows XP, or
Windows 2000)

If no other vendor's remote control product is installed on the personal computer, click Next to continue
installation. To cancel the installation, click the Cancel button.

• If the operating system is Windows NT 4.0, Windows Me, or Windows 98:
In the Notes dialog box, confirm that Remote Control Agent functions normally when combined with the display
driver on this personal computer and determine if another vendor's remote control product is installed on the
personal computer. This check is required ensure normal agent operation.

Figure 2‒19: Notes dialog box (if the operating system is Windows NT 4.0, Windows Me, or Windows
98)
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On each personal computer where JP1/Remote Control Agent is installed, confirm that a display driver compatible
with JP1/Remote Control is used. If the display driver used on the personal computer is not compatible with JP1/
Remote Control, the personal computer or Remote Control Agent may malfunction after JP1/Remote Control
Agent is installed.
Clicking the Driver List button displays a list of display drivers compatible with JP1/Remote Control. Confirm
that the display driver used on the personal computer is compatible with JP1/Remote Control and select the I
confirmed the above Notes check box. If the personal computer runs Windows Me or Windows 98, the name of
the driver chip set used on the personal computer might not be displayed.
After selecting the I confirmed the above Notes check box, you can click Next to continue installation.

(8) Checking settings for installation
This step displays the information for starting the copying of the JP1/Software Distribution files that contain the
remote control program.

Figure 2‒20: Confirm Installation dialog box

Check the contents of the information. Click the Back button to make changes if necessary. If you do not need to
change anything, click the Next button. A dialog box that displays the progress of the installation is displayed, and the
file copying starts.

(9) Completing installation
When all files are copied, the following dialog box appears.
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Figure 2‒21: Installation Complete dialog box

When installing Remote Control Agent, you should select the Start Remote Control Agent Setup check box in order
to launch the setup program immediately following installation.

Depending on the PC, you may be prompted to restart your computer after the installation finishes. If you are
prompted, follow the instructions on the screen and specify whether to restart now or later.

Click the Finish button to exit the installer.

2.3.3 Changing the installation contents
Use the maintenance wizard to add new components or remove installed components. You can use the maintenance
wizard to specify that the settings of the previous installation are to be used when reinstalling the product, or you can
use the maintenance wizard to uninstall the product. Before using the maintenance wizard, exit the remote control
program.

To launch the maintenance wizard, run the installer from the CD-ROM of the already installed product. If you are
performing an overwrite installation with the installer of the same version, the maintenance wizard is displayed, and
then the following Welcome dialog box is displayed.
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Figure 2‒22: Welcome dialog box

From the Maintenance Wizard dialog box, select Modify, Repair, or Remove.

Modify
This option allows you to add new components or remove one or more installed components.
If you select Modify and click the Next button, the Select Components dialog box is displayed (for JP1/Software
Distribution Manager, this is displayed from the previous Select Manager Type dialog box). Modify the
installation components, and then proceed with the installation as you would when installing for the first time.
When the installation finishes, the Maintenance Complete dialog box is displayed.

Repair
This option reinstalls all the components of the previous installation.
If you select Repair and click the Next button, a dialog box displaying the progress is displayed. When the
reinstallation finishes, the Maintenance Complete dialog box is displayed.

Remove
This option removes all the components and uninstalls the product.
If you select Remove and click the Next button, the Confirm File Deletion dialog box is displayed. Click the OK
button to start the uninstallation. When the uninstallation finishes, the Maintenance Complete dialog box is
displayed.

2.3.4 Uninstallation
This subsection describes how to uninstall the remote control program and gives notes on uninstallation.

(1) Uninstalling
You can use one of the following two methods to uninstall the remote control program:

• Uninstall from the Control Panel's Add/Remove Programs

• Uninstall by selecting the Remove option of the maintenance wizard

In both methods, the Confirm File Deletion dialog box is displayed during the process. Click the OK button to start
uninstallation. When the uninstallation finishes, the Maintenance Complete dialog box is displayed.

2. Installation

30



(2) Notes on uninstallation
This subsection gives notes on uninstallation.

• The operation of the JP1/Remote Control uninstallation varies depending on the program folder where the icon is
registered. Be careful of the following points.

• When the icon is registered to the default program folder:
During uninstallation, the default program folders (JP1_Remote Control Manager and JP1_Remote
Control Agent) and the program icons are deleted. Therefore, do not store other program icons in the
JP1_Remote Control Manager and JP1_Remote Control Agent program folders.

• When the icon is registered to a user-specified program folder:
During the uninstallation, all the JP1/Remote Control icons are deleted, but the program folder remains. You
have to manually delete the program folder to remove it.
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3 Environment Setup
This chapter describes how to set up the environment required for use of the remote
control facility.
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3.1 Remote control mode
You can use the remote control facility when the controller is connected to an agent. A single controller can be
connected with more than one agent. In addition, multiple controllers can be connected to a single agent.

An agent cannot initiate a connection to the controller. However, you cannot issue a connection request to the
controller from the agent. Either the controller or the agent can initiate the disconnection operation.

The permission to operate an agent machine is called the remote control mode. The remote control mode has three
levels: View, Shared, and Exclusive, in which order the level of operational permission becomes higher.

View
This mode only allows you to view the screen of the agent machine. No keyboard or mouse operations are
allowed.
When the connected controller or agent is in the exclusive mode, the local machine is forced to this mode.

Shared
This mode allows you to operate the agent from either the controller or the agent.

Exclusive
This mode allows you to inhibit operations from the connection destination (controller or agent), and gives the
local machine exclusive permission to operate the agent machine. When the controller is in this mode, keyboard
and mouse operations of the agent machine will be disabled. Additionally, when the agent is in this mode, the
controller can only view the agent's screen (remote control is disabled).

3.1.1 Determining the remote control mode
Both the controller and agent should have their remote control modes set up. When the controller connects to the
agent, the settings will be put into effect. When both sides request the same mode, the agent setting will be given
priority. When the two sides request different modes, the system selects the setting of whichever controller or agent
has been given a higher permission level.

When either the controller or the agent is set to the exclusive mode, the other must be set to the view mode.

The following table shows how the system determines the remote control mode in various combinations.

Table 3‒1: How the remote control mode is determined

Agent setting
Controller setting

View Shared Exclusive

View Pattern 1

Controller: view

Agent: view

Pattern 2

Controller: shared

Agent: view

Pattern 2

Controller: exclusive

Agent: view

Shared Pattern 3

Controller: view

Agent: shared

Pattern 1

Controller: shared

Agent: shared

Pattern 2

Controller: exclusive

Agent: view

Exclusive Pattern 3

Controller: view

Agent: exclusive

Pattern 3

Controller: view

Agent: exclusive

Pattern 1

Controller: view

Agent: exclusive

The following describes these patterns.

Pattern 1: Both the controller and agent request the same remote control mode.

Pattern 3: The agent is given a higher permission level.
In patterns 1 and 3, the agent setting has priority. When the agent setting is the exclusive mode, the controller is
forced into the view mode irrespective of its own setting. When the agent setting is the shared or view mode, the
controller setting continues in effect.
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Pattern 2: The controller is given a higher permission level.
In pattern 2, the controller setting has priority. When the controller setting is the exclusive mode, the agent is
forced into the view mode irrespective of its own setting. When the controller setting is the shared mode, the agent
setting continues in effect.

Figures 3-1 to 3-3 provide examples of how the system determines the remote control mode for each pattern, and what
operations the controller can perform as a result.

Figure 3‒1: When both the controller and agent request the same remote control mode (Pattern 1)

In the example shown in Figure 3-1, the agent setting takes priority because both the controller and the agent are in the
exclusive mode. When the controller connects to the agent, the agent is set to the exclusive mode. Because the agent
setting is determined to be the exclusive mode, the controller is forced into the view mode.

In this case, the controller can only view the agent screen, and cannot operate the agent.

Figure 3‒2: When the controller is given a higher permission level (Pattern 2)

In the example shown in Figure 3-2, the controller setting takes priority because the controller has a higher permission
level. When the controller connects to the agent, the controller is set to the exclusive mode. Because the controller
setting is determined to be the exclusive mode, the agent is forced into the view mode.

In this case, only the controller can operate the agent.
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Figure 3‒3: When the agent is given a higher permission level (Pattern 3)

In the example shown in Figure 3-3, the agent setting takes priority because the agent has a higher permission level.
When the controller connects to the agent, the agent is set to the exclusive mode. Because the agent setting is
determined to be the exclusive mode, the controller is forced into the view mode.

In this case, the controller can only view the agent screen, and cannot operate the agent.

3.1.2 Changing the remote control mode of the agent in the view mode
When the agent is in view mode, the user cannot operate the agent machine. When you need to operate the local
machine from the agent, take the following steps to change the remote control mode.

For Windows 8, Windows Server 2012, Windows 7, Windows Server 2008, Windows Vista, Windows Server 2003,
Windows XP, Windows 2000, and Windows NT 4.0

1. Press the Ctrl + Alt + Delete keys.
The agent shifts to the shared mode, enabling operations on the agent side.

For Windows Me and Windows 98

1. Press the Ctrl + Alt + Delete keys.
The Close Program dialog box appears.

2. Click the Cancel button.
The agent shifts to the shared mode, enabling operations on the agent side.

When you take these steps to shift the agent from the view to shared mode, the controller is notified of this action. On
the controller, a message dialog box appears asking you whether it is OK to change the controller from the exclusive
to the shared mode.

If you agree to the change in the controller's permission level in this message dialog box, the controller assumes the
shared mode, enabling agent operations from both the controller and agent. However, if you do not approve the mode
change, the agent reverts to the view mode, preventing the agent side from operating the agent machine.
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3.1.3 Remote control mode in the multi-connection environment
When multiple controllers are connected to a single agent, only one controller can obtain the exclusive mode. The
remaining controllers assume the view mode. When the controller currently in the exclusive mode relinquishes
permission, or when it severs the connection, a message dialog box appears in remaining controllers stating that the
exclusive mode is now available.

Three examples are described below explaining how the remote control mode changes in the multi-connection
environment. Let's assume that three controllers are connected to one agent, each machine and its permission level is
shown below:

Figure 3‒4: Flow of remote control mode changes (initial state)

(1) One of the controllers acquires the exclusive mode
When Controller 1 request the exclusive mode, other machines will shift their modes as shown below:

Figure 3‒5: Flow of remote control mode changes (when Controller 1 is set to the exclusive mode)

1. Controller 1 requests the exclusive mode.

2. A message dialog box appears on the agent, stating the controller's request to acquire the exclusive mode.
Choosing OK will put the agent into view mode.

3. A message dialog box appears on Controller 2, stating that another controller has acquired the exclusive mode.

Choosing OK will put Controller 2 into view mode.
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(2) One of the controllers acquires the exclusive mode and then cancels it (or severs the
connection)

In example (1), Controller 1 acquires the exclusive mode and the remaining controllers assume the view mode. If
Controller 1 relinquishes the exclusive mode, the remaining machines will experience the following mode changes.
The same changes will apply when Controller 1 severs the connection with the agent.

Figure 3‒6: Flow of remote control mode changes (when Controller 1 is disconnected from the agent)

1. Controller 1 reverts to the shared mode.

2. On Controller 2, which was originally in the shared mode, a message dialog box appears stating that another
controller has released the exclusive mode. However, Controller 2 remains in the view mode.

(3) One of the controllers acquires the exclusive mode but the agent presses Ctrl + Alt +
Delete keys

In example (1), Controller 1 acquires the exclusive mode and the remaining machines assume the view mode. If the
agent presses the Ctrl + Alt + Delete keys, the other machines will experience the following mode changes.

Figure 3‒7: Flow of remote control mode changes (when the agent presses the Ctrl + Alt + Delete keys)

1. On the agent, press the Ctrl + Alt + Delete keys.

2. On Controller 1, a message dialog box appears asking you whether it is OK to change the permission level to the
shared mode.
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Choosing Yes will put both Controller 1 and the agent into the shared mode. (No mode changes occur if the user
of Controller 1 chooses No in the dialog box.)

3. On Controller 2, which was originally in the shared mode, a message dialog box appears stating that another
controller has released the exclusive mode. However, Controller 2 remains in the view mode.
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3.2 Automatic dialing connection
In the WAN environment, you need to make a dialup connection before starting to use the remote control facility. The
automated dialup connection procedure is called the automatic dialing connection.

3.2.1 Preconditions
To make the automatic dialing connection, the controller machine must have the following OS and applications
(services).

Table 3‒2: Controller preconditions

OS Application (service)

Windows Me Dial-Up Networking

Windows 98

Windows 8 Remote Access Service

Windows Server 2012

Windows 7

Windows Server 2008

Windows Vista

Windows Server 2003

Windows XP

Windows 2000

Windows NT 4.0 Service Pack 3 or later

3.2.2 Setting up the automatic dialing connection
You need to configure the following settings to make an automatic dialing connection.

Dial-Up Networking (Remote Access Service) settings
In Windows Dial-Up Networking or Remote Access Service, specify the connection destinations (phone book)
and the server. In addition, before using the automatic dialing connection facility, make a manual connection to
the destination using Windows Dial-Up Networking or Remote Access Service to ensure that the dial-up
connection facility works normally.

Remote Control Manager property settings
In the Properties dialog box, in the Dial-up Settings page, specify whether the automatic dialing connection
should be used or not, and any options required for the automatic dialing facility. You can modify the Dial-Up
Networking (Remote Access Service) settings directly.

For details on the Dial-up Settings page, see 3.3.12 Dial-up Settings page.
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3.3 Setting up the operating environment of Remote
Control Manager

Before starting to use the remote control facility, you need to set up the operating environment. This includes elements
such as the connection method to the agent, remote control mode, and data transmission method from the agent.

To set up the operating environment of Remote Control Manager, use the Properties dialog box. To open the
Properties dialog box, choose Tools and then Properties in the Remote Control window.

The table below lists the setup items for each page of the Properties dialog box.

Table 3‒3: Operating environment items for Remote Control Manager

Page Item

Connection page Port number

Specify reconnection

Whether to disconnect automatically

Optimize Transaction page Data traffic (e.g. data compression setting)

Desktop (e.g. the suppression of wallpaper)

Display (e.g. bitmap cache)

Mouse

Control Mode page Remote control mode (view/shared/exclusive)

Window page Scroll (e.g. auto-scroll setting)

Window size

Keyboard/mouse (e.g. mouse button settings)

Zoom (e.g. agent window auto-zoom, etc.)

Toolbar page Toolbar (items related to the toolbar)

Address bar

Status bar (items related to the status bar)

Action keys

File Transfer page Whether to compress/encrypt data

Agent's default folder

File Transfer window

Logging page Log output (enable/disable)

Print method

Clipboard page Automatic clipboard transfer

Transmission type (send/receive/share)

Transmission conditions

Data format (plain text/formatted data)

Register Action Key page Register or send an action key

Record page Set a recording file name

Start recording when connected
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Page Item

Record page Status icon

Security page Whether to encrypt remote control data

Black out the agent PC display

Dial-up Settings page Dialup connection

Destination agents

Define Windows dial-up network

Others page Save and load property information

After setting each page, click the Save button to save the specified values as the new default values. If you click the
Update button, the settings take effect only while Remote Control Manager is running.

3.3.1 Connection page
The Connection page allows you to set up the method for connecting to the agent. The Connection page is shown
below.

Figure 3‒8: Connection page

(1) Specify port number
Specify the number of the port to be used for connecting to the agent. Make sure this port number does not coincide
with the ports used by other programs. The default port number is 30003.
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(2) Specify reconnection

Perform retry upon connection failure
Specify whether the system should attempt to reconnect if the first attempt to connect to the agent times out.
Select this check box to retry.

Maximum retry count
Specify the number of retry attempts to be performed if an attempt to connect to the agent fails. Enter an
integer from 1 to 99. The default is 5 attempts.

Retry interval
Specify the interval (minutes) at which retries are performed when an attempt to connect to the agent fails.
Enter an integer from 0 to 60. The default is 1 minute.

Reconnect after the agent rebooted
Specify whether to reconnect after the agent is rebooted. Select this check box to reconnect.
To reconnect to the agent upon reboot, you need to configure the agent to automatically start Remote Control
Agent upon startup. For details on the automatic startup, see 3.4.1 Start options.

When the agent is rebooted, reconnect after
Specify the amount of time (minutes) that must pass for reconnection to start after the agent is rebooted. Enter
an integer from 1 to 60. The default is 5 minutes.

(3) Disconnect from the agent automatically
When operations on Remote Control Manager stop, or when it enters the inactive state, you can specify whether to
sever the connection automatically. Select this check box to disconnect from the agent automatically.

You can select one of the following options to specify when automatic disconnection is to be performed. You can also
specify a value from 1 to 60 (minutes) as the amount of time until disconnection. The default is 5 minutes.

When the time-out elapsed
The system disconnects the agent when a specified period of time elapses since the establishment of the
connection.

If the agent is not manipulated during the time-out
The system disconnects the agent if no operation is made on the agent (that is, if no data is sent) for a specified
period of time.

If the Remote Control window is inactive during the time-out
The system disconnects the agent when a specified period of time elapses since the Remote Control Manager's
windows are deactivated or iconized.

3.3.2 Optimize Transaction page
The Optimize Transaction page allows you to set up the facility used to reduce the amount of data sent from the
agent in order to permit a higher transmission speed.

While you are using the remote control facility, the screen data of the agent is being transferred to the controller.
Sending the agent's screen data "as is" to the controller will increase the amount of transmission data and may extend
transmission time. For this reason, the screen saver is automatically disabled on the agent while it is connected to the
controller. In the Optimize Transaction page, you can also reduce the amount of transmission data and speed up the
data transfer.

If more than one controller is connected to the agent, the effective settings will be those on the controller that has the
most recently configured Optimize Transaction page. When the settings in this page on a controller are changed, a
message dialog box that reports this change opens on the other connected controllers.

Note, however, that when multiple controllers using flow control are connected to the agent, if a controller that is
connected later cancels flow control, the change in the settings will not have any effect. Moreover, no message dialog
box reporting the change appears.

The Optimize Transaction page is shown below.
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Figure 3‒9: Optimize Transaction page

(1) Data traffic

Compress the data to transfer
Select this check box to compress transmission data.
Data with a size of 4,096 or more bytes will be compressed for transmission. This value is suitable for use in the
LAN environment. In the WAN environment, or when you want to compress data at a different threshold, click
the Higher Level Settings button to open the Higher Level Settings dialog box. Here, you can specify the
compression threshold for transmission data. For details on the Higher Level Settings dialog box, see (5) Higher
level settings below in this subsection.
The amount of transfer data is reduced approximately by half.

Use flow control
Select this check box to use flow control to automatically adjust the amount of data. By default, this is not
selected.
If you select this option, the amount of data transferred from the agent to the controller is controlled automatically.
Therefore, remote controls handling high data volumes such as animation or video media, or running in an
environment with slow speed communication lines, can operate under stable conditions. However, if you use flow
control, the response time when compared to not using the flow control is slower and the display is not as smooth.
Leave the check box unselected for a high-speed and smooth remote control. If, however, you are using a slow
communication line or if you are displaying animation or video in the agent, the performance of the remote
controller will degrade drastically.

(2) Desktop
You can specify options related to the agent's desktop display.
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Do not show the wallpaper
Select this check box to suppress the display of wallpaper on the agent. Selecting this option will eliminate
wallpaper-related information, and thus reduce the overall size of transmission data.
If the agent is using the Web page viewing facility of the Active Desktop, however, you cannot suppress the
display of wallpaper. In this case, select the Do not show the Active Desktop web page option at the same time.

Do not show the window animation, etc.
Select this check box to suppress window and menu animations, title bar and caption gradations, and other user
interface effects on the agent window. Data for user interface effects will not be sent. This reduces the amount of
data transferred. The user interface effects that can be suppressed with this check box are listed below.

User interface effect that can be suppressed Explanation

Window animation Animation used to show or hide a window

Combo box animation Animation used to show or hide a combo box

Menu animation Animation used to show or hide a menu

Tool tip animation Animation used to show or hide a tool tip.

Gradated caption display Window title bar caption displayed with a gradation

Shaded mouse cursor Mouse cursor with a shade around

Do not show the Active Desktop web page
Select this check box to suppress viewing Web pages on the agent's Active Desktop. Selecting this option will
reduce the drawing data on the desktop background, and thus reduce the overall size of transmission data.

Do not show window contents while dragging
Select this check box to suppress the display of window contents while the window is being dragged on the agent.
Selecting this option will move only the window frame on the agent, rather than the full window, and thus reduce
the overall size of transmission data.

(3) Display
You can specify options related to the drawing process when the agent display is shown on the controller.

Reduce bitmap color
Select this check box to reduce the colors of bitmap images. Selecting this option will reduce the colors of bitmap
images, and thus reduce the overall size of transmission data.
You can choose either of the following color reduction methods:

Monochrome
Reduces the colors of bitmap images to two colors (that is, black and white). The following are restrictions
when bitmap images are reduced to two colors:

• The colors of some bitmap images cannot be reduced.

• Screens behind menu lists might be displayed incorrectly after the menu lists are displayed.

16 colors
Reduces the colors of bitmap images to sixteen colors. The following are restrictions when bitmap images are
reduced to sixteen colors:

• This option is inactive when connecting to an agent whose version is 05-10.

• Even if 16 colors is chosen, when you connect to an agent whose version is 05-10, the Reduce bitmap
color setting automatically changes to Monochrome.

256 colors
Reduces the number of colors in bitmap images to 256. The following restrictions apply to the conversion to
256 colors.

• This option is inactive if the controller is connected to an agent 06-00 or earlier.
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• If the controller is configured to 256 colors, and then is connected to an agent 05-10, it is automatically
reconfigured to Monochrome. If the controller is connected to an agent the version of which is 05-23 or
later and 06-00 or earlier, it is automatically reconfigured to 16 colors.

Use cache to display bitmaps
Select this check box to cache the bitmap images commonly used in Windows. Selecting this option will eliminate
the bitmap data cached by the controller, and thus reduce the overall size of transmission data.
Note the following when using this option.

• This option is inactive if the controller is connected to an agent whose version is 06-00 or earlier and whose
operating system is Windows Me or Windows 98.

• If the controller is configured to select this option and then is connected to an agent whose version is 06-00 or
earlier and whose operating system is Windows Me or Windows 98, the controller is automatically
reconfigured to prevent the cache from being used to display bitmaps (the check box is cleared).

• The following free disk space will be required on both the controller and agent in order to create cache files.
Controller: 10 megabytes multiplied by the number of agents connected at the same time
Agent: 10 megabytes

The cache file will be automatically deleted when the controller is disconnected from the agent. If cache file
creation fails for a reason such as insufficient disk space, an error message reporting the cache file creation failure
is displayed. This error causes the cache option setting to be automatically invalidated (the check box is cleared).
However, connection is established normally. The error message is only displayed on the controller.

The following option is effective only when connecting the controller to a Windows 8, Windows Server 2012,
Windows 7, Windows Server 2008, Windows Vista, Windows Server 2003, Windows XP, Windows 2000, or
Windows NT 4.0 agent.

Use local font
Select this check box to use the controller's fonts to display characters. Selecting this option will eliminate font-
related information, and thus reduce the overall size of transmission data. Note that some text may not be shown
correctly, depending on the font used.

(4) Mouse

Send mouse movement at click in the window
Select this check box to configure the system so that mouse movement information is transmitted from the
controller to the agent only when the controller user clicks or drags the mouse. When this facility is enabled, the
pointer on the agent display does not move even if the user moves the mouse on the controller side, as long as you
do not click the mouse. The pointer on the agent display moves only when the controller user makes a clicking or
dragging operation.
Using this facility can reduce the overall size of transmission data. This facility is recommended when the
connection is made over low-speed lines. However, this facility compromises operability, as the mouse position
on the controller does not correspond to the pointer position on the agent.

(5) Higher level settings
You can configure the data compression threshold and polling interval to conform to the network environment to
which you wish to connect the agent. The default settings are values recommended for use in the LAN environment.
In the WAN environment, or if you want to modify the default values for the LAN environment, click Higher Level
Settings. The Higher Level Settings dialog box appears.
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Figure 3‒10: Higher Level Settings dialog box

Specify data size to compress
Select this check box to specify the compression threshold for transmission data. You can select one of the
following 6 settings as the compression threshold. The default setting is 4096 bytes or more.
Click Description to view the description on how to specify the compression threshold.

• 1 byte or more
Compresses all transmission data. This option will increase the load on the CPU, and may slow down the
processing speed.

• 512 bytes or more
Recommended for the WAN environment.

• 1024 bytes or more
Effective in the WAN environment.

• 4096 bytes or more
Recommended for the LAN environment.

• 8192 bytes or more
Effective in the LAN environment.

• 16384 bytes or more
Compresses transmission data of 16,384 bytes or more. This option will reduce the amount of data to be
compressed, and increase the overall amount of transmission data.

Specify polling interval
Select this check box to specify the polling interval.
The agent receives drawing instructions and sends all the drawing data at the specified interval. Setting a long
polling interval will create a time lag between the display shown on the controller and the actual screen on the
agent, but effectively reduces the overall size of transmission data. You can select one of the following 6 polling
intervals. The default is 100 milliseconds.
Click Description to view the description on how to specify the polling interval.

• 50 milliseconds
Increases the amount of transmission data.

• 100 milliseconds
Recommended for the LAN environment.

• 300 milliseconds
Effective in the LAN environment.

• 1000 milliseconds
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Recommended for the WAN environment.

• 3000 milliseconds
Effective in the WAN environment.

• 5000 milliseconds
Reduces the amount of transmission data, but delays the drawing process on the controller.

3.3.3 Control Mode page
The Control Mode page allows you to set up the remote control mode of the controller. When the mode defined in
this page does not agree with the mode defined for the agent, the system adjusts the modes according to certain
conditions when establishing the connection. For details on the remote control mode, see 3.1 Remote control mode.

The Control Mode page is shown below.

Figure 3‒11: Control Mode page

(1) Remote control mode

View
Enables to only view the agent screen.

Shared
Enables operation of the agent from both the controller and agent. The controller user can view the agent screen
and provide operation support to the agent (e.g. correcting the operation of the agent user).

Exclusive
Enables the remote control of the agent, while suppressing operations from the agent. The controller must be in
the exclusive mode when it performs operations that make it necessary that no operations be implemented from
the agent, e.g., when the controller user is trying to modify the machine environment of the agent.
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When the controller is in the exclusive mode, the agent takes the view mode, and cannot perform most keyboard
or mouse operations. (Some keys are enabled.)

3.3.4 Window page
From the Window page, you can specify the operating environment for displaying the agent window in the Remote
Control window of the controller. The Window page is shown below.

Figure 3‒12: Window page

(1) Scroll
You can specify options related to the scrolling operation of the Remote Control window.

Scroll amount
Specify the following scroll amounts in pixels in the Remote Control window. The default scroll amount is 10
pixels.

• The number of pixels the screen scrolls when you click an arrow button on a scroll bar.

• The number of pixels the screen scrolls when you use a mouse scroll wheel.

• The number of pixels the screen scrolls when you select the Scroll synchronized with the mouse pointer
check box and create a scroll.

Disable wheel scroll
Select this check box when you want to disable scrolling with the mouse's scrolling wheel for the Remote Control
window. Even if you choose this option, you can still wheel-scroll the scroll bar in the agent screen called into the
Remote Control window.
Select this option when wheel scrolling is inconvenient because it moves both the Remote Control window and
the agent's window at the same time.
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Scroll synchronized with the mouse pointer
Select this check box to configure an agent to that it scrolls automatically when you move the mouse pointer close
to the end of the window. By default, this check box is not selected.
If you select this check box, select one of the following scroll methods:

• Always
When you move the mouse pointer close to a window edge, the window will always scroll automatically.

• Only while dragging
When you move the mouse pointer close to a window edge, the window will scroll automatically if you are
dragging. If you are not dragging, the window will not scroll automatically.

Scroll synchronized with the active window
Select this check box if you want any active agent window to scroll automatically so that it always is displayed
within the controller's display area. By default, this check box is not selected.
This function is available only if the version of the agent connected to the controller is 06-00 or later.

(2) Window size
You can specify options related to the size of the Remote Control window.

Window size is variable
Select this check box when you do not want to fix the size of the controller's window.
When you specify fixing the window size, it will be adjusted to a size corresponding to the resolution of the
agent's screen. Therefore, if you call up the screen of an agent with low resolution, the controller's toolbar and
status bar will not be shown fully.

(3) Keyboard/Mouse
You can specify options related to the keyboard and mouse operations of the Remote Control window.

While dragging limit the mouse movement within the window
Select this check box if you want to contain the mouse pointer within the Remote Control window while dragging
the mouse. This check box is cleared by default. The setting takes effect when the remote control mode is shared
or exclusive.

Give priority to the controller's mouse button settings
Select this check box to assign priority to the controller's mouse button settings (for left or right hand use).
If the controller's mouse button settings are different from the agent's mouse button settings and this check box is
not selected, mouse button operations on the controller will be interpreted as different operations on the agent. If
this check box is selected, the controller's mouse button operations are performed correctly on the agent regardless
of the agent's mouse button settings.
Leave this check box unselected to assign priority to the agent's mouse button settings.
This function is available if the version of the agent connected to the controller is 06-00 or later.

Send input of the system key
Select this check box if you want to enter a system key on the controller and execute the system key on the agent.
By default, this check box is not selected.
With this check box selected, the following four key combinations can initiate respective operations directly on
the agent.

Table 3‒4: Key and key sequences that you can use to operate the agent from the controller by
specifying settings on the Window page

Key or key sequence Function

Windows Opens the start menu.

Ctrl + Esc

Alt + Esc Switches active applications.

Alt + Tab Opens a dialog box for selecting an application.
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Note that the key and key sequences listed above can be used only when the controller OS is Windows 8,
Windows Server 2012, Windows 7, Windows Server 2008, Windows Vista, Windows Server 2003, Windows XP,
Windows 2000, or Windows NT 4.0 Service Pack 3 or later.

Set the double-click speed to match the controller
If you select this check box, the agent will recognize a double-click based on the controller double-click speed
setting. You can see the double-click speed setting by choosing Control Panel, Mouse, and then Mouse
Properties. By default, this check box is cleared.
If the agent does not recognize double-clicks when you run a certain application, clear this check box. The agent
will then recognize double-clicks based on its own double-click speed setting.

(4) Zoom
You can specify options related to the keyboard and mouse operations of the Remote Control window.

Auto-zoom
Select this check box to automatically zoom the displayed agent window according to the size of the Remote
Control window. By default, this option is unselected.
When you select this check box, you perform the same operation as when you choose View, Zoom, and then
Auto-zoom from the Remote Control window menu. The selection status of the check box is linked to that of the
Auto-zoom menu item.
To cancel the zoom, perform one of the following operations:

• Clear this check box.

• Clear the Auto-zoom menu item, and then choose Cancel.

If you select the Auto-zoom check box, set the image quality in the following Zoom priority section.

Zoom priority
Select Speed or Image quality for the image of the agent window that is auto-zoomed to the window size. By
default, Speed is selected.
This setting is not only applied when the Auto-zoom check box is selected, but also when you choose View,
Zoom, and then Zoom Out to Fit from the Remote Control window menu.

Speed
This performs high-speed zooming. However, the image quality is poor, and characters and icons are hard to
see.

Image quality
This performs zooming with high-quality images. The display speed is slower than when selecting Speed, but
characters and icons are clearer.
Note that the Image quality option is available only for the following versions of the controller: Windows 8,
Windows Server 2012, Windows 7, Windows Server 2008, Windows Vista, Windows Server 2003, Windows
XP, Windows 2000, and Windows NT 4.0.

3.3.5 Toolbar page
You can use the Toolbar page to make settings for the toolbar in the Remote Control window. The Toolbar page is
shown below.
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Figure 3‒13: Toolbar page

(1) Toolbar

Show the toolbar
Select this check box to display the toolbar in the Remote Control window. By default, this check box is selected
(the toolbar is displayed).

Show the button text labels
Select this check box to display the text labels for the buttons on the toolbar. By default, this check box is selected.

(2) Address bar

Show the address bar
Select this check box to display the address bar in the Remote Control window. By default, this check box is
selected.

(3) Status bar
You can choose the items you want to show on the status bar of the Remote Control window.

Show the status bar
Select this check box to display the status bar in the Remote Control window.

Show elapsed time
Shows the amount of time that has elapsed since the connection was established with the agent.

Show the amount of data sent
Shows the amount of sent data (data sent from the controller to the agent).
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Show the amount of data received
Shows the amount of received data (screen data sent from the agent).

Show status icon of data transfer
Shows the icon representing the data transmission status with the agent.

Show status of Ctrl and Alt keys
Shows the icon representing whether the Ctrl and Alt keys are pressed down on the agent side.

(4) Action keys

Show action keys
You can display the action keys you have registered on the Register Action Key page in the Properties dialog box
in the button bar (action keys) above the status bar. Showing frequently used action keys in the action keys will
allow you to send the action keys to the agent by simply clicking the button.

3.3.6 File Transfer page
The File Transfer page allows you to set up the operating environment associated with file transmission between the
controller and agent. The File Transfer page is shown below.

Figure 3‒14: File Transfer page

(1) Data transmission
You can set up data compression and data encryption. This option can be specified in the Transfer Options dialog box
of the File Transfer window. If the connection destination has different values set in this option, the most recently
saved setting will take effect. By default, the Compress the data to transfer option is selected.
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Compress the data to transfer
Select this check box to compress transmission data. This check box is selected by default. Compressing
transmission data will reduce the amount of time required for file transfer and reduce the amount of transmission
data approximately by half. For details on the transmission data compression ratio, see 4.3.9(2) Transfer page.

Encrypt the data to transfer
Select this check box to encrypt transmission data.

(2) Agent's default folder
You can specify the default folder on the agent for storing files transferred without a specific destination. This folder
will store files which are dragged and dropped from the Explorer to the Remote Control window. If you specify a
nonexistent folder name, the system will create a new folder at the time of file transmission.

If you do not specify a default folder, drag and drop file transmission will be disabled.

By default, no folder is specified.

(3) File Transfer window

Show the File Transfer window
Select this check box to show the File Transfer window when transferring files by drag and drop. If you specify
not to show the File Transfer window, dropping the file(s) will immediately trigger transmission, and send the
file(s) to the agent's default folder defined in (2) above.
If you use a menu command or button to transfer file(s), the File Transfer window will always appear, regardless
of your settings here.

3.3.7 Logging page
The Logging page allows you to set information on log output. The Logging page is shown below.
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Figure 3‒15: Logging page

(1) Disable logging
Select this option to disable logging. This is selected by default.

(2) Log all data items
Select this option to log all data items.

(3) Select the items to log
Select this option to select the types of information you want to log. You can select from the following types.
Connect/disconnect information is selected by default.

• Connect/disconnect

• Authenticate

• Reboot/shutdown

• Ctrl+Alt+Delete

• Remote control mode

• Optimize Transaction option

(4) Print method

Maximum lines in a log file
Specify the maximum number of lines in a log file as an integer from 0 to 9,999. The default is 500 lines.
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Generations to be saved
Specify the number of log generations to be saved as an integer from 0 to 99. The value specified here will form
the last 2 digits of the log file name, indicating the generation number. The default is 0 (no generation
management).

3.3.8 Clipboard page
The Clipboard page allows you to set information related to the automatic transfer of clipboard data. The Clipboard
page is shown below.

Figure 3‒16: Clipboard page

(1) Transfer the clipboard data automatically
Select this check box to use the automatic clipboard transfer facility. This facility automatically transfers clipboard
data between the controller and agent.

The automatic transfer of clipboard data is only available when the version of the agent at the connection destination
is 05-21 or later.

(2) Transfer type
You can specify the direction for transferring clipboard data.

Send
The controller's clipboard data is sent to the agent when the contents of the clipboard is updated.

Receive
The controller receives the agent's clipboard data, when the contents of the clipboard is updated.
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Share
The combination of the above two. Both the controller and agent share the same contents in the clipboard.

(3) Options
When you select either Receive or Share as the Transfer type, you can specify conditions for data transmission.

Always receive the data
Ensures the controller is ready to receive clipboard data from the connected agent at all times. When the controller
is connected to more than one agent, it receives the clipboard data from all the agents.

Receive the data only when the Remote Control window is active
The controller receives clipboard data from the connected agent, only when the Remote Control window is active.
Even if the controller is connected to more than one agent, it only receives clipboard data of the agent subject to
remote control operations.

(4) Data type
You can specify the data type to be transferred with the automatic clipboard transfer facility.

Plain text
Only transfers the text portion of the clipboard data.

Formatted data
Transfers text as well as other types of clipboard data. You can transfer text files, bitmap files, metafiles, rich text
format files, color palettes, and the combination of any of these.

3.3.9 Register Action Key page
If the Remote Control mode is Shared or Exclusive, you can register shortcut keys, which cannot be directly sent
from the keyboard, as action keys and send the action keys to the agent.

Action keys that are registered on this page can be sent from this page or the action key bar at the bottom of the
Remote Control window.

To display the action key bar, open the View menu and choose Action Keys. Alternatively, go to the Properties dialog
box, open the Toolbar page, and then select the Show the toolbar check box.

The settings specified on this page will also be saved when you click the Update button.

The Register Action Key page is shown below.
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Figure 3‒17: Register Action Key page

(1) Action keys
The available action keys are displayed, classified by type.

(2) Action key type
Select Default or Custom as the action key type. When you select Default, a list of the default action keys
provided by JP1/Remote Control Manager is displayed in the Action keys area. When you select Custom, a list of
keys that can be combined by the user is displayed in the Action keys area.

(3) Description
A descriptive text is displayed for the key selected in the Action keys area.

(4) Selected key
The selected key is displayed. When you select a key from the list in the Action keys area and click >>, the selected
key is displayed here. If you click the Register button while keys are in the Selected key area, those keys are
registered as action keys and are moved to the Registered keys area.

Keys selected from Custom can be combined with keys from the Selected key area. For example, if you select
Windows + and click the >> button, and then select E and click the >> button, a key called Windows + E is
displayed in the Selected key area. You cannot customize action keys selected from Default.

To remove keys from the Selected key area, click the Reset button or << button. If keys selected from Custom are
combined, clicking the Reset button clears all the keys, and clicking the << button removes the action keys one by one
from the right box.
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(5) Registered keys
This area shows a list of the currently registered action keys. These action keys can be sent to the agent. To send an
action key to the agent, select the action key to be sent and click the Send button. To remove a registered action key,
select the action key and click the Remove button.

In the action-keys input bar at the bottom of the Remote Control window, the action keys are displayed in the order
shown in the Registered keys list. To resort the action keys, select an action key and click the ^ or v button.

3.3.10 Record page
You can use the Record page to configure settings for agent screen information recording. The Record page is shown
below.

Figure 3‒18: Record page

(1) File
Specify the name of the file that will contain recorded information on the agent screen and where to store the file. If
you specify a recording file in advance, you do not need to specify the recording file name when starting the recording
of the window information in the Remote Control window. By default, a recording file is not specified (it is blank).

If you specify a file name, the recording file is overwritten at each recording. However, if you need a different
recording file for each recording, you can set the file name so that a variable is automatically appended to the name.
You can set a file name with a variable from the Select Recording File dialog box that is displayed by clicking the
Browse button
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Figure 3‒19: Select Recording File dialog box

From the Save as type list, select a template for the file name. You can select from the following three types.

• AgentName.rcr
• AgentName Date Time.rcr
• Date Time AgentName.rcr

If you select a template, the file name with the variable is displayed in the File name box.

You can also combine custom variables and directly specify the recording file name in the File name box. For details
on using variables to specify the recording file name, see 4.5.2(4)(a) Setting up a recording file.

(2) Start recording when connected
Select this check box if you want to start recording when you connect to the agent. By default, this check box is
cleared.

(3) Show the status icon
Select this check box to display the icon that indicates the recording status of the agent window information (status
icon). The icon is displayed in the status bar. By default, this check box is cleared.

3.3.11 Security page
You can use the Security page to configure data encryption and control the screen display of the agent when remote
control is enabled. The Security page is shown below.
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Figure 3‒20: Security page

(1) Data transfer

Encrypt the data to transmit
Select this check box to encrypt the data to transmit from the controller to the agent.
When you select this check box, the data you enter via controller keyboard and mouse operations and clipboard
data are encrypted when they are transmitted to the agent. The amount of encrypted data is approximately twice
the amount of unencrypted data.

Encrypt the data to receive
Select this check box to encrypt the data to receive from the agent to the controller.
When you select this check box, agent screen information and clipboard data are encrypted when they are
transmitted to the controller. The amount of encrypted data is approximately 1.1 times the amount of unencrypted
data.

(2) Screen blackout
Set up the screen display on the agent PC for when remote control is used. This setting is available for an agent whose
version is 08-00 or later.

Black out agent PC display when the remote control mode of the controller is Exclusive mode
Select this check box to black out the agent display when remote control is being used. This check box is not
selected by default. This check box is inactive when the OS on the connected agent is Windows Server 2003
(IPF), Windows NT 4.0, Windows Me, or Windows 98.
This setting is valid only when the remote control mode of the controller is exclusive. If this remote control mode
is changed to another mode during remote control operations, the blackout setting of the agent display is disabled.
If you change the setting of the check box during remote control operation, the agent display is controlled
according to the timing of the setting change.
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Note the following when you black out the agent display:

• The display board and display of the agent machine must support the power-saving mode.

• Thoroughly check operation in a test environment before you apply blacking out of the agent display. When
remote control is used, the CPU usage might be displayed as 100% on the agent PC, or an unintended image
might remain on the screen at intervals of a few seconds.

• The blackout display restriction on the agent might be forcibly lifted. The table below explains when this can
happen.

Table 3‒5: Causes of blackout display restriction on the agent display being forcibly lifted

Cause Description

Communication is disconnected • The controller disconnected or terminated remote control.

• The agent disconnected or terminated remote control.

• Remote control was disconnected due to a communication error.

Exclusive mode is canceled • The Ctrl + Alt + Del keys are pressed on the agent.

• A hardware error or system error message is displayed on the agent. Alternatively, the displayed
message box was closed.

• The Windows Messenger service displayed a message on the agent. Alternatively, the displayed
message box was closed.

Lock agent PC if the connection is disconnected while the display is blacked out, or the blackout display
restriction is lifted forcibly

Select this check box to lock the agent if the blackout display restriction on the agent is forcibly lifted. This
check box is not selected by default.
This check box is enabled only when the Black out agent PC display when the remote control mode of the
controller is Exclusive mode check box is selected.

3.3.12 Dial-up Settings page
The Dial-up Settings page allows you to set up the connection destination at the time of a dialup connection. This
page is shown in the environment where Dial-Up Networking (Remote Access Service) is installed.

To use the automatic dialing facility, you need to configure Windows Dial-Up Networking or Remote Access Service.
For the controller, you can start the Dial-Up Networking (Remote Access Service) directly from the Dial-up Settings
page and modify settings.

The Dial-up Settings page is shown below.
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Figure 3‒21: Dial-up Settings page

When using the automatic dialing facility, select the Use dial-up connection check box and configure the settings
described in (1) and (2) below. Note that you can only set up one dialing destination. If the dialing destination varies
from agent to agent, you need to change settings each time the dialing destination changes.

(1) List of destination agents
Lists all the entries registered in the current telephone book. Select one of them as the connection destination.

Choose Details button to display the Details dialog box. You can specify the following items in this dialog box.

(a) Connection page

This page allows you to set up detailed information related to connection and disconnection.
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Figure 3‒22: Connection page

Retrying dial-up connection
Select this check box to enable automatic redialing when an attempt to make a dialup connection fails. You can
specify the number of retries and their interval. This check box is cleared by default.

Number of retries
Specify the number of retries as an integer from 1 to 5 (attempts). The default is 3 attempts.

Retry interval
Specify the retry interval as an integer from 10 to 180 (seconds). The default is 30 seconds.

Disconnect when the remote control stops
Select this check box when you want to sever the dialup connection upon completion of remote control operations
(when disconnecting from the agent). This option is selected by default.
If you clear this check box, a dialup connection will be severed when Remote Control Manager is terminated
(when the Remote Control window is closed).

(b) Logon page

The Logon page allows you to set up logon information to be used when establishing a dialup connection.

Figure 3‒23: Logon page

Save authentication information
Select this check box when you want to save authentication information. Saving the information will allow you to
omit the logon procedure when establishing a connection. This option is cleared by default.
If you select this check box you must enter a user name, password, and domain of the logon user. Omitting these
values will cause the system to assume the current user name, password, and domain remain valid.
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(2) Define Windows dial-up network
In this area of the Dial-up Settings page in the Property dialog box you can directly add, modify, or delete the settings
for the Dial-Up Networking (Remote Access Service) of the OS.

New
Adds a new connection destination, using Windows functionality.

Edit
Edits the information of the entry selected in the List of destination agents section.

Delete
Deletes the entry selected in the List of destination agents section.

The operations of the New, Edit, and Delete buttons in this area will directly modify the settings in the OS. Any
changes you make will immediately take effect even if you choose Cancel in the Properties dialog box.

3.3.13 Others page
From the Others page, you can save (to a file) the property information you set in the Properties dialog box of the
controller. You can also load property information from a saved file.

By loading the same property information file to multiple controllers, you can unify the operating environment of
those controllers.

The Others page is shown below.

Figure 3‒24: Others page

Save (in the Properties area)
Saves the settings of the Properties dialog box to an INI file. Clicking the Save button displays a dialog box for
specifying the name of the file to be saved. The default file name that is displayed is Settings.ini.
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Read
Reads (that is, loads) the property information from a file. Clicking the Read button displays a dialog box for
specifying the file to be read.
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3.4 Setting up the operating environment of Remote
Control Agent

You can define the operating environment for Remote Control Agent in the Remote Control Agent Setup dialog box,
or Remote Control Agent - Properties dialog box. The following section explains how to display each of the dialog
boxes.

• Remote Control Agent Setup dialog box
This dialog box is displayed after installation of Remote Control Agent. You can also display the dialog box by
choosing, from the Start menu, Programs, JP1_Remote Control Agent, and then Setup. For JP1/Software
Distribution Remote Control Agents, from each JP1/Software Distribution program folder, choose Remote
Control Agent, and then Setup.

• Remote Control Agent - Properties dialog box
Display this dialog box from the Remote Control Agent menu. Right-click the Remote Control Agent icon in the
Status window or task bar, and then choose Properties from the popup menu.

Although there may be minor variations, you can set up identical items in the two dialog boxes. However, the Change
Device Files window is only displayed during the setup procedure and is not displayed in the Remote Control Agent -
Properties dialog box.

The table below shows the setup items for Remote Control Agent. The following description of setup items uses the
pages of the Remote Control Agent Setup dialog box. The following table displays the sequence of pages that are
displayed in the Remote Control Agent Setup dialog box.

Table 3‒6: Operating environment items for Remote Control Agent

Classification Item

Start options Enable/disable automatic startup

Show/hide the icon

Enable/disable manual termination

Remote control mode (view/shared/exclusive)

Connection options Port number

Enable/disable automatic disconnection

Show/hide a connection-confirmation dialog box.

Settings for permitted controllers Permitted controller (host name or IP address)

Authentication settings Authentication information

Settings for logging Enable/disable logging

Print method

File transmission settings Enable/disable file transmission

Output of file access logs

Chat server settings Set the operating environment of the chat server

Memory settings (for Windows Me and
Windows 98)

Use/change default memory settings

Password to change setup Password to change setup

Device file settings (for Windows NT 4.0) Change device file

Note that, when you specify a setup password (one of the setup items), users who do not have this password cannot
view or modify the setup information.
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The following section explains each setting. The explanation shows screenshots of the Remote Control Agent Setup
dialog box.

3.4.1 Start options
You can set start options in the dialog box shown below. In the Remote Control Agent - Properties dialog box, the
Start Options page corresponds to this dialog box.

Figure 3‒25: Remote Control Agent Setup dialog box (setting start options)

(1) Options

Agent is started automatically
Select this check box to automatically start Remote Control Agent when Windows is launched. This option is
cleared by default.
If the setting for this item was changed, the computer must be restarted.

Show the icon in the taskbar
Select this check box to show the Remote Control Agent icon in the taskbar at Remote Control Agent startup.
This option is selected by default.
In Windows 8, Windows Server 2012, Windows 7 and Windows Server 2008 R2, the Remote Control Agent
icon is not displayed on the taskbar. If you want to display the icon on the taskbar, choose Control Panel,
Appearance and Personalization, and then Customize icons on the taskbar. Next, select Show icon and
notifications for Behaviors for the Remote Control Agent icon.

Enable termination of the agent
Select this check box to enable a manual termination of Remote Control Agent. Selecting this option will activate
the Exit menu of Remote Control Agent. This option is selected by default.

(2) Mode
This facility allows you to set the remote control mode for the agent. The default setting is Shared.

When the mode specified here does not agree with the mode defined for the controller, they will be adjusted according
to set rules. For details on the remote control mode, see 3.1 Remote control mode. An agent in the view mode does not
accept local operations, and thus will not allow you to modify the mode in this dialog box. For details on how to
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change the remote control mode for a system in the view mode, see 3.1.2 Changing the remote control mode of the
agent in the view mode.

View
Restricts you to viewing the screen of the agent (local machine). You cannot make screen operations. The agent
assumes this mode when the connected controller is in the exclusive mode.

Shared
Allows you to operate the agent from both the controller and agent.

Exclusive
Denies any operations from the controller, and allows only the agent user to operate the agent.

3.4.2 Connection options
The next dialog box allows you to set options for connection or disconnection from the controller. In the Remote
Control Agent - Properties dialog box, the Connection page serves as this dialog box.

Figure 3‒26: Remote Control Agent Setup dialog box (setting connection options)

(1) Port number
Specify the number of the port to be used at the agent side. Make sure to specify the same value as the controller you
plan to connect with. The default port number is 30003.

(2) When not connected to any controller
Select the process the agent should take when all connections with the controller are severed. The default is The agent
continues running.

The agent continues running
Leaves Remote Control Agent running and waits for a reconnection attempt. If the controller sends a reconnection
request, the connection will be re-established.
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The agent terminates
Automatically terminates Remote Control Agent when the connection with the last controller is severed. Even if
the controller makes a reconnection request, the connection will not be re-established.

(3) Show a connection-confirmation dialog box
Select this check box to display the Confirm Connection Request dialog box that is used to notify the user of a
connection request from the controller. The user can accept or reject the connection request from the controller in the
Confirm Connection Request dialog box. By default, this check box is not selected (the dialog box is not displayed).

Show the dialog box for
Specify a value from 0 to 180 seconds as the time allowed for the user to accept or reject the connection request. If
you specify 0, the dialog box is displayed until the user replies. The default value is 10 seconds.
If the user does not reply during the time specified here, the connection request is accepted or rejected depending
on the value assigned to After period elapses.

After period elapses
Specify whether to accept or reject the connection request from the controller if no user response is received
within the time specified in Show the dialog box for.

Permit connection
Accepts the connection request.

Reject connection
Rejects the connection request.

Show the dialog box at
Specify where to display the Confirm Connection Request dialog box on the desktop window. You can select
Center, Top left, Top right, Bottom left, or Bottom right. The default is Bottom right.

3.4.3 Settings for permitted controllers
You can define controllers that are allowed to connect to the local system as permitted controllers.

When using the remote control facility, unconditionally allowing controllers to conduct operations may result in
damage to the agent's environment due to carelessness or malicious operations. Once a permitted controller is set up,
the system can reject connection requests from controllers that are not registered as permitted controllers. If no
permitted controller is set up, the system accepts connection requests from any controller.

You can also restrict users making controller connections. For details on how to make the settings, see 3.4.4
Authentication settings.

Use the following dialog box to define permitted controllers. In the Remote Control Agent - Properties dialog box, the
Permitted controller page serves as this dialog box.

3. Environment Setup

70



Figure 3‒27: Remote Control Agent Setup dialog box (setting permitted controllers)

Permitted controllers
In the Host name or IP address box, enter the host name or IP address of the machine that you want to permit
control for connection.
In this text box, enter no more than 255 characters per item. The host name is case insensitive.
For the host name, specify a name that the agent recognizes. If the definition of the DNS or host name is not the
same for the agent and the controller, the system may reject connection or may accept connection from an invalid
host.
If processing on the network requires a long time when you specify a host name, specify an IP address consisting
of decimal numbers separated by periods.
You can use a wildcard in the host name or IP address to specify multiple permitted controllers at the same time.
The following wildcards are available:

* (asterisk)
Represents 0 or more characters.

? (question mark)
Represents any one character.

When you use a wildcard for the host name, the host name must include at least one alphabetic character. For
example, if you want to specify the host names 2gHostA and 2gHostB for the permitted controllers, specify
2g* or 2gHost*. If you specify a host name consisting of only numbers and a wildcard, the system handles the
host name as an IP address. This might cause incorrect operation.
To use a wildcard for an IP address, you must specify four decimal numbers separated by periods. For example, if
you want to specify the IP address 10.208.* or 10.208.??????? for the permitted controller, specify
10.208.*.* or 10.208.??.???. If the IP address contains more or fewer than four periods as separators, the
system treats it as a host name. This might cause incorrect operation.
The table below gives examples of using wildcards to specify host names and IP addresses.

Table 3‒7: Examples of specifying wildcards

Example Applicable character string

help* Host name beginning with help, such as help, helpdesk, and helper

A*z Host name beginning with A and ending with z
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Example Applicable character string

admin?host Host name containing any one character between admin and host. For example, admin1host and
admin2host.

Win?? Host name consisting of five characters beginning with Win

10.208.*.* IP address from 10.208.0.0 to 10.208.255.255

10.208.93.* IP address from 10.208.93.0 to 10.208.93.255

Click the Add button to add the entry into the list box under the text box. The list box can have a maximum of 256
items. You cannot add an item that already exists in the list box.
You can also select an item in the list box and click the Delete button to delete the item from the list box. When
you select multiple items in the list box, you can delete multiple permitted controllers at the same time.

3.4.4 Authentication settings
You can define authentication information for restricting users making controller connections. Specify authentication
information when you want to permit remote control for specified users. If you do not specify anything, the system
accepts connections from all users.

You can also define authentication information that remains in effect only for a predefined period of time. By
registering this authentication information together with other authentication information, you can usually permit
connection only for registered users while also temporarily permitting connection for the help desk in the case of a
machine failure.

You can register multiple users in the authentication information, and manage them with passwords. For each user
registered, you can specify whether or not to permit remote control operations such as setting shared mode or
exclusive mode and shutting down the agent. You can also use user authentication linked with the Windows
Authentication feature to enhance security for remote control.

You can use the following three types of user authentication for setting authentication information:

• Standard authentication
User authentication provided by JP1/Remote Control. Only those users who have the user name and password
specified in the authentication information can connect to the agent.

• Windows authentication
User authentication linked with the Windows Authentication feature. Only those Windows users and groups
specified in the authentication information can connect to the agent. You can apply detailed security policies,
including password expiration dates and audits, to this type of user authentication.

• Temporary authentication
User authentication provided by JP1/Remote Control. Only the user (temporary user) who has the user name and
password specified in the temporary authentication information can connect to the agent. You can register only
one user in the temporary authentication information.
You can also specify a waiting time for this type of user authentication. When the specified waiting time has
elapsed, the authentication information is no longer valid.

If user information has been specified in an agent 07-00 or earlier, the User Authentication dialog box appears before
you specify authentication information. In this case, specify the user ID and password specified in 07-00 or earlier.

The dialog box for setting up authentication information is shown below. In the Remote Control Agent - Properties
dialog box, the Authentication Settings page corresponds to this dialog box.
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Figure 3‒28: Remote Control Agent Setup dialog box (setting authentication information)

Permitted user list
Displays a list of users for which remote control is permitted.

Name
Displays the user names for which remote control is permitted. If you specify Group for the user type for
Windows authentication, the group names are displayed. For temporary authentication, Temporary user
appears. For details on specifying Windows authentication, see (1) Adding authentication information.

Type
Displays the types of users listed in the table below.

Table 3‒8: User types

User type Description

Standard User for which connection is permitted in standard authentication

Windows User User for which connection is permitted in Windows authentication

Windows Group Group for which connection is permitted in Windows authentication

Temporary User for which connection is permitted in temporary authentication

Domain
Displays the domain name for Windows authentication. For a Windows user or group on the local computer,
the local computer name is displayed.
A domain name is not displayed for standard authentication and temporary authentication. This item is not
displayed in Windows Me and Windows 98.

Description
Displays a description of the user.

The following describes how to add, delete, and edit authentication information.

(1) Adding authentication information
To add authentication information, use the Add User dialog box that appears when you click the Add button.
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In the pages of this dialog box, specify information such as the user name and password, and the functions of
permitted remote control operations.

When you finish the specification on the pages, click the OK button to close the dialog box. Click the Cancel button
to cancel the specified authentication information. If you want to continue the specification of authentication
information without closing the dialog box, click the Apply button.

The following describes how to specify user information, including user name and password, and permitted remote
control operations.

(a) Specifying user information

In the General page, specify user information such as the user name and password. The following shows the General
page.

Figure 3‒29: General page

The following describes how to specify user information for each authentication method.

Using standard authentication
To use standard user authentication provided by JP1/Remote Control, select Standard for Type.

Name
Specify the user name, using no more than 20 characters. This item must be specified. The specified user
name is case sensitive.
You cannot use the following names:

• Already registered name

• A name containing any of the following symbols or space:
\, /, *, ", :, ', !, |, ., <, >, ?, %, ,

When you use standard authentication function, the List button is disabled.

Description
Specify the description of the user, using no more than 260 characters. This item is optional. This item is
optional.

Password
Specify the password, using no more than 14 characters. This item is optional.
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Re-enter the password
When you enter the password, re-enter it for confirmation.

Change the user name and password when a connection is established
Select this check box if you want the Change User Name and Password dialog box to be displayed when an
attempt is made to connect from Remote Control Manager. By default, this check box is cleared.
Once the user name and password have been changed, this check box is automatically cleared. Note that the
check box is also cleared when the old user name and password and the new user name and password are the
same.

Using Windows authentication
To use user authentication linked with the Windows Authentication feature, select Windows for Type.
Note that you cannot use Windows authentication when:

• Connection is made from a controller 07-00 or earlier.

• The operating system is Windows Me or Windows 98.

For the user or group that uses Windows authentication, you must specify Access this computer from the
network for the Windows user rights. For details on how to set the user rights, see J. Setting Permissions for
Access via the Network.
When using the Windows Authentication feature, note that a user name containing an at mark (@) prevents
authentication from being performed correctly.

Name
In the dialog box that appears when you click the List button, select the user or group. If you selected User for
Type, the User List dialog box appears. If you selected Group for Type, the Group List dialog box appears.
When you select the Do not check the existence of Windows user check box to directly enter the name, use
no more than 260 characters. The specified name is case insensitive. Note that you cannot specify a name that
is already registered.

Description
Specify the description of the user, using no more than 260 characters. This item is optional. If you do not
specify anything, the specification of Description in the User List or Group List dialog box for the user name
or group name specified for Name is set.

Domain
When you select the Windows user or group, select a domain from the pull-down list. If you do not specify
anything, the Windows user or group on the local computer is set.
You cannot specify this item unless the computer has joined the domain.

Type
Select either of the following items:

• User
Select this to specify a Windows user.

• Group
Select this to specify a Windows group.

Do not check the existence of a Windows user
With this check box selected, you can directly enter a value for Name, Description, and Domain. To permit
remote control for a Windows user or a user to be registered in the group, select this check box and enter the
value for each item. When you directly enter a value for Domain, use the NetBIOS domain name. This check
box is cleared by default.

Using temporary authentication
To use temporary user authentication, select Temporary for Type. The Temporary option is inactive if the
temporary user has already been set.
Since the Temporary User Registration Wizard is used to set the authentication for the temporary user, do not set
the user name or password in the Add User dialog box.
To display the Temporary User Registration Wizard after you add a temporary user in the Add User dialog box,
from the Start menu, choose Programs, JP1_Remote Control Agent, and then Temporary User Registration
Wizard. To display this wizard for JP1/Software Distribution Remote Control Agent, from each JP1/Software
Distribution program folder, choose Remote Control Agent, and then double-click the Temporary User
Registration Wizard icon.
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For details on how to use the Temporary User Registration Wizard to set authentication information, see (2)
Setting temporary user authentication information.

Description
Specify a description of the user, using no more than 260 characters. This item is optional.

Create a shortcut on the desktop.
Select this check box if you want the Remote Control - Temporary User Registration icon to be created on
the desktop after a temporary user is added. Clicking this icon displays the Temporary User Registration
Wizard. By default, this check box is not selected.

(b) Setting permitted remote control operations

In the Permit Operation page, specify the remote control operations you want to permit, such as shutting down an
agent and transferring clipboard data. The following shows the Permit Operation page.

Figure 3‒30: Permit Operation page

The following describes the items you can specify in the Permit Operation page. By default, all the check boxes are
selected.

Permit shared mode settings
Enables the setting of shared mode.
When you want to permit the controller to only view the agent's screen, clear this check box and the Permit
exclusive mode settings check box.

Permit exclusive mode settings
Enables the setting of control mode.

Permit the execution of shutdown
Permits a shutdown to be performed by choosing Tools and then Shutdown in the controller. You cannot restrict
any other shutdown operation performed, for example, by choosing Shutdown from the Start menu.

Permit the execution of rebooting
Permits rebooting to be performed by choosing Tools and then Reboot in the controller. You cannot restrict any
other reboot operation that is performed, for example, by choosing Reboot from the Start menu.
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Permit the input of Ctrl + Alt + Del key
Permits the same operation as pressing the Ctrl + Alt + Del keys to be performed by choosing Tools and then
Send Ctrl+Alt+Del in the controller.

Permit transfer to clipboard
Permits transfer of clipboard data. For an overview of clipboard data transfer and the method of operation, see
4.2.3 Transferring clipboard data.

Permit file reading during file transfer#

Permits the reading of files during file transfer. For an overview of file transfer and the method of operation, see
4.3 Transferring files.

Permit file writing during file transfer#

Permits the writing of files during file transfer. For an overview of file transfer and the method of operation, see
4.3 Transferring files.

#
Specifies whether or not to permit file transfer for each user. For details on how to permit file transfer for the
entire agent, see 3.4.6 File transmission settings.

The table below lists the file operations that the controller performs for the agent according to the possible
combinations of Permit file reading during file transfer and Permit file writing during file transfer.

Table 3‒9: File operations permitted for the agent

File operation

Check boxes

Read#1 and write#2
Only Read#1 is

selected
Only Write#2 is

selectedBoth selected Both cleared

File reception from the agent Y N Y N

File transmission to the agent Y N N Y

Folder creation Y N N Y

File deletion Y N N Y

File renaming Y N N Y

File attribute change Y N N Y

File opening Y N Y N

Viewing of files Y N Y Y

Legend:
Y: Permitted
N: Not permitted

#1
Indicates Enable file read during file transfer.

#2
Indicates Enable file write during file transfer.

(c) Setting how to display a dialog box for confirming a connection request

In the Connection Confirmation page, specify whether to display the Confirm Connection Request dialog box used
for permitting or rejecting connection when a connection request from a user is accepted. The following shows the
Connection Confirmation page.
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Figure 3‒31: Connection Confirmation page

The following describes the items you can specify in the Connection Confirmation page. By default, the dialog box
is not displayed.

Display the Connection Confirmation dialog box.
Specify whether to display the Confirm Connection Request dialog box. By default, this check box is not selected.
Select this check box to display the Confirm Connection Request dialog box.

Dialog box display position
Set where the Confirm Connection Request dialog box will be displayed on the Windows desktop. You can select
from Center, Top left, Top right, Bottom left, and Bottom right. The default is Bottom right.

Dialog box display time
Specify a value from 0 to 180 seconds as the length of time that the Confirm Connection Request dialog box is
displayed while waiting for the connection to be permitted or rejected. The default is 10. If you specify 0, the
dialog box is displayed until connection is permitted or rejected.

After display time has elapsed
Specify whether to automatically permit or reject connection when the period of time specified in Dialog box
display time has elapsed. The default is Permit. Select Reject to automatically reject connection.

Logoff status
Specify whether to automatically permit or reject the connection when the agent is in the logoff status. The default
is Reject.
When the agent is in the logoff status, the Confirm Connection Request dialog box does not appear regardless of
whether or not the connection is permitted.

The following shows the Confirm Connection Request dialog box.
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Figure 3‒32: Confirm Connection Request dialog box

The Confirm Connection Request dialog box shows the IP address and host name of the controller that requested
connection, and the user name registered in the authentication information.

Click the Yes button to permit connection. Click the No button to reject connection. If you do not perform any
operation before the waiting time has elapsed, the system performs the processing indicated in the settings in the
Connection Confirmation page.

If the computer is locked, the Confirm Connection Request dialog box is not displayed. However, connection is
permitted or rejected according to the settings in Dialog box display time and After display time has elapsed.

(2) Setting temporary user authentication information
To use temporary authentication, use the Temporary User Registration Wizard to set temporary user authentication
information and the connection waiting time. Display the Temporary User Registration Wizard using either of the
following methods:

• From the Start menu, choose Programs, JP1_Remote Control Agent, and then Temporary User Registration
Wizard.
For JP1/Software Distribution Remote Control Agent, from any JP1/Software Distribution program folder, choose
Remote Control Agent, and then choose the Temporary User Registration Wizard icon.

• On the desktop, double-click the Remote Control - Temporary User Registration Wizard icon.

The following explains how to set information when the Temporary User Registration Wizard is displayed.

(a) Setting authentication information

Set authentication information for the temporary user.

Figure 3‒33: Temporary User Registration wizard (setting authentication information)
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User name
Specify the temporary user name, using no more than 20 characters. This item must be specified. The specified
user name is case sensitive.
You cannot use a name containing any of the following symbols or space:
\, /, *, ", :, ', !, |, ., <, >, ?, %, ,
If the temporary user has already been registered, the user name specified previously is displayed.

Password
Specify the password, using no more than 14 characters. This item is optional.

Re-enter the password
When you enter the password, re-enter it for confirmation.

When you finish setting the information, click the Next button. Click the Cancel button to exit the wizard without
saving the authentication information settings.

(b) Setting the waiting time for connection

Specify the time that can elapse from registration of the temporary user authentication information until a connection
request from the temporary user is accepted.

If the time you specify here has elapsed since you completed setup with the Temporary User Registration Wizard, the
temporary user authentication information will no longer be valid. If you want to re-permit connection from the
temporary user, you will need to use the Temporary User Registration Wizard to set the information again.

Figure 3‒34: Temporary User Registration wizard (setting the waiting time for connection)

Waiting time
Specify the waiting time during which a connection request from the temporary user will be accepted. Enter a
value from 0 minutes to 99 hours.
Note, however, that if you specify 0 minutes or 0 hours, the temporary user is not registered. If a temporary user
has already been registered, the temporary user is deleted.

By setting authentication information and specifying 0 as the waiting time, you can forcibly disconnect the connected
temporary user.

When you finish setting the waiting time, click the Next button.

(c) Checking the settings

Check the specified temporary user authentication information and the waiting time for a connection request.

Once you have registered the temporary user authentication information in the Temporary User Registration Wizard,
you will not be able to check this information. If you have forgotten the user name or password, you must use the
Temporary User Registration Wizard to register the temporary user authentication information again.

To permit connection for a temporary user, report the information and password displayed here to the controller user.
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Figure 3‒35: Temporary User Registration wizard (checking the settings information)

Temporary user information
Indicates the name of the temporary user and the connection waiting time.

Computer information
Indicates the computer name of the agent and the IP address for local area connection. If more than one NIC is
installed, the IP address that was first bound is displayed.

If the settings are correct, click the Finish button.

The setup of the temporary user authentication information is complete and the system waits for a connection request
from the temporary user according to the settings.

(d) Notes on setting a temporary user

The following are notes on setting a temporary user.

• The registered temporary user authentication information is automatically deleted when one of the following
occurs:

• The waiting time for a connection request has elapsed.

• The temporary user authentication information is set again (the temporary user is registered again with new
settings).

• The temporary user is connected.

• Connection with the security PC is released.

• Remote Control Agent terminates.

• The user logs off from or shuts down Windows.

• The connected temporary user is automatically disconnected when one of the following occurs:

• The temporary user authentication information is set again.

• Connection with the security PC is released.

• Remote Control Agent terminates.

• The user logs off from or shuts down Windows.

(3) Deleting authentication information
In the Permitted user list field, select the user information to be deleted, and then click the Delete button. A dialog
box appears asking you whether you want to delete the selected user information. Click the Yes button to delete the
user information. You cannot delete more than one item of user information at a time.

When you delete the temporary user, the Remote Control - Temporary User Registration icon is also deleted from
the desktop.
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(4) Editing authentication information
In the Permitted user list field, select the user information for which you want to edit the user name or password, and
then click the Edit button. The Edit User dialog box, in which you edit the user information, appears. You cannot edit
more than one item of user information at a time.

To edit temporary user authentication information, set it again from the Temporary User Registration Wizard. The
temporary user authentication information will be updated with the new settings.

In the Edit User dialog box, a user whose type is Temporary cannot be changed to any other type. Similarly, the user
type cannot be changed to Temporary from any other type. If you want to change the user type, delete the user
information and then add it again.

The method of using the Edit User dialog box is the same as that of using the Add User dialog box. For details, see (1)
Adding authentication information. Note, however, that the Edit User dialog box does not contain an Apply button.

(5) Notes on setting authentication information
The authentication function might not operate depending on the connected product or its version, causing remote
control requests from all users to be rejected.

If the specified settings will cause remote control requests from all users to be rejected, a warning message appears
before the settings take effect. If this message appears, check the settings.

The table below shows when the authentication function is valid and when it is invalid.

Table 3‒10: Status of the authentication function according to the combinations of version, applicable OS,
and user type

Controller Version

Agent

Standard#1 Windows#1 Temporary#1

All#2
Windows Me

Windows 98#2
Windows NT 4.0

or later#2 All#2

Usual version 03-00 - 07-10 Y N#3 N Y

07-11 or later Y N#3 Y Y

Security PC 07-11 - 08-00 Y N#3 Y Y

08-01 or later Y N#3 Y Y

Legend:
Y: The authentication function is valid.
N: The authentication function is invalid.

#1
Type of user for which remote control is permitted.

#2
OSs applicable to the agent.

All
All OSs applicable to the product.

Windows NT 4.0 or later
Windows 8, Windows Server 2012, Windows Server 2008, Windows Server 2003 (excluding Windows
Server 2003 (IPF) and Windows Server 2003 (x64)), Windows XP, Windows 2000, and Windows NT 4.0

#3
The authentication setting itself is impossible.
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3.4.5 Settings for logging
You can set up the information on log output in the following dialog box. In the Remote Control Agent - Properties
dialog box, the Logging page serves as this dialog box.

Figure 3‒36: Remote Control Agent Setup dialog box (setting the information on log output)

Disable logging
Select this option to disable the output of logging information. This option is selected by default.

Log all data items
Select this option to output all logging items that can be selected in Select the items to log.

Select the items to log
Select logging items when you choose to log only certain items. The items selected from the following will be
output. Only Connect/disconnect is selected by default.

• Connect/disconnect

• Authenticate

• Reboot/shutdown

• Ctrl+Alt+Delete

• Remote control mode

• Optimize transaction option

Print method

Maximum lines in a log file
Specify the maximum number of lines in a log file as an integer from 0 to 9,999. The default is 500 lines.

Generations to be saved
Specify the number of log generations to be saved as an integer from 0 to 99. The value specified here will
form the last 2 digits of the log file name, indicating the generation number. The default is 0 (no generation
management).
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3.4.6 File transmission settings
You can select whether to allow file transmission (accept the controller's instruction to send and/or receive files). In
the Remote Control Agent - Properties dialog box, the File Transfer page serves as this dialog box.

Figure 3‒37: Remote Control Agent Setup dialog box (setting file transmission options)

Disable file transmission between controller and agent
Rejects file transmission requests from the controller.

Enable file transmission between controller and agent
Accepts file transmission requests from the controller. This option is selected by default.

Port number
Specify the number of the port to be used by the file transmission functionality as an integer from 5001 to
65535. Make sure the port number does not coincide with the numbers used by other programs. The default
port number is 30004.

File access permission
Specify access permission for the files and folders from the controller.

• Read
Select this check box to permit files and folders to be read from the controller. By default, this check box
is selected.

• Write
Select this check box to permit files and folders to be written to from the controller. By default, this check
box is selected.
If the agent runs on Windows 8, Windows Server 2012, Windows 7, Windows Server 2008, Windows
Vista, Windows Server 2003, Windows XP, Windows 2000, or Windows NT 4.0 and the Windows access
permission is set to read only, selecting this check box does not allow the controller to write to folders or
files.

The table below shows how each Read and Write setting combination controls whether to permit or prohibit file
controller operations.
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Table 3‒11: How file access permissions control file operations by the controller for the agent

File operation

Check boxes

Read and write Only Read is
selected

Only Write is
selectedBoth selected Both cleared

File reception from the agent Y N Y N

File transmission to the agent Y N N Y

Folder creation Y N N Y

File deletion Y N N Y

File renaming Y N N Y

File attribute change Y N N Y

File opening Y N Y N

Viewing of files# Y Y Y Y

Legend:
Y: Permitted
N: Not permitted

#
The file name, size, update date, and attributes are displayed in the File Transfer window.

File access logs
Specify in the File Transfer window whether to output logs when the controller uses files and folders of the
agent. Select the Output check box to output file access logs. By default, the check box is not selected.
Click the Details button to display the Logging dialog box, where you can specify the type of logs to be output
and the output format.
The following explains the settings in the Logging dialog box.

(1) File access logs
In the Logging dialog box, specify information about file access logs to be output.

For details about the output logs, see K.2 File access logs.
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Figure 3‒38: Logging dialog box

Log all data items
Select this option to output all logging items that can be selected in Select the items to log. This option is selected
by default.

Select the items to log
Select this option when you want to output only selected items as file access logs. The items you select from the
following will be output. By default, Connection/disconnect, Forwarded files, and Deleted files are selected.

• Connection/disconnect

• Forwarded files

• Deleted files

• Created folders

• Rename

• Attribute changes

If you do not specify any options, file access logs will not be output.

Log output level
Set information about file access logs. Neither check box is selected by default:

• Do not output warning information
Select this check box to prevent warning information from being output to the log.

• Do not output error information
Select this check box to prevent error information from being output to the log.

Log output environment
Set the format for the log output, and the amount of information that can be output to file access logs.

Output format
Select the log output format from the following. The default is CSV Format.

Table 3‒12: Log data output formats that can be selected in the Logging dialog box

Output format Description

CSV Format Information is output in the comma-separated format.
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Output format Description

TSV Format Information is output in the tab-separated format.

User-specified format Information is output using the alphanumeric-character or symbol separator entered in the
Delimiter text box.

The default for the Delimiter text box is a semicolon (;).

Maximum lines in a log file
Specify the maximum number of lines in a log file as an integer from 0 to 9,999. The default is 500 lines. If
you specify 0, logs will not be output.

Generations to be saved
Specify the number of log generations to be saved as an integer from 0 to 99. The value specified here will
form the last 2 digits of the log file name, indicating the generation number. The default is 0 (no generation
management).

3.4.7 Chat server settings
Use the following dialog box to set the operating environment of the chat server in order to utilize the chat function.
More specifically, use the Chat page in the Remote Control Agent - Properties dialog box. However, this dialog box
and page are not displayed if the chat component is not installed.

Figure 3‒39: Remote Control Agent Setup dialog box (setting chat server)

Start the server when the agent starts
Select this check box if you want to start the chat server when the agent starts. By default, this check box is
cleared.
A chat server that is configured for automatic start will end automatically when the agent ends.

Port number
Specify the port number to be used for the chat server as an integer from 0 to 65535. The default port number
is 30005.
If you specify a port number beyond this range, a message dialog box is displayed, prompting you to respecify
a port number.
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Icon is displayed on the taskbar
Select this check box to display the Chat Server icon on the task bar. By default, this check box is selected.
When you select this check box, the Chat Server icon will be displayed on the task bar when the chat server
starts.
In Windows 8, Windows Server 2012, Windows 7 and Windows Server 2008 R2, the Remote Control Agent
icon is not displayed on the taskbar. If you want to display the icon on the taskbar, choose Control Panel,
Appearance and Personalization, and then Customize icons on the taskbar. Next, select Show icon and
notifications for Behaviors for the Remote Control Chat icon.

Start the chat function at the time of the connection
Select this check box to start the chat function when the chat server receives a connection request from the
Chat window. By default, this check box is selected.
When you select this check box, the Chat window will be displayed when the chat server receives a
connection request from the Chat window, indicating that the chat function can be used.
You cannot use the chat function before you log on. If a connection request is issued before logon, the Chat
window will not be displayed until after you log on.

3.4.8 Memory settings (for Windows Me and Windows 98)
You can configure memory to be used by Remote Control Agent.

Using an application(s) which requires a large amount of memory on an agent running on Windows Me or Windows
98, may cause the machine to stop due to lack of memory. To prevent this, you can define the maximum amount of
memory Remote Control Agent can use. The program will then automatically abandon any drawing command if the
operation cannot be completed within the set amount of memory.

The dialog box for configuring the memory is shown below. This dialog box appears only on agents running on
Windows Me or Windows 98. In the Remote Control Agent - Properties dialog box, the Memory Settings page serves
as this dialog box.

Figure 3‒40: Remote Control Agent Setup dialog box (setting memory to be used)

Use default settings (Recommended)
Uses the Remote Control Agent's default value to manage memory. Usually, select this option.
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Customize memory allocation
Specify the maximum memory size, and the interval for resuming the use of memory when the system runs out of
memory.

Memory size allocated when starting Remote Control Agent
Specify the maximum amount of memory Remote Control Agent can use (in megabytes). The minimum value
is 2 megabytes, and the default is 5 megabytes. The maximum value is not fixed, but equates to one third of
the agent's total available memory. The value specified here will become the memory size to be secured at the
startup of the agent. Make sure to configure what is required.

When memory is short, the drawing window waits for the specified interval
Specify the interval for resuming the use of memory when the system has a memory shortage. Use an integer
from 0 to 3,600 (seconds). The default interval is 5 seconds. Setting a long interval will extend the period of
time when screen drawing data is not transmitted to the agent.

3.4.9 Password to change setup
You can define a password for protecting the setup information of Remote Control Agent.

Figure 3‒41: Remote Control Agent Setup dialog box (setting the setup password)

In the Remote Control Agent - Properties dialog box, the Password to Change Setup page serves as this dialog box.
In this window, clicking OK or Apply will validate the password.

Set password
Select this check box to set a password for setup information. This option is cleared by default.

Password
Specify a password for protecting setup information, using up to 14 characters. When the Set password check
box is selected, you cannot omit this item.

Re-enter password
Re-enter the password for confirmation.

This password will be requested when:
Select when a dialog box requesting a password should be displayed.

• The Setup program is started
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Requests a password when opening the Remote Control Agent Setup dialog box or Property dialog box. A
user who does not know the correct password cannot view the setup information.

• The Setup program is closed for update
Requests a password when updating the setup information (when the End or OK button is clicked). A
user who does not know the correct password can still view the setup information.

3.4.10 Device file settings (for Windows NT 4.0)
This dialog box prompts you to change the device file of the agent. This settings window is displayed in the Remote
Control Agent Setup dialog box only. It is not displayed in the Remote Control Agent - Properties dialog box.

Remote Control Agent for Windows NT 4.0 switches its device file for the display with that for the Windows system.
Without this process, you cannot use the Remote Control Agent.

The device file will be switched when Remote Control Agent is installed. In the case of JP1/Software Distribution
Remote Control Agent, the device file will also be switched at the first setup time following installation. At setup
time, the following dialog box is displayed, prompting you to switch the device file.

Figure 3‒42: Remote Control Agent Setup dialog box (replacing the device file of an agent)

Replacing a device file
The current device file and the substitute device file are identified.

Replace the device file
Select this check box to replace the display device file being used by Windows with the device file that will be
used by Remote Control Agent. By default, this check box is cleared. Read the information under Notes to
ensure that the display driver being used is compatible with JP1/Remote Control. After confirmation, select
the check box.

Notes
The area under Notes displays notes on display drivers and information about the display driver being used by the
personal computer. Clicking the Driver List button displays a list of display drivers compatible with JP1/Remote
Control. Confirm that the display driver used on the personal computer is compatible with JP1/Remote Control.
On the personal computer where you have installed Remote Control Agent, use a display driver that is compatible
with JP1/Remote Control. If the personal computer uses a display driver that is not listed in the driver list, the
personal computer or Remote Control Agent may malfunction after JP1/Remote Control Agent is installed.
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Driver List
Displays a list of display drivers compatible with JP1/Remote Control.

This dialog box is displayed not only when a setup procedure starts, but also when the device driver is changed after
Remote Control Agent is installed. To use Remote Control Agent, confirm that the substitute display driver is
compatible with JP1/Remote Control. If this can be confirmed, replace the current display driver with the display
driver compatible with JP1/Remote Control.

After this procedure, you need to restart the system before using Remote Control Agent. This allows the system to
recognize the new device file, thus enabling the use of Remote Control Agent.
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4 Controller Operations
This chapter describes how to start, operate, and exit Remote Control Manager.

The explanations in this chapter focus on menu operations. However, you can
perform the same operations from the toolbar buttons, popup menus, and shortcuts.
For details on the tool buttons, see 4.2.4(7) Customizing the toolbar. For details on
menus, see A. Menus.
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4.1 Starting and exiting Remote Control Manager
This section describes procedures for starting Remote Control Manager, connecting and/or disconnecting an agent,
and terminating Remote Control Manager.

4.1.1 Starting Remote Control Manager
In the Remote Control Manager program folder or JP1/Software Distribution's program folder, choose the Remote
Controller icon to start Remote Control Manager. Remote Control Manage starts and the Remote Control window
appears. The figure below shows the Remote Control window.

Figure 4‒1: Remote Control window (unconnected state)

Address bar
In the address bar, you specify the agent to be connected. The address bar consists of the Agent button, which is
used for selecting from a list of created agents, and an address box, which is used for directly specifying an agent.
For details on how to use the address bar, see 4.1.2(1)(a) From the address bar.

Menu bar
The menu bar is displayed when the system is not connected to an agent. When the system is connected to an
agent, the menu bar disappears. However, you can view the menu by right-clicking the title bar and choosing the
Remote Control menu. For details on each menu item, see A.1 Remote Control window menu.

Toolbar buttons
The toolbar contains buttons of commonly used remote control functions. For details on each button and their
display status, see 4.2.4(7) Customizing the toolbar.

Status bar
The status bar displays remote control information such as the amount of incoming/outgoing data, connection
duration, the status of the Ctrl and Alt keys, and the data transfer status with an agent. For details on the display
status of the status bar, see 3.3.5(3) Status bar.

Action-keys input bar
The action-keys input bar displays buttons of function keys and shortcut keys for sending data to an agent. For
details on the action keys, see 4.2.2 Registering and executing action keys.

You can also start Remote Control Manager via the following methods:

Using a command
Type the following command to start Remote Control Manager.
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dmrccntl.exe /agent host-name or IP-address
Specify the host name or IP address to identify the agent to be connected. When Remote Control Manager starts,
Remote Control Manager automatically connects to the specified agent. If you omit this specification, the agent
will not be connected to Remote Control Manager.

From JP1/IM - View
In the Tool Launcher window of JP1/IM - View, choose Remote Control and then Remote Control.

4.1.2 Connecting with an agent
The controller performs remote control operations while it is connected with an agent. Once the controller establishes
a connection with an agent, the agent's screen appears in the Remote Control window. When the controller is
connected to more than one agent, Remote Control Manager opens as many Remote Control windows as there are
connected agents.

A maximum of 255 controllers can be connected to one agent at the same time.

This subsection describes how you can connect with an agent, check the connection status, and set up the remote
control mode.

Note that the menu bar of this window disappears once a connection is established with an agent. To use a menu,
right-click the title bar to display Remote Control Menu, and choose the menu name.

Figure 4‒2: The Remote Control menu displayed in the Remote Control window

(1) Establishing a connection
There are four ways of establishing a connection with an agent:

• From the address bar

• Specify an agent via a dialog box

• Search for an agent via a dialog box

• Select an agent from the Connect button's history list

In any method, if you specify that the agent is to display the connection request, a message dialog box indicating the
connection request rejection is displayed on the controller.

If security settings have been specified on the agent side, the User Authentication dialog box appears when an attempt
is made to connect to the agent. Authentication will succeed if the correct authentication information is entered in the
dialog box. Note that the Change User Name and Password dialog box also appears when the Change the user name
and password when a connection is established check box on the General page in the Add User dialog box is
selected. If the dialog box appears, enter the new user name and password.

If you want to enter a domain with a user name, use the domain-name\user-name or user-name@domain-name
format.

For details on how to specify agent security, see 3.4.4 Authentication settings.
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If a connection attempt fails, an error message appears, and the system will reattempt to establish connection based on
your option settings.

The following explains each connection method.

(a) From the address bar

This method connects agent specified on the address bar in the Remote Control window. The address bar consists of
an agent button and an address box. If the address bar is not displayed, you can display it by one of the following
methods:

• From the View menu, choose Toolbar, and then Address bar.

• In the Properties dialog box, go to the Toolbar page and select the Show the address bar check box.

You can use the address bar to connect to an agent via one of the two methods shown below.

Selection from the agent menu

Click the Agent button ( ) in the Remote Control window. The agent menu is then displayed.
You can select an agent from the agent menu. The agent menu is a menu-form list of the agents that are currently
included in the network. If you register frequently used agents on the agent menu, you will able to connect with
them more easily.

Figure 4‒3: Flow of specifying the connection destination from the agent menu

By selecting a network icon ( ) in the agent menu, you can determine whether the network represented by that
icon includes machines that are running Remote Control Agent. From the top-level of the agent menu, you can
add currently connected agents to the agent menu or edit the agent menu.
For information on how to create, maintain, and use the agent menu, see 4.4 Managing agents.

Selection from the address box
To specify the agent to be connected, use the address box displayed on the address bar in the Remote Control
window. In the address box, enter the host name, IP address, or path of the agent, and then press the Enter key.
Alternatively, select the agent from the pull-down list of agents that were connected in the past.
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Figure 4‒4: Specifying the connection destination from the address box

For information about agent paths, see 4.4.5(2) Recording agent paths.
Connection records in the address box can be deleted or reordered. For further information, see 4.4 Managing
agents.

(b) Specifying an agent via a dialog box

In this method, you display a dialog box for specifying the agent to be connected, and then a particular agent.

To specify an agent via a dialog box:

1. From the File menu of the Remote Control window, choose Connect (or click the Connect button on the toolbar).
The Remote Control Agent Specification dialog box appears.

Figure 4‒5: Remote Control Agent Specification dialog box

Agent to be connected
Specify the agent to be connected. Once you connect to an agent, that agent is registered in the list box, so you
can select it from the list box for future connections. You cannot make multiple selections. Up to 256 agents
can be registered in the list box.

Connect
Starts the connection with the specified agent.

Search
Searches for agents in the network. For details on searching for agents, see (c) Searching for an agent via a
dialog box.

2. In the Agent to be connected box, enter the host name, IP address, or agent path of the agent to be connected.
For details on the agent path, see 4.4.5(2) Recording agent paths.

3. Click the Connect button.
This connects your system to the agent and closes the Remote Control Agent Specification dialog box. If you are
already connected to an agent, a new Remote Control window opens.

(c) Searching for an agent via a dialog box

From the dialog box for searching agents, you specify the connection destination by searching for machines that are
running Remote Control Agent on the network.
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For details on agent searching such as how to specify the search parameters and view the search results or limitations
of the search, see C. How to Use the Find Agent Facility.

Once you connect with one of the agents identified by the search, the system deletes the information about any other
agents. If you want to save the search results, we recommend that you conduct your agent search from the Agent
Manager window. For details on agent searches from the Agent Manager window, see 4.4.3(3) Searching for and
reading the organizational information about agents.

To search for agents and connect to an agent from the Remote Control window:

1. In the Remote Control window, choose File and then Connect. (Alternatively, on the toolbar, click the Connect
button.)
The Remote Control Agent Specification dialog box appears.

2. Click Search.
The Search Agents dialog box appears. You can also open the Search Agents dialog box by going to the File
menu and choosing Search.

Figure 4‒6: Search Agents dialog box

3. In the Network area to be searched box, specify the IP address of the network to search in.
For details on specifying the search range, see C.1 Setting the search range.
Clicking the Settings button displays the Settings for Agent Search dialog box, which is used for customizing the
search method. For details on customizing the search, see C.3 Customizing the search method.

4. Click Search.
This searches for machines running Remote Control Agent within the specified network. When the search starts,
the Search Agents dialog box expands to display the Agent and Details pages, which show the search status.

Figure 4‒7: Agent page

Agent page
Icons display the status of the agents (Awaiting connection, Connection rejected, Not running, or Not
responding). For details on each status, see C.2 The status of found agents.
For Awaiting connection and Connection rejected statuses, the agent name (for the Show agent host names
setting), the version of Remote Control Agent, and the OS are displayed.
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To narrow down the agent statuses displayed in this page, use the check boxes located in the right section of
the dialog box.

Details page
A message indicates the search status of the agents.

5. From the Agent page, select an agent with Awaiting connection status, and then click Connect.
The system connects to the agent, and closes the Search Agents dialog box.

(d) Selecting an agent from the Connect button's history list

This connection method uses one of the Connect button usage records, which can be displayed from the toolbar in the
Remote Control window. Click the arrow next to the Connect button. Select an agent from the pull-down list of the
agents that were connected in the past.

Figure 4‒8: Selecting the connection destination from the Connect button's history list

If the toolbar is not displayed, you can display it by one of the following methods.

• From the View menu, choose Toolbar, and then Toolbar.

• In the Properties dialog box, open the Toolbar page, and then select the Show the toolbar check box.

(2) Automatic dialing connection
You can also use the automatic dialing facility to establish a connection.

In this case, you can select any of the methods described in (1) Establishing a connection. The Dial-up Connection
dialog box is displayed when connecting to an agent. When dialing a connection, the Progress dialog box is displayed.
The following subsections explain each dialog box.

(a) Dial-up connection

If you are using the auto-dialup function to connect to an agent, the following Dial-up Connection dialog box appears.
From the property settings, you can set it so that this dialog box does not appear.

Figure 4‒9: Dial-up Connection dialog box
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Connect to
The name of the connection destination (such as the name set in the dial-up network or remote access service) is
displayed.

Authentication information
Specify the user name, password, and domain to use for the dial-up connection. If these settings are omitted, the
current user name, password, and domain are used.

Save authentication information
Select this check box to use the authentication information of this session for subsequent connections. This dialog
box is not displayed for subsequent connections.

Connect
Starts the dial-up using the specified authentication information.

Setup
Displays a dialog box for editing the current connection destination. The dialog box that is displayed varies
depending on the OS. The settings specified here use Windows functions to directly change the settings of the OS.
Once you set these settings, clicking the Cancel button in the Dial-up Connection dialog box will not restore the
original settings.

Specifying the user name, password, and domain, and then clicking the Connect button starts the dialup and displays
the Progress dialog box.

(b) Progress

While dialing the connection, the Progress dialog box displays the current status.

Figure 4‒10: Progress dialog box

Connecting to
Displays the name of the connection destination (such as the name set in the dial-up network or remote access
service).

Status
Displays the current dial status in the following format.
hh:mm:ss n/m xxxxxxxxxxxxxxxxxx

• hh:mm:ss is the time the action occurred.

• n/m is the redial count and total count.

• xxxxxxxxxxxxxxxxxx is the status message.

Re-dial
Resets the redial count and starts dialing again.

Error
Displays an error message if an error occurs.
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When the dialing finishes, the Progress dialog box closes and the remote control starts, just as in a regular connection.
If dialing fails, the system redials to establish connection based on your option settings. Choose the Re-dial button to
reset the redial count and commence redialing.

(3) Checking the connection status with the agent

When connected to an agent, the controller shows an icon ( ) on the status bar, indicating that an agent is
connected. This icon is called the transmission icon. The yellow PC at the top of the icon represents receiving data
from the agent, whereas the blue PC at the bottom represents sending data to the agent. During data transmission, the
relevant PC in the icon illuminates. Placing your pointer over the icon pops up the transmission data count.

The status bar also shows the remote control mode, the amount of time that has elapsed since connection was
established, and the number of data transfers. If the status bar is not displayed, you can display it using one of the
following methods.

• From the View menu, choose Status Bar, and then Status Bar.

• In the Properties dialog box, open the Toolbar page, and then select the Show the status bar check box.

You can configure property settings to show or hide this information. There are two ways to show this information.

• Selecting from the menu
In the Remote Control window, from the View menu, choose Status Bar and select the following items:

• Elapsed Time

• Transferred Data

• Show Data Transfer Status Icon

• Selecting in the Properties dialog box
In the Remote Control window, from the Tools menu, choose Properties to display the Properties dialog box. In
the Toolbar page, select the following check boxes:

• Show elapsed time

• Show the amount of data sent

• Show the amount of data received

• Show status icon of data transfer

(4) Setting the remote control mode
Set the remote control mode of the controller to conform to the contents of remote control operations you need to
perform on the agent. However, if the agent side defines a higher level of permission, the mode of the controller may
be adjusted when connection is established. For details on the remote control mode, see 3.1 Remote control mode.

There are three ways of setting the remote control mode:

• Selecting from the menu
In the Remote Control window, from the Tools menu, choose Control Mode and select View, Shared, or
Exclusive.

• Selecting with the tool button
You can customize the toolbar to include buttons for selecting remote control modes. When you select a mode, the
button is pressed.
For example, if shared mode is selected, the toolbar looks like as follows.

Figure 4‒11: Toolbar when the shared mode is specified

For information on how to customize the toolbar to display additional buttons, see 4.2.4(7) Customizing the
toolbar.

• Selecting in the Properties dialog box
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Open the Remote Control window from the Tools menu and choose Properties to display the Properties dialog
box. In the Control Mode page, select the relevant remote control mode.

You can view the set remote control mode from the status bar and toolbar of the Remote Control window.

4.1.3 Disconnecting an agent
You can disconnect an agent either manually or automatically. Both disconnection methods are detailed below. This
subsection also explains the procedure for reconnecting a previously disconnected agent.

When the automatic dialing facility is used, the dialup connection will be severed automatically when the agent is
disconnected. However, you may configure the property settings so that the dialup connection is severed upon
termination of Remote Control Manager (when closing the Remote Control window).

(1) Automatic disconnection
Automatic disconnection automatically disconnects an agent when no operation is made on the agent for a certain
period of time. It also disconnects an agent automatically when the Remote Control window is inactive for a certain
period of time.

You can set the timing or period of inactivity time for disconnection in the Properties dialog box. From the Tools
menu of the Remote Control window, choose Properties to open the Properties dialog box. Then, in the Connection
page, select the Disconnect from the agent automatically check box. You can select one of the following three
timings:

When the time-out elapsed
Disconnects the agent after a specified period of time has elapsed since connection was established.

If the agent is not manipulated during the time-out
Disconnects the agent when the agent non-operation state continues for a specified period of time (that is, when no
data is sent).

If the Remote Control window is inactive during the time-out
Disconnects the agent when the Remote Control Manager window has remained in the inactive state for a
specified period of time, or when a specified period of time elapses after the Remote Control Manager window
was iconified.

(2) Manual disconnection
From the File menu, choose Disconnect to manually disconnect an agent. When the controller is connected with more
than one agent, with the corresponding number of Remote Control Managers (Remote Control windows) open, this
operation will only disconnect the agent for the window where you performed the operation.

(3) Reconnection
Disconnect an agent, and then, from the File menu, choose Reconnect to reconnect the previously connected agent.
However, an attempt to reconnect to the agent will fail if it is configured so that its Remote Control Agent terminates
automatically upon disconnection.

4.1.4 Terminating Remote Control Manager
To terminate Remote Control Manager, from the File menu, choose Terminate. When the controller is connected
with more than one agent, with the corresponding number of Remote Control Managers (Remote Control windows)
open, this operation will only terminate the Remote Control Manager where you performed the operation.

When multiple Remote Control Managers are running and you want to terminate all of them, choose the File menu
and then Terminate All.

In either case, performing a termination operation will automatically disconnect the agent(s).
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4.1.5 Operation environment which requires tuning while connecting with
an agent

When connecting with an agent, some network environments may require tuning of the transmission data size and
polling interval. Make the necessary adjustments in the Higher Level Settings dialog box shown below.

Figure 4‒12: Higher Level Settings dialog box

In the Properties dialog box, in the Optimize Transaction page, click the Higher Level Settings button to display the
Higher Level Settings dialog box.

(1) Specifying the compression threshold for transmission data
You can specify the compression threshold for transmission data with the agent. Compressing data at or above a
certain size will reduce the overall amount of transmission data, thus reducing the load on the network. Note, however,
that compressing too much data may increase the load on the CPU for compression and extraction operations, and
delay the overall process. Define an appropriate value in consideration of the machine performance and network
environment.

The default setting is the value recommended for the LAN environment. In the WAN environment, specify the value
recommended for WAN (that is, 512 or more bytes).

(2) Specifying the polling interval
You can specify the polling interval for the controller to acquire the agent's screen data (that is, the interval for the
agent to acquire drawing instructions).

The agent obtains drawing instructions at the specified interval and transfers all the instructions to the controller in a
batch. When the system is configured to compress transmission data, the agent compresses data in a batch. Setting too
long an interval will cause a time lag in the drawing of the agent's screen on the controller, but allows the system to
batch-process a greater number of drawing instructions, effectively reducing the amount of transmission data.

The default setting is the value recommended for the LAN environment. In the WAN environment, specify the value
recommended for WAN (that is, 1000 milliseconds).
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4.2 Performing remote control operations
You must call the agent's screen onto the Remote Control window to perform remote control operations on the agent.
The figure below shows the Remote Control window when the controller is connected to the agent.

Figure 4‒13: Remote Control window (when connected to the agent)

When your system is connected to an agent, the following icons are displayed in the status bar of the Remote Control
window.

Ctrl/Alt key status indicator
Displays the status of the Ctrl and Alt keys in the agent. For details, see 4.2.1(1) Monitoring the Ctrl and Alt keys.

Transmission icon
Displays the connection status with the agent. During a data transfer, the corresponding PC lights up.

• Yellow PC: receiving data form the agent

• Blue PC: sending data to the agent

Placing your pointer over the icon pops up the amount of transmission data.
If you encrypt the remote control data, a key symbol is displayed on the icon. For details on encryption, see
4.2.4(1) Encrypting remote control data.

Status icon
Displays the recording status of the agent window information. For details, see 4.5.2(2) Recording status display.

This section describes the remote control operations available when the remote control mode is either shared or
exclusive. When the remote control mode is view, you can only view the agent's screen.

4.2.1 Remote control of agents
On the controller, you can operate the agent's screen just as you would operate the local machine. Available operations
include entering characters, and clicking or dragging with the mouse. Some procedures, e.g., executing shortcut keys,
may require special operations. This subsection describes these special operation procedures.
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(1) Monitoring the Ctrl and Alt keys
When the remote control mode is shared, the agent side can also operate the agent machine. Operating the agent from
both sides does not cause any problems. Remember, however, when the agent user is pressing the Ctrl or Alt key, a
key stroke made from the controller may trigger an unintended function.

The status bar shows the state of the Ctrl and Alt keys on the agent machine, using the following icons. When the
agent user presses the Ctrl key or the Alt key, the arrow in the icon representing that key faces down on the controller
screen.

The figure below shows the state of the status bar when the Alt key is pressed on the agent machine.

Figure 4‒14: Status bar when the Alt key is pressed on the agent machine

You can configure property settings to define whether to show these icons.

(2) Pressing shortcut keys
Pressing function keys (e.g., Print Screen) or shortcut keys (e.g., Alt + Tab) on the keyboard will execute the
operation on the controller itself, not on the agent's screen called into the controller's display. To perform such
operations on the agent machine, you need to send action key instructions.

Action keys are commands, registered with Remote Control Manager, to substitute for operations performed by
function keys or shortcut keys. You can register your own keys in addition to the default action keys provided by
Remote Control Manager. Execute registered action keys from the Remote Control window's key input bar.

For details on how to register and execute action keys, see 4.2.2 Registering and executing action keys.

You can also enable some keys to execute functions on the agent by opening the Properties dialog box, going to the
Window page, and selecting the Sends input of the system key check box. For information about settings on the
Window page, see 3.3.4 Window page.

(3) Pressing the Ctrl + Alt + Delete keys
You cannot press the Ctrl + Alt + Delete keys for an agent directly from the keyboard. You can, however, choose
Tools and then Send Ctrl+Alt+Del to perform an operation similar to pressing the Ctrl + Alt + Delete keys. The
operations you can perform depend on the agent's operating system.

• If the agent is running on Windows 8, Windows Server 2012, Windows 7, Windows Server 2008, Windows Vista,
Windows Server 2003, Windows XP, Windows 2000, or Windows NT 4.0:
You can perform any operation that can be normally be initiated by Ctrl + Alt + Delete, including logging on to
Windows.

• If the agent is running on Windows Me or Windows 98:
You can display the Remote Control Process Viewer window on the agent. If an application or process hangs up
on an agent that is under remote control, you can use the Remote Control Process Viewer window to abort the
application or process from a controller. For further information on the abort operation, see 4.6 Aborting an
application or process on an agent that is running on Windows Me or Windows 98.

(4) Shutting down the agent
You can shut down an agent by operations at the controller. If the version of the controller and agent is 06-71 or later
and the agent PC is equipped with a power-off functionality, you can issue a controller instruction to shut down and
switch off the agent.

Perform the following steps:

1. From the Tools menu, choose Shut Down.
A message dialog box appears, asking you to confirm whether you want to shut down the agent.
The following message dialog box is displayed if the version of the controller and agent is 06-71 or later:
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Select the Turn the power off after shutdown check box if you want to switch off the agent after shutting it
down. By default, this check box is not selected.

2. Choose OK.
The controller issues a shutdown instruction to the agent. Upon receipt of the instruction, the agent shuts down. If
the Turn the power off after shutdown check box is selected, the agent will also switch off. However, note that
the power to the agent may remain on if the agent PC is not equipped with a power-off software functionality.

(5) Rebooting the agent
You can reboot an agent from the controller. If Remote Control Agent is configured to start automatically, you should
allow some time to pass before initiating a connection procedure to continue remote control operations.

Perform the following steps to reboot and reconnect the agent. For details on how to configure the agent to start
Remote Control Agent automatically, see 3.4.1 Start options.

1. From the Tools menu, choose Reboot.
The Reconnection Interval dialog box appears.

Figure 4‒15: Reconnection Interval dialog box

Start to connect
Select this check box to start the connection. If you select this check box, in the Start time box set the time (in
minutes) until the connection.

Do not connect
Select this check box if you do not want to connect.

You can set the default values for this dialog box when setting up properties.

2. Select Start to connect, set the time for initiating the connection, and click OK.
A message dialog box appears, asking you to confirm whether you want the controller to reboot the agent.

3. Choose OK.
The controller issues a reboot instruction to the agent. Upon receipt of the instruction, the agent reboots.
The controller automatically initiates a connection procedure with the agent after the amount of time, specified in
step 2, elapses.

(6) Transferring clipboard data
During remote control operations, the data cut or copied from a document on an agent will be stored in the clipboard
of the agent machine, but cannot be pasted onto a document on the controller. Similarly, the data copied on the
controller cannot be pasted onto a document on an agent.

To make this kind of pasting possible, you must transfer data between the agent's clipboard and controller's clipboard.
This way, you can easily cut and paste data between documents on different machines without having to allocate a
network drive. You can also configure property settings to automatically transfer clipboard data.

For details on the transmission of clipboard data, see 4.2.3 Transferring clipboard data.
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4.2.2 Registering and executing action keys
Action keys are commands, registered with Remote Control Manager, to substitute for key operations (function keys,
shortcut keys, etc.) which are performed on the controller itself, and then sent on to the agent. The registered keys are
shown on the key input bar of the Remote Control window. You only need to click the appropriate buttons on the key
input bar to execute function key or shortcut key operations on the agent.

The following explains how to register and send action keys, as well as the action keys provided by default. For details
on the settings used to display the key input bar, see 3.3.5 Toolbar page.

(1) Register and send action keys

To register and send action keys:

1. From the Tools menu, choose Properties. In the Properties dialog box, select the Register Action Key page.

Figure 4‒16: Register Action Key page in the Properties dialog box

2. From the Action keys list box, select the action key you want to execute, and click >>.
The action key appears in the Selected key list.
The contents of the Action keys list box changes according to the selection in Action key type.

Default
Lists the default action keys provided by Remote Control Manager. For details on the default action keys, see
(2) Default action keys.

Custom
Select this option to register a user-specific key as an action key.

3. Click Register.
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The action key moves from the Selected key box to the Registered keys list. The keys shown in the Registered
keys list appear on the key input bar in the same order. Adjust the order as required, using the upward arrow
button and the downward arrow button.

4. From the Registered keys list, select the action key you want to execute, and click Send.
The selected action key is sent to the agent.
If the system is configured to display the key input bar, you can close the dialog box, and use the buttons on the
bar to send action keys.

(2) Default action keys
The following table lists the action keys that are provided by default in Remote Control Manager. You can use these
action keys if you go to the Register Action Key page and then, from the Action key type drop-down list, choose
Default.

Table 4‒1: Default action keys

Number Action key

1 Ctrl + C

2 Ctrl + O

3 Ctrl + P

4 Ctrl + S

5 Ctrl + V

6 Ctrl + X

7 Ctrl + Z

8 F1

9 Shift + F1

10 Shift + F10

11 Spacebar

12 Esc

13 Alt

14 Alt + Tab

15 Alt + Esc

16 Alt + Spacebar

17 Alt + -

18 Alt + Enter

19 Alt + F4

20 Alt + F6

21 Alt + Print Screen

22 Print Screen

23 Ctrl + Esc

24 Ctrl + F6

25 Ctrl + Tab
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4.2.3 Transferring clipboard data
When you edit a document on an agent by using the remote control facility and want to copy or move data between a
document on the agent and a document on the controller, you will need to transfer clipboard data between the agent
and the controller. You can transfer text, bitmaps, metafiles, rich text format files, color palettes, and any combination
of the above. The following figure provides an overview of transferring data between clipboards.

Figure 4‒17: Clipboard data transmission

When the connected agent is version 05-21 or later, you can use the automatic clipboard data transmission facility, and
eliminate the inconvenience of having to perform each transfer manually. Note that the automatic transmission facility
transfers clipboard data every time the clipboard contents are updated, regardless of whether or not it is necessary. As
a result, you may not be able to correctly grasp the clipboard contents of the local machine, or the operation speed
may slow down depending of the size of transferred clipboard data. Accordingly, you should use the automatic
transmission facility only when manual transmission is cumbersome, e.g., when you need to cut and paste data
between the controller and agent frequently.

The following subsections describe how to transfer clipboard data manually, and how to configure the system to
perform automatic transmission.

(1) Manual transmission
You can use either of two methods to transfer data from the clipboard manually:

• Open the Transfer Clipboard Data dialog box and transfer data.

• Use the pull-down menu attached to the Send Data button to transfer data.

These methods are explained below.

(a) Open the Transfer Clipboard Data dialog box and transfer data

You can use the Transfer Clipboard Data dialog box to select a transfer type and a data type.

To perform the operation:

1. On the controller or agent, select the data you want to transfer, and copy (or cut) it.
The data is stored in the clipboard of the controller or agent.

2. From the Tools menu, choose Transfer Clipboard Data. (Alternatively, click the Send Data button on the
toolbar.)
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The Transfer Clipboard Data dialog box appears.

Figure 4‒18: Transfer Clipboard Data dialog box

Transfer type
Specify the data transmission direction. Select Receive to use the agent's data on the controller, and select
Send to use the controller's data on the agent.

Data type
Specify the format of the data to be transmitted. Select Plain text if the transmission data is text only. For data
other than text (such as bitmaps, metafiles, rich text, or color palettes), or a combination of text and other
types of data, select Formatted data.

3. Make any necessary selections, and choose OK.
The data transmission starts. A message dialog box appears during the transmission indicating the transmission
status.

4. Paste the data on the screen (into the application) of the controller or agent, to which the data is to be transferred.
The transferred data is pasted.

(b) Use the pull-down menu attached to the Send Data button to transfer data

You can open a pull-down menu by clicking the arrow next to the Send Data button on the toolbar in the Remote
Control window. Select the desired menu item.

Figure 4‒19: Transferring data from the pull-down menu attached to the Send Data button

Send
Sends data in all format combinations, including text, bitmaps, metafiles, rich text, and color palettes to the agent.
Choosing this menu item performs the same function as selecting Send for Transfer type and Formatted data
for Data type in the Transfer Clipboard Data dialog box.

Receive
Receives data in all format combinations, including text, bitmaps, metafiles, rich text, and color palettes from the
agent. Choosing this menu item performs the same function as selecting Receive for Transfer type and
Formatted data for Data type in the Transfer Clipboard Data dialog box.

Send - Text Only
Sends text-format data to the agent. Choosing this menu item performs the same function as selecting Send for
Transfer type and Plain text for Data type in the Transfer Clipboard Data dialog box.
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Receive - Text Only
Receives text-format data from the agent. Choosing this menu item performs the same function as selecting
Receive for Transfer type and Plain text for Data type in the Transfer Clipboard Data dialog box.

If the toolbar is not displayed, you can view it using either of the following two methods:

• Choose View, Toolbar, and then Toolbar.

• In the Properties dialog box, open the Toolbar page and select the Show the toolbar check box.

(2) Automatic transmission
When the connected agent is version 05-23 or later, you can use the automatic clipboard data transmission facility.
This facility automatically transfers clipboard data to the connected controller or agent when the contents of the
clipboard are updated. Using this facility keeps the contents of the controller and agent clipboards identical at all
times, thus allowing you to perform seamless editing operations over different machines.

To use the facility, in the Properties dialog box, in the Clipboard page, set the Transfer the clipboard data
automatically option. You can restrict the direction of transmission (send or receive) and data format (plain text or
formatted data). When using the facility to receive the agent's clipboard data, you can select the transmission condition
from the following: Always receive the data and Receive the data only when the Remote Control window is
active. If you select the Always receive the data option when connected to more than one agent, the controller will
receive clipboard data from all agents. If this is inconvenient, select the Receive the data only when the Remote
Control window is active option. With this selected, even if connected to multiple agents, you only receive data from
the agent currently subject to remote control. For details on how to configure the automatic transfer of clipboard data,
see 3.3.8 Clipboard page.

While transferring data, the system displays a message and progress bar (bar indicating the transmission progress by
percentage) in the status bar situated at the bottom of the Remote Control window.

Figure 4‒20: Message and progress bar displayed while data is being transmitted

If you start receiving an unexpectedly large file, which looks like it will take an excessively long time to transfer, you
can right-click the progress bar and choose Cancel to cancel the transmission. The system will discard the data being
transmitted, and the clipboard contents will revert to the previous state.

Figure 4‒21: Progress bar with the Cancel menu displayed

4.2.4 Useful operations you should remember
This subsection describes useful operations you should remember when using the remote control facility.
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(1) Encrypting remote control data
You can encrypt data to be sent to or received from the agent (including clipboard data) when using JP1/Remote
Control. Encrypting remote control data allows you to protect it. To encrypt remote control data, go to the Properties
dialog box, open the Security page, and select Encrypt the data to transmit and Encrypt the data to receive.

When the controller is configured to encrypt remote control data, the Send/Receive icon on the status bar looks like as
follows:

• Data to be transmitted is encrypted: 

• Data to be received is encrypted: 

• Data to be transmitted and data to be received are encrypted: 

Note that this function is available only when connecting to an agent version of 06-51 or later.

(2) Making the agent screen more readable and easier for operation
You can make the agent screen more readable and easier to operate by using the controls to zoom the agent screen in
or out and to hide and display the toolbar, address bar, and other components.

(a) Zooming the agent screen in or out

Zooming out the agent screen to fit it into the controller display
From the View menu, choose Zoom, and then Zoom Out to Fit, to zoom out the agent screen to fit it into the
Remote Control window. You can use this option when the agent's resolution is greater than that of the controller.
The image quality when zooming is determined by the Zoom priority setting of the Properties dialog box's
Window page.
To cancel the zooming, from the View menu, choose Zoom, and then Cancel.

Zooming in or out the agent screen to fit it into the controller display
If you go to the View menu, choose Zoom, and then Auto-zoom, the agent window is automatically zoomed to fit
the controller display.
This menu choice performs the same operation as when you go to the Window page of the controller's Properties
dialog box and select the Auto-zoom check box. The selection status of the check box is linked to that of the
Auto-zoom menu item.
From the Window page of the Properties dialog box, you can also specify whether to prioritize speed or image
quality when zooming.
To cancel the zoom, perform one of the following operations.

• Clear the Auto-zoom menu item, and then choose Cancel.

• Go to the Window page of the Properties dialog box, and then clear the Auto-zoom check box.

Showing the agent screen in the full-screen size
From the View menu, choose Full Screen, to set a full-screen view of the agent screen on the controller display.
The full-screen view may not be available for reasons such as the inability to adjust screen resolution. When the
controller and agent machines have different resolutions, a dialog box appears on the controller, requesting that
the resolution be changed. Select a refresh rate in this dialog box.
To cancel the full-screen view, enter the Alt + Enter keys. A dialog box appears, asking you to specify which of
the following operations you want to perform:

• Cancel the full-screen view.

• Cancel the full-screen view, and send the Alt + Enter keys.

• Maintain the full-screen view, and send the Alt + Enter keys.

(b) Arranging multiple agent screens

When you have multiple agents subjected to remote control, you can arrange the multiple agent screens in a number of
ways to facilitate operations on the screens.
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From the Window menu, select Arrange Vertically, Arrange Horizontally, or Arrange All. If you select Arrange
Vertically, the agent screens are tiled vertically. If you select Arrange Horizontally, the screens are tiled
horizontally. If you select Arrange All, the screens are tiled vertically and horizontally.

For example, if three agents are connected to the controller, the above three arrangements are as follows:

Figure 4‒22: Example of arranging multiple agent screens

(c) Displaying or hiding the controller bars

You can display or hide the controller bars (toolbar, address bar, and status bar) in the Remote Control window. When
the controller bars are hidden, the display area on the agent screen is increased and easier to perform operations on.

To display or hide the controller bars, you can use the appropriate menu or properties dialog box.

Menu

• From the View menu, choose Toolbar, and then Toolbar or Address Bar.

• From the View menu, choose Status Bar, and then Status Bar.

Properties dialog box

• Go to the Toolbar page, select or clear the Show the toolbar, Show the address bar, or Show the status bar
check box.

(3) Saving agent screens
You can save in a bitmap file the agent screen for an agent that is under remote control. This function is helpful when
an error message is displayed on the agent screen. The save file contains the screen including the error message and
can be analyzed later to help identify the cause of the error.

To save an agent screen, go to the File menu and choose Save Screen. The Select File Used to Save the Agent Screen
dialog box appears. In this dialog box, specify the name of the file to be saved and its location.

When saving the file, specify one of the five following color formats:

• Monochrome

• 16 color

• 256 color

• 16-bit color

• 24-bit color

By default, the color format of the agent window is used.
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(4) Auto-scroll
Auto-scroll is a facility that allows you to scroll the agent's screen (provided that it has scroll bars) by placing the
pointer near the edge of the agent's screen shown on the controller display. To use this facility, go to the Properties
dialog box, open the Window page, select the Scroll synchronized with the mouse pointer check box, and select
Always or Only while dragging.

If you select Always, the window will automatically scroll when you move the mouse pointer close to a window edge.
If you select Only while dragging, the window will not scroll when you move the mouse pointer ordinarily, but will
scroll while you are dragging. This is convenient when you perform drag and drop operations.

Another function for automatic scroll is provided to display the agent's active window on the controller's display area.
The display area of the controller scrolls in synchronization with the active window of the agent. To enable this
function, go to the Properties dialog box, open the Window page, and select the Scroll synchronized with the active
window check box. This function is not available if the version of the connected agent is 06-00 or earlier.

(5) Variable window size
The Remote Control window is fixed to the size that matches the resolution of the agent's screen. Therefore, when
displaying an agent's window with low resolution, the Remote Control window may not be able to fully show its
toolbar or status bar.

To prevent a partial display, go to the Properties dialog box in the Window page and select the Window size is
variable check box.

(6) Scrolling with the mouse scroll wheel
You can use the mouse's scroll wheel to scroll each window of Remote Control Manager. When you rotate the wheel,
a window that can be scrolled vertically will be scrolled vertically, whereas a window that can be scrolled horizontally
will be scrolled horizontally. If a Remote Control window can be scrolled both horizontally and vertically, you can
scroll the window horizontally by rotating the wheel while pressing down the Shift key.

When connected to an agent of version 05-23 or later, you can use the scroll wheel to scroll the agent's screen called to
the Remote Control window.

If both the Remote Control window and the agent screen called onto the window have scroll bars, using the mouse
scroll wheel will scroll both windows simultaneously, making them difficult to operate. To prevent this, select the
Disable wheel scroll check box in the Window page of the Properties dialog box. This will invalidate wheel rotation
instructions in the Remote Control window, only scrolling the agent screen called to the controller display.

(7) Customizing the toolbar
You can change the button types of the toolbar in the Remote Control window and the order in which the buttons are
displayed. The following subsection describes how to customize the toolbar and the various toolbar buttons.

(a) Customizing the toolbar

To customize the toolbar, open the View menu, choose Toolbar, and then Customize. The Customize Toolbar dialog
box appears. Use this dialog box to customize the toolbar.

Figure 4‒23: Customize Toolbar dialog box
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To add a button to the toolbar, select the button to be added from the Available toolbar buttons list, and then click
the Add button. This shuffles the selected button to the Current toolbar buttons list and adds the button to the
toolbar. The layout of the buttons is based on the order of the Current toolbar buttons list.

Alternatively, to remove a button from the toolbar, select the button from the Current toolbar buttons list, and then
click the Remove button. The button is shuffled back to the Available toolbar buttons, and the button is removed
from the toolbar.

To change the display order of a toolbar button, select the button from the Current toolbar buttons list and click the
Move Up or Move Down button. The selected toolbar button moves up or down one level. In the Current toolbar
buttons list, the entries for toolbar buttons are positioned at higher level if the toolbar buttons are closer to the left end
on the toolbar in the Remote Control window. You can also change the buttons to be displayed on the toolbar and their
positions on the toolbar by performing a drag-and-drop operation on the Current toolbar buttons list. To restore the
default toolbar buttons, click the Reset button.

You can also display or hide toolbar button text labels by one of the following two methods.

• From the View menu, choose Toolbar, and then Button Text Labels.

• In the Properties dialog box, go to the Toolbar page and select the Show the button text labels check box.

(b) List of toolbar buttons

The table below lists the toolbar buttons that can be displayed on the toolbar in the Remote Control window.

Table 4‒2: Toolbar buttons

Button Function Default display

Connect button
Connects to an agent. Click the arrow and select an agent from the drop-down
list of the agents that were connected in the past.

Y

Disconnect button
Terminates connection with the agent.

Y

Reconnect button
Reconnects to an agent.

N

Terminate button
Terminates Remote Control Manager.

N

Terminate All button
Terminates all running Remote Control Managers.

N

Shut Down button
Shuts down the agent.
If the agent's version is 06-71 or later and the agent's PC has the power-off
functionality, you can turn off the agent after shutting it down.

N

Reboot button
Reboots the agent.

N

Ctrl+Alt+Del button
Sends the Ctrl + Alt + Delete key operation to the agent.
If a Windows Me or Windows 98 agent is connected, the Remote Control
Process Viewer window appears.

Y

Send Data button
Transfers data between clipboards.
If you click the arrow, menu of transfer clipboard data appears. This menu
enables you to transfer data.

Y
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Button Function Default display

Send File button
Displays the File Transfer window.

Y

Refresh button
Updates the agent screen to the current status.

Y

Cancel Zoom button
Returns the reduced agent screen to the original size.

Y

Zoom Out button
Reduces the agent screen to fit the Remote Control window.

N

Auto-zoom button
Automatically enlarges or reduces the agent screen to fit the Remote Control
window.

Y

Full Screen button
Displays the agent screen using the entire area of the controller screen.

Y

Properties button
Lets you set the operating environment for the Remote Control Manager.

Y

View button
Indicates the View remote control mode.

N

Shared button
Indicates the Shared remote control mode.

N

Exclusive button
Indicates the Exclusive remote control mode.

N

Help button
Displays the JP1/Remote Control online help.

N

Version button
Displays the version of JP1/Remote Control Manager.

N

Save Screen button
Saves the agent screen display.

N

Horizontal button
Arranges the agent windows horizontally (left to right).

N

Vertical button
Arranges the agent windows vertically (top to bottom).

N

Arrange All button
Uniformly arranges the agent windows horizontally and vertically.

N
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Button Function Default display

Minimize All button
Minimizes all Remote Control windows.

N

Search button
Searches the agents.

N

Start button
Starts recording the agent screen display.

N

Pause button
Pauses or restarts recording the agent screen display.

N

Stop button
Stops recording the agent screen display.

N

Play button
Plays back a recording file.

N

Convert button
Converts a recording file.

N

Chat button
Displays the Chat window.

N

Legend:
Y: Displayed by default
N: Not displayed by default

(8) Operating on the agent without being aware of the controller

(a) Giving priority to the controller's settings for the mouse buttons

If mouse button settings (for right or left hand operation) are different between the controller and the agent, mouse
button operations performed on the controller produce different effects on the agent. For example, if the controller's
mouse is set for right hand operation and the agent's mouse is set for left hand operation, an attempt to display the
context menu will result in an ordinary selection operation.

If you want the controller's mouse button operation to produce the same effect on the agent, go to the Properties dialog
box, open the Window page, and select the Gives priority to the controller's mouse button settings check box.

This function is available if the version of the agent connected to the controller is 06-00 or later.

(b) Sending system keys

Before shortcut keys or function keys entered on the controller can produce the intended effects on the agent, these
keys must be registered as action keys and sent to the agent. However, the following four keys, when entered on the
controller, will produce the intended effects on the agent if they are set in the Properties dialog box.

• Windows

• Ctrl + Esc

• Alt + Esc

• Alt + Tab

To make the entry of these keys on the controller produce the desired effect on the agent, open the Properties dialog
box, open the Window page, and then select the Sends input of the system key check box.

4. Controller Operations

117



This function is only available if the controller is running on Windows 8, Windows Server 2012, Windows 7,
Windows Server 2008, Windows Vista, Windows Server 2003, Windows XP, Windows 2000, or Windows NT 4.0
Service Pack 3 or later.

(9) Logging information
Remote Control Manager allows you to specify whether or not to output remote control logs, and what kind of
information should be output if you choose to output logs. You can also set up the logging environment (the number
of output lines and logging generations). Configure the logging information in the Logging page of the Properties
dialog box. Log information is not output by default.

You can select the following types of log information for output:

• Connect/disconnect

• Authenticate

• Reboot/shutdown

• Ctrl + Alt + Delete

• Remote control mode

• Optimize transaction option

For details on log information and its meaning, see K. Logging Format and Output Information.
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4.3 Transferring files
When the remote control mode is either exclusive or shared, you can send and/or receive files between the controller
and agent during remote control operations. You can also transfer files between agents and edit agent file information.

Use the File Transfer window for file transmission.

4.3.1 File Transfer window
The File Transfer window displays file information of the controller and its agents in a tree structure similar to that of
Explorer. You can perform simple operations, such as drag and drop, within this window to transfer files. You can
also create a folder or remove and delete files.

The figure below shows the File Transfer window.

Figure 4‒24: File Transfer window

The following shows the meanings of the icons that are displayed in the File Transfer window.

: Controller

: Agent

: Removable disk drive

: Hard disk

: CD-ROM drive

: Network drive

: RAM disk drive

: Folder

: File

For details on the File Transfer window menus, see A.2 File Transfer window menus.

4.3.2 Opening and closing the File Transfer window
This subsection describes how to open and/or close the File Transfer window, and how to connect and/or disconnect
an agent.

To use the file transmission facility, you need to configure the agent's system to allow file transmission. If you
configure the settings to permit file transfer, you can also set file access permissions. You must also assign a port
number on the agent side for file transmission. For details on configuring the agent system, see 3.4.6 File transmission
settings.
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(1) Opening the File Transfer window
There are two ways of opening the File Transfer window. You need to start the File Transfer window after connecting
to the agent from the Remote Control window.

(a) Using the button or menu

With the agent screen called into the Remote Control window, choose Transfer File from the Tools menu. This menu
is disabled until a connection is established with an agent.

(b) Drag and drop

From the system's Explorer, you can drag and drop a file to any location on the agent's screen called onto the Remote
Control window to start the File Transfer window. File transmission starts immediately after the File Transfer window
opens.

Figure 4‒25: Drag and drop from Explorer to the Remote Control window

When using the drag and drop operation to transfer files, you must specify the agent's default folder (its transmission
destination folder) in the property settings of Remote Control Manager. If no default folder is specified, dropping a
file into the Remote Control window will not initiate file transmission.

Similarly, in the property settings of Remote Control Manager, if you set the configurations so they do not show the
File Transfer window, dropping a file into the Remote Control window will immediately initiate file transmission
without displaying the File Transfer window.

For details on property settings on file transmission, see 3.3.6 File Transfer page.

(2) Connecting to an agent
To use the File Transfer window for file transmission, you need to be connected to an agent through a port different
from the one used for remote control operations. When you take the steps described in (1) Opening the File Transfer
window to open the File Transfer window, the window uses a tree view to show the agents, that were connected
through the Remote Control window at the time the File Transfer window was opened. This represents a state in
which the controller is connected to the agent for file transmission.

Use either of the following procedures to connect to an additional agent that does not appear on the tree view. When
doing this, note the following:

• If an agent is not connected to the controller via the remote control port, it cannot be connected for file transfer to
the controller, either.

• If the agent is not logged on, file transfer between the controller and the agent is impossible.
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(a) Connecting from the address box

You can specify the agent you want to connect to in the address box of the toolbar in the File Transfer window.

The address box lists all the agents currently connected through the Remote Control window in a pull-down list.
Simply select the agent you want from the list.

If the address box lists too many agents for you to find the one you want, you can directly enter the agent in the
address box. In this case, enter the agent in the address box and press the Enter key. You can use up to 260 characters,
with no restriction on the type of characters available. Note that you cannot connect to an agent that has not been
connected for remote control purposes.

(b) Connecting from the Remote Control window

You can use a different Remote Control window than the one used to initially open the File Transfer window to re-
open the File Transfer window. Use either of the procedures described in (1) Opening the File Transfer window
above. From the second time onwards, agents will be added to the File Transfer window (rather than opening multiple
File Transfer windows).

(3) Disconnecting from the agent
From the File menu, choose Disconnect to disconnect the file transmission connection with the agent. If files are
being transferred or deleted at the time of disconnection, the process will be canceled. When the agent is logged off,
the connection for file transfer is also disconnected.

Severing the file transmission connection will not sever the remote control connection; but, severing the remote
control connection will sever the file transmission connection automatically. Similarly, when the remote control mode
is changed to view, the file transmission connection with the relevant agent will be severed. In this case, if files are
being transferred or deleted, a dialog box appears, asking whether you want to cancel the process.

(4) Closing the File Transfer window
From the File menu, choose End to exit the File Transfer window. Closing the File Transfer window will
automatically sever all file transmission connections. If files are being transferred or deleted at the time of exiting, the
process will be canceled.

4.3.3 File transfer security
Two types of security are available for file transfer.

• Data encryption

• File access permissions

(1) Data encryption
Data transferred "as is" across the network can be accessed by other people. You can encrypt the data to protect the
contents of files transferred between the controller and the agent from unauthorized access.

To encrypt data contained in files to be transferred, specify appropriate settings in the Transfer Options dialog box or
Properties dialog box on the controller. When the controller is configured for file transfer encryption, a lock is added
to the controller and agent icons.
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Figure 4‒26: Icons displayed when the data encryption function is specified for transferring files

For further information on the encryption settings, see 3.3.6 File Transfer page or 4.3.9(2) Transfer page.

(2) Setting file access permissions
If the controller is assigned file transfer permission, the controller is granted the same access as agent users. Therefore,
illegal access from the controller is possible. You can set file access permissions on the agent.

There are two file access permission types: Read and Write. Operations that can be performed on files vary depending
on the access permissions assigned to the files. For example, if a file is only assigned Read permission, an attempt to
send the file to the agent will result in the output of an error message.

You can set file access permissions when setting up the agent or making settings in the Remote Control Agent -
Properties dialog box. For further information on the configuration method, see 3.4.6 File transmission settings.

4.3.4 File transmission operations
The File Transfer window allows you to transfer files between the controller and agent in both directions. You can
also transfer files between agents.

There are three ways to transfer files in the File Transfer window. This subsection describes each operation procedure.

• Drag and drop
You can drag and drop files using the same procedure as in the system's Explorer. You can also drag and drop
files between the system's explorer and File Transfer window. This is the simplest way to transmit files.

• File registration
In this method you register a file or folder with Remote Control Manager as the transmission file(s), and transfer it
to the specified destination. You can also check the size and attributes of the registered file before transmission.
The files registered for copying can be pasted (transferred) as many times as you like.

• Customized transfer
This method allows you to transfer a file to multiple agents in a single operation. You can set the default
transmission destination folder, or specify the same folder as the transfer source, so you do not have to enter the
destination folder manually.

(1) Drag and drop
You can drag and drop a file or folder on the File Transfer window for transmission. The normal drag and drop
operation will copy files. To move files, press the Shift key while dropping the files. If you drag a file with the right
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button of the mouse, a menu appears when you drop the file, allowing you to select one of the following options:
Transfer, Copy, or Cancel.

You can also drag and drop a file to transfer it between the system's Explorer and the File Transfer window. In this
case, the file will be copied even if you press down the Shift key.

(2) File registration
You can register a file or folder and specify the destination to transfer it to.

Perform the following steps:

1. Select the file or folder you want to transfer. From the Edit menu, choose Register for Copying or Register for
Moving.
The selected file or folder is registered for copying or moving.
Note that you cannot register files for moving if the files belong to an agent of version 05-10. The files can only
be registered for copying.

2. Select the transfer destination (drive or folder). From the Edit menu, choose Transfer Files.
The file transmission starts.

(3) Customized transfer
Customized transfer is a method of transferring a file to multiple agents in a single operation. You can set the default
transmission destination folder, or specify the same folder as the transfer source, so you do not have to enter the
destination folder manually.

Perform the following steps for customized transfer:

1. Select the file or folder you want to transfer. From the Edit menu, choose Customize.
The Customized Transfer dialog box appears.

Figure 4‒27: Customized Transfer dialog box

Destination list
This facility lists the host names or IP addresses of all agents connected for file transmission. If the
transmission source is an agent, the controller is included as one of the possible transmission destinations.

Destination folder
Specify the transmission destination folder. The default setting is the folder specified in the File Transfer
window options. For details on how to set the destination folder, see 4.3.9(2) Transfer page.
To specify a folder other than the default folder, click the Browse button and specify the path.

Destination folder is same as the source
Select this check box to transfer the file to the same folder as the transmission source. Selecting this will
display the upper level folder of the transmission file in the Destination folder box, and disable the box.

2. Set the transmission destination agents and folders, and click Transfer.
The file transmission process starts. If you select multiple agents, the transmission file will be sent to the same
folder of each agent.
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4.3.5 Displaying the transmission status and canceling the process
When file transmission starts, the Progress of File Transfer dialog box appears on both the controller and agent(s).
(The dialog box is minimized on the agent.)

Figure 4‒28: Progress of File Transfer dialog box

To cancel the file transmission, in the Progress of File Transfer dialog box, click Cancel. The Cancel button can be
clicked from either the controller or the agent(s). If the controller cancels file transmission, a dialog box appears,
asking whether transmission should be canceled. If the agent cancels transmission, the process is canceled
immediately.

If you cancel file transmission, the files that have already been transferred will remain at the transmission destination.
When you are moving files, rather than copying them, the transferred files are deleted from the transmission source.

In file transmission within the same agent, or between two agents, files are transferred via a work folder on the
controller. Therefore, the Progress of File Transfer dialog box appears twice, once in the transmission from the agent
to the work folder, and once in the transmission from the work folder to the destination agent.

4.3.6 Manipulating agent files
When you manipulate agent files, you can display the agent screen and can also use the File Transfer window.

When you open an agent file from the File Transfer window, the file is transferred from the agent to the controller.
That is, if you open an agent file from the File Transfer window, you are opening a copy of the file that is received in
the controller. So, editing the file will not affect agent users. The file is received by the folder specified by an option in
the File Transfer window. For details about setting the folder to receive the file, see 4.3.9(3) File page.

If you open files with the same name from multiple agents, the controller receives the files in the order you open them.
Each time the controller receives a file, the controller overwrites the file received the last time. As a consequence, the
file received the last time will be opened.

(1) Editing agent files
To edit an agent file from the File Transfer window:

1. In the File Transfer window select an agent file. Then choose File and then Open.
The controller receives the selected file. When the transfer finishes, the file transfer list window that displays the
received files is displayed, and then the files in the list are opened. For details of the file transfer list window, see
(2) Transfer and delete files.

2. Edit the file.

3. After editing is complete, close the file.
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The file is automatically transferred from the controller to the original location on the agent and the original file is
overwritten. After the transfer, the file is deleted from the controller.

The above processing is based on the default settings in the Transfer Options dialog box. If you want to transfer the
file under a certain condition or leave the file on the controller rather than automatically transferring the file and
deleting the file on the controller, change the settings on the File page in the Transfer Options dialog box. For further
information, see 4.3.9(3) File page.

If the controller is not configured for automatic file transfer and deletion, the file on the controller will remain in place
when the file is closed. For details on manually transferring and deleting files remaining in the controller, see (2)
Transfer and delete files.

(2) Transfer and delete files
If you opened an agent file from the File Transfer window, that file is saved in the controller. If the file transfer and
deletion are not auto-processed, the file will remain in the controller even if you close it.

By using the file transfer list window, you can confirm files which remain in the controller. From this window, you
can transfer files remaining in the controller to the agent, and you can delete them from the controller.

To display the file transfer list window and manually transfer and delete files:

1. From the File Transfer window, select the item (host or folder) of the agent to be checked, choose View, and then
File Transfer List.
The file transfer list window appears, so you can confirm the files that remain in the controller. If you have not
opened any file from the selected agent, the file transfer list window displays nothing.
The following is the file transfer list window.

Figure 4‒29: File transfer list window

Name
Displays the name of the file opened in the agent.

Folder
Displays the path of the controller where the file opened in the agent is saved.

Status
Displays the status of the file.

Size
Displays the size of the opened file.

Modified
Displays the last modified date of the file.

Source location
Displays the path of the file in the agent.

For details on the file transfer list window menus, see A.2 File Transfer window menus.

2. In the file transfer list window, choose Edit, and then Transfer Files or Delete after Transfer.
The edited file is transferred to the original location on the agent. If you choose Transfer Files, the operation that
is performed is similar to copying in that the file remains on the controller. Choosing Delete after Transfer is
similar to moving in that the file is deleted from the controller.
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To delete the file from the controller, from the File menu of the file transfer list window, choose the Delete menu. A
dialog box appears and indicates the deletion status, while the files in the controller are deleted.

Figure 4‒30: Progress of File Deletion dialog box

4.3.7 Confirming file information
If you wish to know detailed information concerning a specific file, or the total size of registered files, open the File
Confirmation dialog box, to check file information.

The following explains how to display the File Confirmation dialog box.

To check the information of a selected file:
Select a file or folder. From the Edit menu, choose Confirm Files and then Selected File.

To check the information about a registered file:
From the Edit menu, choose Confirm Files and then File List. (The File List command is enabled when a file is
registered.)

The File Confirmation dialog box allows you to check information such as the location, name, size, modified date, and
attributes of each file or folder, as well as the number of selected files and their total size. You can also register the
selected files or change the registration type. The following is the File Confirmation dialog box.
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Figure 4‒31: File Confirmation dialog box

Run
Displays the current transfer type.

• Select
The selected file. The file is not registered.

• Copy
The file registered for copying.

• Move
The file registered for moving.

If you are checking the information of the selected file, change the file from Select to Copy or Move to register
the file as a copy or move the file.
If you are viewing a registered file, you can change the registration type (Copy/Move).

Host
Displays the host where the folder or file you are currently viewing is located. For the controller, Local is
displayed. For an agent, the host name or IP address is displayed.

Location
Displays the top-level folder name of the currently folder or file you are currently viewing.

Name, Size, Modified, Attributes
Displays the information (name, size, last modified date, and attributes) of the file currently selected in the File
Transfer window or the file registered for copying or moving.

Number of files
Displays the total number of selected files. If a folder is selected, the number of files in the folder is also
calculated.

Size
Displays the total byte size of the currently folder or file you are currently viewing.

Delete
If you select a registered file from the list and click this button, the registration is canceled.

Click the OK button to exit the file confirmation. If files are removed from the registration with the Delete button, the
changes are applied when clicking the OK button. If you click the Cancel button, the changes of the Delete button are
not applied.
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If you change Run, the changes are applied at the time you change the setting. Therefore, clicking the OK button or
clicking the Cancel button will not affect the results.

4.3.8 Editing a file
The File Transfer window allows you not only to transfer files but also perform the following operations on the folder
or file on the local system or connected agent. However, you cannot perform these operations unless you have access
permission for the folder or file:

• Create a folder

• Delete a folder or file

• Change attributes of the folder or file

• Rename a folder or file

These operations are not available for agents of version 05-10. Note that you cannot perform any operations unless
you have the access right to the folder or file you want to operate.

(1) Creating a folder
You can create a new folder on the controller or on the agent.

Perform the following steps:

1. Select the location (drive or folder) in which you want to create a new folder.

2. From the File menu, choose New and then Folder.
The system adds a new folder with a temporary name (e.g., new folder) to the list view, and makes it ready to
enter the folder name.

3. Enter the folder name.
A new folder is created with the specified name.

(2) Deleting a folder or file
You can delete a folder or file on the controller or agent. If the system Recycle Bin is available, the folder or file you
want to delete will be moved to the bin. If no Recycle Bin is available, the folder will be deleted from the system.

Perform the following steps:

1. Select the folder or file you want to delete.

2. Press the Delete key on the keyboard. (Alternatively, from the File menu, choose Delete.)
A dialog box appears, asking you whether the file should be deleted (moved to the Recycle Bin).
If you want to delete the file from the system directly, rather than moving it to the Recycle Bin, perform the above
operation while holding down the Shift key.

3. Choose Yes or Delete All.
The selected folder or file is deleted (moved to the Recycle Bin). On the controller, a dialog box appears, showing
the deletion status.

(3) Changing attributes of folders and files
You can change attributes of folders and files in the File Transfer window.

To change attributes:

1. Select the file or folder whose attributes you want to change.
You can select multiple files or folders.

2. Choose File and then Properties.
The Properties dialog box appears.
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Figure 4‒32: Properties dialog box

At the top of the dialog box, the name of the selected file or folder, as well as the total number of selected items
are displayed. Below that, the following information is displayed:

Host
Displays the name of the host where the selected file or folder exists.

Location
Displays the path of the selected file or folder.

Size
Displays the size of the selected folder or file. If a folder is selected, the total number of files in that folder is
displayed. If multiple files are selected, the total number of selected files is displayed.

Contents
If the folder properties are displayed, the total number of files and folders under the selected folder is
displayed.

Created
Displays the created date of the selected folder or file.

Modified
Displays the last modified date of the selected file.

Accessed
Displays the last accessed date of the selected file.

Attributes
Displays the attributes of the selected folder or file. You can change the Read-only, Hidden, and Archive
attributes. You cannot change the Compress or System attributes.

3. Set the required attributes and choose OK.
The attributes are changed so that the settings you made take effect. The new settings take effect on the selected
file or folder, but they do not take effect in the file(s) and folder(s) in the selected folder.
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(4) Renaming a folder or file
You can rename folders and files on the controller or on the agent.

To rename a folder or file on the controller or agent:

1. Select a folder or file you want to rename.

2. Click the name section again. (Alternatively, from the File menu, choose Rename.)
The icon of the folder or file takes the state in which you can change its name.

3. Enter a new name.
The folder or file is renamed.

4.3.9 Configuring the file transmission options
To improve the efficiency of File Transfer window operations, we recommend that you configure options in the
Transfer Options dialog box. From the Other menu, choose Option to display this dialog box. After setting these
options, click the Save button to save the specified values as the new default values. If you click Update, the settings
are only effective during the current session of Remote Control Manager.

The Transfer Options dialog box and its setup items are shown below.

(1) View page
The View page allows you to configure options related to the view of the File Transfer window.

Figure 4‒33: View page

File type
Configure this option if you want to restrict the kinds of files to be shown on the File Transfer window. You may
use up to 225 characters, with no restrictions on characters to be used. Note that the asterisk (*) is the only
character which can be used as the wild card. The default setting is *.* (meaning all files).
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Icon

Display document files as application icons.
This check box specifies whether files are represented in the list view by application icons or by icons specific
to file transmission. By default, this check box is selected, so that the files are represented by application
icons.

Status box
You can configure whether or not the system should automatically close the Progress of File Transfer dialog box,
shown during file transmission, and the Progress of File Deletion dialog box, shown during file deletion. Both
check boxes are selected by default (meaning the dialog boxes will be closed automatically).

Status box disappears when transfer is completed.
Select this check box to close the Status box automatically upon completion of file transmission.

Status box disappears when deletion is completed.
Select this check box to close the Status box automatically upon completion of file deletion.

File transfer List

The file transfer list closes when there is no entry.
Select this check box if you want the file transfer list window to be closed automatically when all the files that
you opened from the file transfer list window are deleted (that is, when agent files are deleted from the
controller). If this check box is cleared, the file transfer list window remains open. By default, this check box
is selected.

(2) Transfer page
The Transfer page allows you to configure options related to file transmission methods.

Figure 4‒34: Transfer page

Transfer options
Configure data compression. This option can be also set up in the File Transfer page of the Properties dialog box
from the Remote Control window. If the two pages have different settings, the ones saved most recently will take
effect.
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Compress the data to transfer.
Select this check box to compress all transmission data. Compressing the data will reduce the time required
for transmission. By default, the Compress the data to transfer option is selected. The table below lists the
standard compression rates for transmission data.

Table 4‒3: Transmission data compression ratio

Type of transmission data Compression rate

100 megabytes of text data About 1%

145 megabytes of program data (for Microsoft Office 95) About 47%

Encrypt the data to transfer.
Select this check box to encrypt data to be transferred. If the file transfer destination is an agent whose version
is 06-51 or earlier, you cannot use the encryption function.

• Display a warning message if data is not encrypted.
Select this check box to display a warning message when the agent cannot encrypt data (the agent version
is 06-51 or earlier). If you select this check box, a warning message stating that data cannot be encrypted
will be displayed when connection is established for file transfer and when file transfer is performed.

Work folder
Specify the folder for temporarily storing files being transferred within an agent or from an agent to another agent.

Destination folder
Set the default destination folder for customized transfer. No folder is specified by default.

(3) File page
From the File page, you can specify the behavior when opening or closing agent files.

Figure 4‒35: File page
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Opening files on the agent
Specifies the folder in the controller for saving agent files which are opened. For the folder name, use up to 260
characters except for slashes (/), asterisks (*), question marks (?), double quotation marks ("), less-than symbols
(<), greater-than symbols (>) and vertical bars (|).

Show the list of opened files for confirmation.
Select this check box if you want to view a list of files which are opened from the agent. If this check box is
selected, the file transfer list window appears just as you opened a file. By default, this check box is selected.

Closing files on the agent
Specifies actions to be triggered when the files are closed.

Delete local copy on the controller
Select this check box if you want files in the controller to be deleted. By default, this check box is selected. If
you clear this check box, the file is kept in the controller when closing the file.

• Show progress in the dialog box during deletion
Select this check box if you want to view the Progress of File Deletion dialog box when the files in the
controller are deleted. If this check box is cleared, the Progress of File Deletion dialog box is not
displayed when the files are deleted. By default, this check box is selected.

Overwrite the file on the agent with the local copy on the controller
Select this check box if you want to restore files stored in the controller back to the agent. By default, this
check box is selected. You can select either of the following transmission methods:

• Transfer only modified files to the agent
Transfers only the files edited in the controller. This option is selected by default.

• Transfer all files to the agent
Restores all the files stored in the controller back to the agent.

These two options determine actions to be triggered when the files are closed. The table below shows the various
operations depending on the combination of options.

Table 4‒4: How the action subsequent to the closing of the file depends on the combination of options

Overwrite the file on the agent with
the local copy on the controller

Delete local copy
on the controller Actions to be triggered when the files are closed

Y Y The files are sent. After that, the corresponding files are deleted
from the controller.

Y N The files are sent. The files also remain in the controller.

N Y The files are deleted.

N N The files are neither sent nor deleted.

Legend:
Y: The check box is selected
N: The check box is cleared

(4) Logging page
In the Logging page, specify the output of file access logs, which log the file operations performed in the File Transfer
window.

For details about output logs, see K.2 File access logs.
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Figure 4‒36: Logging page

Output logs
Select this check box when you want to output logs about file accesses that used the File Transfer window. By
default, the check box is not selected.

Log all data items
Select this option to output all logging items that can be selected in Select the items to log. This is selected by
default.

Select the items to log
Select this option when you want to output only selected items as file access logs. The items selected from the
following will be output. By default, Connection/disconnect, Forwarded files, and Deleted files are selected.

• Connection/disconnect

• Forwarded files

• Deleted files

• Created folders

• Rename

• Attribute changes

If you do not specify any options, file access logs will not be output.

Log output level
Set information about file access logs. Neither check box is selected by default:

• Do not output warning information
Select this check box to prevent warning information from being output to the log.

• Do not output error information
Select this check box to prevent error information from being output to the log.

Print method
Set the format for the log output, and the amount of information that can be output to file access logs.
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Output format
Select the log output format from the following. The default is CSV Format.

Output format Description

CSV Format Information is output in the comma-separated format.

TSV Format Information is output in the tab-separated format.

User-specified format Information is output using the alphanumeric character or a symbol entered in the Delimiter text
box.

The default of the Delimiter text box is a semicolon (;).

Maximum lines in a log file
Specify the maximum number of lines in a log file as an integer from 0 to 9,999. The default is 500 lines. If
you specify 0, logs will not be output.

Generations to be saved
Specify the number of log generations to be saved as an integer from 0 to 99. The value specified here will
form the last 2 digits of the log file name, indicating the generation number. The default is 0 (no generation
management).

4.3.10 Notes on file transmission
This subsection describes points to remember when using the file transmission facility.

• File transmission is not available in the following situations:

• When the agent is not connected in the Remote Control window

• When the controller is in the view mode

• Before the agent is logged on

• If the agent is not configured to allow file transmission, you cannot transfer files with it. However, if the agent
modifies the property settings to prohibit file transmission when it is being operated through the File Transfer
window, you can continue to operate the agent's files until the remote control connection is severed.
For details on file transmission permission by the agent, see 3.4.6 File transmission settings.

• For an agent of version 05-10, you cannot create, delete, rename, or transfer the agent's folders or files (although
you can copy them).

• During file transmission via a low-speed line, refrain from remote control operations in the Remote Control
window, so as to prevent a memory shortage.

• If a connection error occurs during file transmission, the system may not be able to detect the disconnection. In
this case, the controller may fail to reconnect for file transmission. To avoid such situations, use the remote
control facility and cancel the Progress of File Transfer dialog box on the agent.

• Up to 260 (half-width) characters can be specified for the path of files that are transferred.
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4.4 Managing agents
Remote Control Manager enables you to name and group agents, thus allowing you to manage agent organization
more easily. The window for managing agent organization is called the Agent Manager window.

4.4.1 Screen components of the Agent Manager window
The Agent Manager window can display the following two types of information:

• Agent list

• Connection history

Use the pull-down list on the toolbar to select the information you want to display.

The following explains the windows for displaying each piece of information. For details on the Agent Manager
window menus, see A.3 Agent Manager window menus.

(1) Agent list
The agent list allows you to organize agent information in the manner you prefer. For example, you can give
descriptive names to agents, or organize them into logical groupings (by division, by business duties, etc.) in a
hierarchy. You can also receive connection requests from agents.

The figure below shows an example of the Agent Manager window with the agent list displayed.

Figure 4‒37: Agent Manager window (showing the agent list)

In the Remote Control window, click the Agent button to show the organizational information of the agents created
here. The menu format (agent menu) is used. For example, the agent information, shown in Figure 4-37, will be
displayed as below.
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Figure 4‒38: Example of an agent menu

(2) Connection history
The connection history uses a list format to show information about the agents that have been connected to date.
Agents are displayed by host names, IP addresses, or agent paths. For agent paths, see 4.4.5(2) Recording agent paths.

The figure below shows an example of the Agent Manager window with the connection history displayed.

Figure 4‒39: Agent Manager window (showing the connection history)

4.4.2 Starting and exiting the Agent Manager window
This subsection describes how to start and exit the Agent Manager window.

You can start the Agent Manager window even when unconnected to any agents. You can also instruct the system to
connect an agent from this window.

(1) Starting the Agent Manager window
There are two ways to start the Agent Manager window:

• In the Remote Control window, from the Agent menu, choose Change List.

• In the Remote Control window, click the Agent button. From the drop-down menu, choose Change List.

(2) Exiting the Agent Manager window
From the File menu, choose Close to exit the Agent Manager window.

If you have edited the contents of the Agent Manager window before choosing to exit, a dialog box appears asking
whether you want to save the changes. If you want to just save the changes without exiting the window, choose Save
or Save As from the File menu.
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4.4.3 Creating an agent list
This subsection describes how to create an agent list. There are five ways of creating an agent list, as shown below.
Choose the method most appropriate to the size of the network to be managed and how you wish to manage it.

• Add connected agents in the Remote Control window

• Create the list in the Agent Manager window

• Search for and read organizational information about agents

• Import agent information from the hosts file

• Use backup files

(1) Adding connected agents in the Remote Control window
Perform the following steps to add connected agents to the agent list in the current Remote Control window.

1. In the Remote Control window of the Agent menu, choose Add to List. (Alternatively, click the Agent button
and choose Add to List.)
The Set New Agent dialog box appears.

Figure 4‒40: Set New Agent dialog box

Address displays the address of the currently connected agent.

2. In the Name box, enter the name you want to give to the agent.
You are required to specify a name. The name specified here is displayed in the Name box of the agent list.

3. Specify whether to save the connection options that are set on the agent.
Select the Save connection option check box if you want to save connection options for the agent that is being
connected. By default, this check box is cleared. For how to set connection options on an agent, see 4.4.6 Setting
connection options for each agent.

4. Click OK.
The agent is added to the end of the agent list.
At this point, the added agent will not be shown in the agent menu of the Remote Control window. To add it to the
menu, start the Agent Manager window and save the information.

(2) Creating the list in the Agent Manager window
The Agent Manager window enables you to create a folder to group agents. Folders can be created in a hierarchical
structure. You can also insert separators in the agent menu of the Remote Control window, to make the agent
organization easier to understand.

Perform the following procedures to create folders and agents in the agent list, and insert separators into the agent
menu. Folders and agents are created in the following locations, depending on the item you select at the beginning of
the procedure.

When you select the root or folder
At the end of the hierarchical level under the selected root or folder

When you select an agent or separator
Immediately after the selected agent or separator (in the same hierarchical level)
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(a) Creating a folder

To create a folder in the agent list:

1. In the agent list, select the location where you want to create the folder.

2. From the File menu, choose New and then Folder.
The New Folder dialog box appears.

Figure 4‒41: New Folder dialog box

3. In the General page, enter the Name and Description
You must specify the Name. You can enter up to 260 characters for Name and Description.
Also, from the Setup page, you can set the attributes of items to be added to the folder. Item attributes can also be
changed after creating the folder. For details on attribute settings of items, see 4.4.8(1)(b) Setup page.

4. Click OK.
The folder is created in the agent list.

(b) Creating an agent

To create an agent in the agent list:

1. In the agent list, select the location where you want to create the folder.

2. From the File menu, choose New and then Agent.
The New Agent dialog box appears.
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Figure 4‒42: New Agent dialog box

3. In the General page, enter the Name, Host name or IP address and Description for the agent.
You must specify a Name and Address for the agent. You can enter up to 260 characters for Name and
Description. In the Address box, set the IP address or host name of the agent.
Also, from the Setup page, you can customize the connection options of the agent. The connection options can
also be changed after creating the agent. For details on the connection options, see 4.4.6(1) Connection options.

4. Click OK.
The agent is created in the agent list.

(c) Creating a separator

Perform the following steps when inserting a separator in order to make the agent organization easier to understand.

1. In the agent list, select the location where you want to insert the separator.

2. From the File menu, choose New and then Separator.
A separator is inserted.

(3) Searching for and reading the organizational information about agents
The Agent Manager window allows you to search for agent machines on the network and add connectable agents to
the agent list. The procedure for searching for and adding agents to the agent list has the following three stages:

1. Create the Network icon defining the range of addresses you want to search.

2. Use the Network icon to launch the search for agents.

3. Add the agents detected to the agent list.
Operational procedures for each of the above stages are shown below. For details on the find agent facility,
including how to define the search range, how to check the search results, and search restrictions, see C. How to
Use the Find Agent Facility.

(a) Creating the Network icon

The Network icon defines the range of agent searches. You can define a scope of addresses within the same subnet
for each Network icon. Creating a Network icon on the agent list will allow you to search the same network area
repeatedly. Additionally, if you choose Network from the Agent menu of the Remote Control window, you can
search for agents from within the window.
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You can create a Network icon using the same procedure as that for creating other icons (for folders and agents).

1. In the agent list, select the location where you want to create the Network icon.

2. From the File menu, choose New and then Network.
The New Network dialog box appears.

Figure 4‒43: New Network dialog box

3. In the General page, enter the name, address, and description.
You must specify the name and address. You can enter up to 260 characters for Name and Description. For the
Address box, specify the network range you want to search for agents. For instructions on specifying the search
range, see C.1 Setting the search range.
Also, from the Setup page, you can customize the search method of the agent. For instructions on customizing the
search, see C.3 Customizing the search method.

4. Click OK.
The Network icon is created in the agent list.

(b) Searching for agents

Double-click the Network icon to display the Search Agents dialog box and initiate a search for agents in the network
range specified in the Address box.

Figure 4‒44: Search Agents dialog box

Click Details to expand the dialog box and display the search status.
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Figure 4‒45: Agent page

The contents of the Search Agents dialog box are almost the same as when searching for agents from Remote Control.
However, if you search from the Agent Manager window, you can select the Close this dialog box when search is
finished check box to automatically close the dialog box when the search finishes.

You can only add those agents shown in the Agent page of the Search Agents dialog box to the Agent Manager
window. For this reason, when the search is completed, adjust the contents of the Agent page before closing the dialog
box.

For example, if you want to manage the organization of all the machines on the network, regardless of whether
Remote Control Agent is running or not, you need to select all the option items, from Awaiting connection to Not
responding. If you only want to add the currently connectable machines to the agent list, select the Awaiting
connection option only. For details on the agent statuses, see C.2 The status of found agents.

(c) Adding the search results to the agent list

Following the search, if you close the Search Agents dialog box, the agents shown in the Agent page of the dialog box
will be added under the Network icon and shown as Found Agent icons. Even if you click Close in the middle of a
search those agents already identified will be added to the list.

Figure 4‒46: Agent Manager window
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The system shows the Found Agent icons temporarily as search results, and does not save the information. (If you
close the Agent Manager window, the icons will be deleted.) To save the information about the found agents, you
need to drag and drop the icons into another folder. This will make it possible to save each icon as an item in the agent
list. After completing this process, you can treat it like a normal agent, and change its name or description
information.

(4) Importing agent information from the hosts file
Using the hosts file will allow you to add all the agents defined in the file to the agent list in a single operation.

To import agent information from the hosts file:

1. In the agent list, select the location you want to add the agents to (i.e., to read the hosts file information into).
The agents are added to the following locations in accordance with the choices you make.

When you select the root or folder
At the end of the hierarchical level under the selected root or folder

When you select an agent or separator
Immediately after the selected agent or separator (in the same hierarchical level)

2. From the File menu choose Import From and then Hosts File.
The Open File dialog box appears.

3. Select the hosts file you want to use, and click Open.
All the agents defined in the hosts file are added to the agent list. The contents of a hosts file are processed
according to the following rules:

• The leading and trailing spaces and tabs are ignored.

• Lines starting with the number sign (#) will be treated as comment lines and ignored.

• The first space or tab to the next space or tab will be regarded as the name.

• Aliases will be ignored.

• If a line defining an IP address and host name contains a number sign (#), the following character string will
be regarded as a description of the agent.

(5) Using the backup files
You can save the agent list information in a backup file with any name.

The following describes how to save the agent list information, and how to read the backup file to recover the agent
list.

(a) Saving to a file

To save the agent list information to a file, choose Save As from the File menu and save with a different name.

(b) Importing from a file

To use the backup file to recover the agent list:

1. In the agent list, select the location you want to read the file information to.
The agent list information is added to the following locations depending on what item you select.

When you select the root or folder
At the end of the hierarchical level under the selected root or folder

When you select an agent or separator
Immediately after the selected agent or separator (in the same hierarchical level)

2. From the File menu, choose Import From and then System File.
The Open File dialog box appears.

3. Select the backup file and click Open.
The agent list information is recovered and added to the specified location.
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4.4.4 Receiving connection requests from agents
In the Agent Manager window, you can receive connection requests from agents.

When a connection request is received from an agent, you can connect to the agent using the Agent Manager window,
as explained below.

When a connection request is received from an agent, the Agent Manager window pops up showing the agent that has
issued the connection request as an icon in the Agent List. If an agent issues connection requests to multiple
controllers simultaneously, that agent is identified as an icon in the Agent List on all the destination controllers.
Double-clicking this icon initiates a connection establishment process to the agent. This allows you to respond quickly
to connection requests from agents.

The following figure shows how the controller responds to a connection request from the agent.

Figure 4‒47: How the controller responds to a connection request from the agent

A pop-up message will also be displayed if the controller is configured to display pop-up messages. For further
information on pop-up messages, see (5) Operations performed to confirm the reception of a connection request
below. Clicking Connect on the pop-up message window initiates a connection establishment process to the agent.

When an agent that has issued connection requests to multiple controllers simultaneously is connected to one of the
controllers, the other controllers automatically close the pop-up message and, in the Agent List, deactivate the icon of
the agent that has issued the connection request. If the controller version is 06-51 or earlier, however, the pop-up
message will not be closed automatically.

The Agent Manager window settings needed to receive connection requests from agents are explained below.

(1) Creating a request server
A request server is required in the Agent List in order to receive connection requests from agents.

To create the request server:

1. In the Agent List, specify a location where the Request Server icon is to be created.

2. From the File menu, choose New and then Request server.
The New Request Server dialog box opens.
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Figure 4‒48: New Request Server dialog box

3. In the General page, fill the Name, Port number, and Description fields.
Entries into the Name and Port number fields are mandatory. You can enter up to 260 characters for Name and
Description. For Port number, specify the port number to use for connecting from the agent. Specify an integer
from 0 to 65535. By default, this is set to 30006.

4. Specify the items in the Setup page as required.
Specify request server attributes. For details on the attributes, see (2) Request server attribute settings. You can
specify these settings at a later time.

5. Click the OK button.
A request server is created and the Request Server icon ( ) is displayed at the specified location.
You can change the name and attributes of the Request Server icon as in the case of folders, agents, and other
items. For details on changing the attributes of the request server, see 4.4.8(4) Changing request server attributes.

(2) Request server attribute settings
The behavior when a connection request is received from an agent is set to the request server as attributes. To explain
these attributes, the Setup page of the New Request Server dialog box is used as an example. The same items are set
when changing the attributes of the request server and setting the properties of folders.
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Figure 4‒49: Setup page

Start request server when the agent manager starts.
Select this check box to start the request server automatically when the Agent Manager starts. By default, this
check box is cleared.

Port number for file transfer
Specify a port number for file transfer as an integer from 0 to 65535. The default port number is 30007. The
specification of a port number is mandatory.

Beep
Select this check box when you want your computer to beep when the controller receives a connection request
from an agent. By default, this check box is selected.

Display in front of all windows
Select this check box to display the Agent Manager window in front of any other window when the controller
receives a connection request from an agent. By default, this check box is selected.
When the Agent Manager window is displayed in front, the focus is placed on the Request Agent icon.

Display a pop-up message
Select this check box to display a pop-up message when the controller receives a connection request from an
agent. By default, this check box is cleared.
With the settings shown above, the Agent Manager window is displayed in front and a pop-up message will be
displayed. From the popup message of the dialog box, you can establish connection to the agent that has issued the
connection request. If you are using the controller as the help desk, select this check box.
For further information on pop-up messages, see (5) Operations performed to confirm the reception of a
connection request below.

Start the remote control
Select this check box to automatically start the remote control when a connection request is received from the
agent. By default, this check box is cleared.

Request agent
To connect to the agent that issued the request and remote control the agent, the connection options are set in
advance. Clicking the Setup button opens the Request Agent Settings dialog box. Specify connection options in
this dialog box. For details on the connection options, see 4.4.6(1) Connection options.
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(3) Starting and stopping the request server
Before you can receive connection requests from agents, you will need to start the Agent Manager window and start
the request server. You can determine whether the request server is active or inactive, based on the way the icon is
displayed.

 : Active (blue)

 : Inactive (red)

How to start and stop the request server is explained below.

(a) Starting the request server

You can start the request server automatically or manually.

Setting for automatic start
If you did not specify automatic start when creating the request server, you can specify automatic start by use of
the following method:

1. In the Agent List, choose the Request Server icon.

2. Choose File, and then Properties.

3. In the Properties dialog box, open the Setup page and select the Start request server when the agent
manager starts check box.

Setting for manual start
To start the request server manually:

1. In the Agent List, select a Request Server icon.

2. Choose File, and then Start.
The selected request server starts.

One of the following conditions causes an error and the request server cannot start.

• The port number for the request server is already used.

• The controller that was last started by the agent manager is connected to an agent.

(b) Stopping the request server

To stop the request server:

1. In the Agent List, select a Request Server icon.

2. Choose File, and then Stop.
A message dialog box is displayed, asking you if you are sure you want to stop the request server.

3. Click Yes.
The selected request server stops.

When one of the following operations is performed, the active request server stops.

• Cut or delete the request server.

• The Agent Manager window display is switched from the Agent List to the Connection history.

(4) Request Agent icon display
When the request server receives a connection request, the agent that has issued the connection request is added under
the request server. This added agent is referred to as a request agent. The following screen is an example that includes
an added Request Agent icon.
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Figure 4‒50: Example of added Request Agent icon

When the request server stops, the Request Agent icons that were active under the request server are deleted
automatically. The Request Agent icon is active as long as the agent keeps the connection request effective. It
becomes inactive when the connection request is canceled.

A Request Agent icon is a temporary representation of an agent that has issued a connection request. This icon as is
does not represent information that can be saved (the icon will be deleted when the Agent Manager window is closed).
If you want to save information about the agent that has issued a connection request, move the Request Agent icon to
another folder via a drag-and-drop operation. Once you have moved the Request Agent icon to another folder, you
can save the icon as an item in the Agent List. You can also treat the agent as an ordinary agent and can change the
name and description of the agent.

(5) Operations performed to confirm the reception of a connection request
The display of a Request Agent icon is a method used to confirm the reception of a connection request. The following
operations also serve the purpose of this confirmation:

• Beeping

• Bringing the Agent Manager window to the front

• Displaying a pop-up message
The pop-up message is displayed as follows:
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Figure 4‒51: Example of a pop-up message

Name
Displays the host name (IP address if the host name cannot be obtained) of the agent that has issued the
connection request.

Address
Displays the IP address of the agent that has issued the connection request.

Description
Displays the comment that was entered on the agent that has issued the connection request.

Connect
Starts Remote Control Manager, and then connects to the agent that issued the connection request.

The pop-up message will be closed automatically when remote control starts or when the connection request is
canceled. Also, when the agent issued connection requests to multiple connections, the pop-up message automatically
closes when connecting to other controllers. If the controller version is 06-51 or earlier, however, the pop-up message
will not be closed automatically.

It is also possible to start remote control on the agent that has issued a connection request, by activating Remote
Control Manager when the controller receives the connection request. You can configure the request server to perform
the above operation when creating the request server. You can also configure the request server by selecting the
Request Server icon, and then going to the File menu, choosing the Properties menu item, and setting the
information in the displayed Properties dialog box. For further information on these settings, see (2) Request server
attribute settings.

4.4.5 Connecting to an agent

(1) Connection from the Agent Manager window
You can connect to an agent by double-clicking the icon of the agent displayed in the Agent Manager window. From
the agent list, you can also connect from found agents (the agents displayed after a search).

By double-clicking a Request Agent icon, you can connect to the agent that has issued a connection request. This
method can also be used to connect to a request agent that is inactive (whose connection request has been canceled).

When you connect to an agent, the IP address, host name, and path of the agent are recorded in the connection history
of the Agent Manager window and in the address box of the Remote Control window.
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(2) Recording agent paths
In order for the agent path to be recorded to the connection history of the Agent Manager window and to the address
box of the Remote Control window, one of the following conditions must be satisfied:

• Connection options are specified for the agent.

• In the General page of the Agent Manager window's Options dialog box, the When no connection option is
specified on an agent, manage the connection history by IP address check box is cleared.

For information on connection option specification for agents, see 4.4.6 Setting connection options for each agent. For
information on settings in the Options dialog box, see 4.4.9(1) Suppressing operations.

The agent path format is as follows. Observe this format when directly entering an agent path to the address box of the
Remote Control window.

Format
agent-name - \path

• Between agent-name and path, place a space plus a hyphen plus a space as a separator.

• Place a back slash (\) in the beginning of the path. If the path includes multiple folders, place a back slash (\)
between adjacent folders.

Example
If the agent name is test and the path is \development-department\first-group, the correct format is
test - \development-department\first-group

Items to note when establishing connection by specifying an agent path
If you specify an agent path, you can connect to the agent if it is saved in the Agent Manager window. An error
occurs if you specify an agent path that is not registered in the Agent List.
Therefore, when you want to connect to a newly created agent, register the agent in the Agent List and then
attempt to connect to the agent.

4.4.6 Setting connection options for each agent
The remote control facility is likely to be used in an environment where different networks coexist. In some
environments, wide area networks (WAN) and local area networks (LAN) might coexist. In some other environments,
dial-up connection might be required. If agents might exist in such an environment, appropriate connection options,
including an option which specifies whether to use dial-up connection, depend on each agent. However, connection
options concerning agents are set on a controller basis. Consequently, connection options need be set up every time
connection to an agent is established.

If you want to spare time for this, you should use the Properties dialog box to set appropriate connection options
separately for each agent. If you do this, the controller can connect to agents without any changes in the connection
options.

This subsection explains how to set the connection option items and how to pass the connection options. Note that the
connection options can also be set in the Setup page when creating new items such as an agent.

(1) Connection options
The connection options that can be set for each agent are the same as the connection options that are set in the
environment where the controller operates.

For the operating environment settings, you can set connection options from the Properties dialog box's Connection
page, Optimize transaction page, Mode page, and Dial-up page. If the connection options have not been set for each
agent in the Agent Manager window, the connection options of the operating environment are applied.

The following table shows the connection option items and the corresponding operating environment settings, and
provides references to the manual. For details on each connection option, see the description of the corresponding
operating environment setting.
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Table 4‒5: Connection options and corresponding operating environment settings

Agent connection option Corresponding operating
environment setting Reference

Connection Port number Connection page 3.3.1

Perform retry upon connection failure

Reconnect after the agent rebooted

Disconnect from the agent automatically

Optimize
transactions

Data traffic Compress the data to transfer Optimize Transaction
page

3.3.2

Use flow control

Higher level settings

• Specify data size to compress

• Specify polling interval

Optimize Transaction
page,

Higher Level Settings
dialog box

3.3.2(5)

Desktop Do not show the wallpaper Optimize Transaction
page

3.3.2

Do not show the window animation, etc.

Do not show the Active Desktop web page

Do not show window contents while
dragging

Display Reduce bitmap color

Use cache to display bitmaps

Use local font

Mouse Send mouse movement at click in the
window

Remote control mode Control Mode page 3.3.3

Dial-up settings Use dial-up
connection

Retrying dial-up connection Dial-up Settings page,
Details dialog box

3.3.12

Disconnect when the remote control stops

Save authentication information

(2) Setting connection options for one agent

To set the connection options for an agent:

1. Select the agent for which you want to set connection options. Then choose File and then Properties.
The Properties dialog box appears.
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Figure 4‒52: Properties dialog box

2. Select the Set up the connection options check box in the Setup page.
When you select this check box, the setting items of the connection options activate, so that you can set them. If
you clear the Set up the connection options check box, the connection options of the controller will be used. By
default, this is cleared.

3. Make the necessary settings.
For details on the connection options, see (1) Connection options. Depending on the items, settings details are
displayed in the Details field when selecting the setting; so set these details as well.

4. Click the OK button.
The connection option settings are applied to the selected agent. The new option settings will apply to future
connections to the agent.

(3) Setting connection options for multiple agents
If you want to connect to multiple agents with the same conditions, you can batch set the connection options.

To set the connection options for multiple agents:

1. Select agents for which you want to set connection options. Next, choose File and then Properties.
The Properties dialog box appears.
If you select folders or networks along with the agent at this point, all the agents under those icons are subject to
the settings.

2. Click the Update Setup button in the Setup page.
The Update Setup dialog box for setting the connection options appears.

3. Select the Set up the connection options check box.
The setting items of the connection options activate, so that you can set them. The setting method is the same as
when setting individual agents.

4. Make the necessary settings and click the OK button.
The connection option settings are applied to the selected agents.

To batch set the connection options for multiple agents in a folder, select a Folder icon and then perform the same
operation.
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(4) Setting connection options for found agents
You can set specific connection options for agents found on your network. In this case, the connection options are set
to the network used in the search rather than the found agent. You cannot set the connection options for the Found
Agent icon.

To set the connection options of found agents (Connection options can also be set before executing the search.):

1. Select a network and choose File and then Properties.
The Properties dialog box appears.

2. In the Setup page, click the Setup button.
The Found Agent Settings appears.

3. Select the Set up the connection options check box.
When you select this check box, the setting items of the connection options activate, so that you can set them. The
setting method is the same as when setting individual agents.

4. Make the necessary settings and click the OK button.
The connection option settings for found agents are saved. The new connection option settings will be applied to
agents found on your network in the future.

(5) Setting connection options for a request agent
You can set connection options in order to start remote control from a request agent. In this case, the connection
options are set for the request server and not the request agent. You cannot set the connection options for the Request
Agent icon.

To set the connection options of request agents (Connection options can also be set for before receiving a connection
request.):

1. Select a request server. Choose File and then Properties.
The Properties dialog box opens.

2. In the Setup page, click the Setup button.
The Settings for Request Agent dialog box opens.

3. Select the Set up the connection options check box.
When you select this check box, the setting items of the connection options activate, so that you can set them. The
setting method is the same as when setting individual agents.

4. Specify connection options and click the OK button.
Connection options are set up for the request agents connected to this request server.

(6) Inheritance of connection options
Connection options for an agent are inherited as follows.

• If you move or copy an agent, the connection options are inherited by the moved agent or the copy of the agent.

• If you create a subfolder, an agent, or a network below a folder, the connection options for the upper folder are
inherited by the subfolder, the agent, or the network.

4.4.7 Editing the agent list and connection history
The Agent Manager window allows you to perform the following editing operations on the networks, folders, agents,
and separators shown in the window.

(1) Moving and copying
There are three ways to move or copy networks, folders, agents (including found agents and request agent), request
server and separators. You can use any of these methods in the agent list, but only the third method is available in the
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connection history. Note that, when moving or copying a folder, all the data contained in the folder will be subject to
the operation.

1. Drag and drop the item you want to move. (In the Agent List, you can copy items by performing operation while
holding down the Ctrl key.)

2. From the Edit menu, use Cut, Copy, and Paste.

3. From the Edit menu, choose Shift Upward or Shift Downward to move the item upward or downward.

Items to be noted when manipulating an active request server

• When you attempt to cut an active request server, a message is displayed, asking you if you are sure you want
to stop the request server.

• When you move an active request server, the request server will still be active in the destination.

• When you copy an active request server, the copy will be inactive.

(2) Deleting
To delete a folder, agent, request server, or separator, select the icon for the item you want to delete, and press the
Delete key. Alternatively, from the File menu, choose Delete.

When you attempt to delete an active request server, a message is displayed, asking you if you are sure you want to
stop the request server. A similar message is also displayed when you attempt to delete a folder that contains an active
request server.

When a request agent is deleted, the connection request from the agent is canceled.

(3) Changing names (for the agent list only)
You can rename a network, folder, agent, or request server displayed in the agent list.

1. Select the icon of the item you want to rename.

2. Click the name section again. (Alternatively, from the File menu, choose Rename.)
The icon of the folder or file enters the state in which you can change its name.

3. Enter the new name.
The folder or file is renamed.

(4) Changing attributes (for the agent list only)
You can change the name, address (or port number for request servers), and description of the folder, agent, network,
and request server displayed in the Agent List. In addition to these, you can also change the following attributes.

• For folders
You can batch change the attributes of the agents, networks, and request servers in a folder.

• For agents
You can change the connection option.

• For networks
You can change the search method of agents as well as the connection options of found agents.

• For request servers
You can change the attributes of request servers as well as the connection options of request agents.

For details on changing attributes, see 4.4.8 Changing and viewing item attributes.

Note that the attributes for a found agent and request agent cannot be modified. Move it to another folder before
changing its attributes.

(5) Searching by keyword
You can specify a character string as key and search items shown in the Agent Manager window for those containing
the character string in the name, address, or description attributes. If you set multiple keys, the system looks for items
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that match all the keys. However, in the connection history, you cannot specify a key for the description attribute.
(Any such key specified will be ignored.)

To search for items:

1. Select the icon of the item you want to start the search from.
With the selected icon as the starting point, a search is performed downward.

2. From the Edit menu, choose Find.
The Find dialog box appears.

Figure 4‒53: Find dialog box

Name
Set this when searching text while using the name as a key.

Address
Set this when searching text while using the address as a key. This is ignored when searching for folders.

Description
Set this when searching text while using the description as a key. This is ignored when searching for items in
the connection history list.

Target
Specify the item to search for. If you specify Agent, both found agents and request agents are search targets.

Find whole words only
Select this check box to search for items where the name, address, and description exactly match the text
specified in Find.

Match upper- and lowercase
Select this check box to perform case sensitive searches for the text specified in Find.

3. Enter necessary information, and click the Find button.
The Find dialog box closes, and the icon of the first item which satisfies the search conditions will become
selected (highlighted). To continue the search using the same keys, choose Find Next from the Edit menu.
Alternatively, press the F3 key.
When no more applicable items are found, the Search Complete message dialog box appears.

4.4.8 Changing and viewing item attributes
The attributes of folders, networks, and request servers displayed in the Agent List can be changed in the Properties
dialog box.

To change the attributes:

1. Select the item you wish to change the attributes of.
You can batch change the attributes by selecting multiple items.
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2. Go to the File menu and choose Properties.
The Properties dialog box is displayed.

3. Change the settings if necessary.
Depending on how many items are selected, the setting contents will vary.

When selecting one item:
The same setting items as when creating each icon are displayed. From the General page, you can change the
name, address (or port number for a request server), and description. The contents of the Setup page vary
depending on the selected item.

When selecting multiple items:
The General page displays the types of the selected items. From the Setup page, specify whether to change
the attributes of agents, networks, or request servers.

4. Click the OK button.
This changes the attributes. If you selected a folder that contains subfolders or if you selected multiple items, you
will be prompted to specify whether or not you want to change the attributes of the subfolders.

• For folders with subfolders

• When selecting multiple items

Specify whether to update, and then click the OK button.
Select this check box to change the settings of subfolders. Clear this check box if you want to change the settings
of items directly under the selected folder or just the selected items when selecting multiple items.

Note that if you select a found agent or request agent and display the Properties dialog box, you can only view the
attributes. To change the attributes, move the item to another folder and change them.

The following explains the contents of each Properties dialog box.

(1) Changing folder attributes
From the Properties dialog box of a folder, you can change the folder attributes.

(a) General page

You can change the Name and Description here. You can also view the created date of the Folder icon.

You must specify the Name. You can enter up to 260 characters for Name and Description.

(b) Setup page

You can batch change the settings of the agents, networks, and request servers in a folder.
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Figure 4‒54: Setup page (Changing folder attributes)

Clicking the Update Setup button of the item to modify displays the Update Setup dialog box.

Update Setup button for the agent
This displays the Update Setup dialog box of the agent. From this dialog box, you can batch change the
connection options of agents in the folder.
The contents of the Update Setup dialog box are the same as the Setup page of the agent's Properties dialog box.

Update Setup button for the network
This displays the Update Setup dialog box of the network. From this dialog box, you can batch change the agent
search method of networks under the folder.
The contents of the Update Setup dialog box are the same as the Setup page of the network's Properties dialog
box. You can also change the connection options of the found agents from this dialog box.

Update Setup button for the request server
This displays the Update Setup dialog box of the request server. From this dialog box, you can batch change the
attributes of the request servers under the folder.
The contents of the Update Setup dialog box are the same as the Setup page of the request server's Properties
dialog box. You can also change the connection options of the request agents from this dialog box.

(2) Changing agent attributes
From the Properties dialog box of an agent, you can change the agent attributes.

(a) General page

You can change the Name, Address, and Description of the network here. You can also view the created date of the
Agent icon.

You must specify the Name and Address. You can enter up to 260 characters for Name and Description. In the
Address box, set the IP address or host name of the agent.

(b) Setup page

You can change the connection option of the agent. For details on the connection options, see 4.4.6 Setting connection
options for each agent.
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(3) Changing network attributes
From the Properties dialog box of a network, you can change the network attributes.

(a) General page

You can change the Name, Address, and Description of the agent here. You can also view the created date of the
Network icon.

You must specify the Name and Address. You can enter up to 260 characters for Name and Description. In the
Address box, set the IP address or host name of the agent. For Address, specify the network search range for agents.
For details on instructions on specifying the search range, see C.1 Setting the search range.

(b) Setup page

You can change the search method of the agents using the Network icon. For details on changing the search method,
see C.3 Customizing the search method.

You can also change the connection options of the found agents from this dialog box.

(4) Changing request server attributes
From the Properties dialog box of a request server, you can change the request server attributes.

(a) General page

You can change the Name, Port number, and Description of the agent here. You can also view the created date of
the Request Server icon.

You must specify the Name and Port number. You can enter up to 260 characters for Name and Description. For
Port number, specify the port number to use for connecting from the agent. Specify an integer from 0 to 65535. By
default, this is set to 30006.

(b) Setup page

You can change the attributes of the request server. For details on the attributes, see 4.4.4(2) Request server attribute
settings.

You can also change the connection options of the request agents from this dialog box.

(5) Batch change attributes of multiple items
From the Properties dialog box of multiple items, you can batch change the attributes of all the selected items.

(a) General page

The number of selected items is listed by type. You can only view the selected items here; you cannot perform
operations on them.

(b) Setup page

You can batch change the settings of the selected items (agents, networks, and request servers).
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Figure 4‒55: Setup page (Batch change attributes of multiple items)

Clicking the Update Setup button of the item to be modified displays the Update Setup dialog box where the contents
vary depending on the type of the item. The Update Setup button of items that are not selected are not active.

Update Setup button for the agent
This displays the Update Setup dialog box for the agent. From this dialog box, you can batch change the
connection options of the selected agents.
The contents of the Update Setup dialog box are the same as the Setup page of the agent's Properties dialog box.

Update Setup button for the network
This displays the Update Setup dialog box for the network. From this dialog box, you can batch change the agent
search method of the selected networks.
The contents of the Update Setup dialog box are the same as the Setup page of the network's Properties dialog
box. You can also change the connection options of the found agents from this dialog box.

Update Setup button for the request server
This displays the Update Setup dialog box for the request server. From this dialog box, you can batch change the
attributes of the selected request servers.
The contents of the Update Setup dialog box are the same as the Setup page of the request server's Properties
dialog box. You can also change the connection options of the request agents from this dialog box.

(6) Viewing found agent and request agent attributes
In the Properties dialog box of the found agent and request agent, only the General page is displayed. You can view
the attributes (name, address, description, and icon created date) of these agents from here. In the Address box, the IP
address or host name of the agent is displayed.

Note that you cannot change the attributes from the Properties dialog box of a found agent or request agent. To change
the attributes, move the item to another folder and change them.

4.4.9 Customizing operations in the Agent Manager window
You can suppress operations in the Agent Manager window. You can also register executable files so that you can
execute them from the Agent Manager.
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(1) Suppressing operations
In the Agent Manager window you can expand an item by double clicking on it. If you double click on an agent,
however, the Agent Manager window establishes connection to the agent. Also, if you double click on a network, the
Agent Manager searches the network. In these cases, you can prevent erroneous operations if you use the General
page in the Options dialog box to suppress the actions that should be triggered by double clicking the mouse. In the
General page you can also specify the action that should be taken by the Search Agents dialog box when the search
finishes. In the General page you can also make settings on connections using paths to agents.

To suppress actions triggered by double clicking:

1. Select an agent, network or request server. Next, choose Tools and then Options.
The Options dialog box appears.

Figure 4‒56: Options dialog box

Connect by double-click
Specifies whether to connect to an agent by double clicking on it. By default, this check box is selected.

When no connection option is specified on an agent, manage the connection history by IP address
Specifies whether to record in the connection history the address of an agent for which no connection options
are specified when connecting to the agent. By default, this check box is selected.
Clear this check box to record the agent path in the connection history list when connecting to an agent.

Search by double-click
Specifies whether you want to search the network by double clicking on it. By default, this check box is
selected.

Close the Search Agents dialog box when search is completed
Specifies whether to close the Search Agents dialog box automatically when the search of the network finishes
in the Agent Manager. By default, this check box is selected.

Start/stop by double-click
Specifies whether or not double-clicking the request server will start or stop it. By default, this check box is
selected.

2. Make necessary settings in the General page and then click OK.
The Options dialog box is closed. The settings that you made will affect operations on agents, networks or request
server.
If you change the settings for the Search Agents dialog box, the settings in the Search Agents dialog box are also
changed.
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(2) Registering external commands
If you register executable files such as .EXE files and .BAT files (shell) as commands, you can execute them from
the Agent Manager window. For example, you can run the Remote Control Manager from the Tools menu of the
Remote Agent Manager if you register the executable file for the Remote Control Manager.

(a) Registering executable files as commands

To register an executable file as a command:

1. Choose Tools and then Options.
The Options dialog box appears.

2. Click Add in the Tool page.
The Add Tools dialog box appears.

Figure 4‒57: Add Tools dialog box

3. Specify the name of the executable file that you want to register, and then click OK.
The Add Tools dialog box is closed. The Tool page displays the path to and the name of the specified executable
file.

Figure 4‒58: Tool page

Registration list
Displays a list of registered commands. The names set in Menu are displayed.
To add a command, click the Add button. To remove a command, click the Delete button. To change the sort
order of the commands, select a command and then click the Shift Upward or Shift Downward button.

Menu (required)
Specify the command name to be displayed in the menu of the Agent Manager window. Use up to 260
characters for the command name. By default, the name of the executable file (except for the file extension)
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specified in the Add Tools dialog box is displayed. To use a character as an accelerator, add an ampersand (&)
before the character.
For example, if you want to assign R as an accelerator to the Remote Control menu, add (&R) after the menu
name as shown below.

Figure 4‒59: Example of specifying the menu name (when setting an accelerator)

File (required)
Specify the name of the file to be executed with up to 260 characters. If the specified file does not exist or is
not accessible, an error occurs when the tool starts. By default, the full pathname of the executable file
specified in the Add Tools dialog box is displayed.

Argument
Specify the arguments to be passed to the command with up to 260 characters.
The arguments can be information which is set for an item such as an agent or a network. Arguments for
information about each item are defined as JP1/Remote Control reserved words. You can specify these
arguments in the format of $(String). The arguments will be expanded when the command is executed.
Therefore, the arguments that are defined as reserved words cannot be specified as command arguments. The
table below lists the arguments defined as JP1/Remote Control reserved words.

Table 4‒6: Arguments defined as JP1/Remote Control reserved words

Argument Meaning

$(Name) name of an item

$(Address) address of an item

$(Description) (entire) description about an item

$(Description-1) first line of the description about an item

$(Description-2) second line of the description about an item

$(Description-3) third line of the description about an item

$(Description-4) fourth line of the description about an item

$(Description-5) fifth line of the description about an item

$(Description-6) sixth line of the description about an item

$(Description-7) seventh line of the description about an item

$(Description-8) eighth line of the description about an item

$(Description-9) ninth line of the description about an item

You can specify item information arguments by selecting them from the pull-down list that is displayed by
clicking the arrow next to the Argument field.
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Directory
Specify the work directory for the command. If you omit this, the directory for the executable file is assumed.

Agent
Select this check box if you want to validate the registered command when an agent, a found agent, or a
history agent is selected. This check box is selected by default.

Network
Select this check box if you want to validate the registered command when a network is selected. This check
box is selected by default.

Others
Select this check box if you want to validate the registered command when a folder or a separator is selected.
This check box is selected by default.

4. Specify the command name, the argument, items in the Valid item box and other necessary items and click OK.
The specified executable file is registered as a command. The registered command name appears in the Tools
menu.

(b) Checking commands

To check if the registered command runs successfully:

1. Select the object that you want to run the command on. Next, choose the registered command from the Tools
menu.
The command is executed. Note that you must re-register the command with the correct settings if an error
message is displayed and execution is canceled in the following cases:

• the arguments were not expanded correctly

• the specified executable file does not exist or cannot be accessed
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4.5 Recording and playing back the agent screen display
You can use the screen saving facility to save files containing the screens of agents that are under remote control. The
screen saving facility saves screens as still images. The controller can also record the progress (screen display) of
operations performed on agents. You can play back this record.

4.5.1 Overview
When the screen of an agent that is under remote control changes to another screen, this screen transition is recorded
in a file. This file is referred to as a recording file. To play back records in the recording file, use Remote Control
Player, which is a function provided by the controller. If you convert the recording file to an AVI file, you can play
back the AVI file even in an environment where the controller is unavailable. The figure below provides an overview
of recording, playing back, and converting the agent screen display.

Figure 4‒60: Overview of recording, playing back, and converting the agent screen display

The function to record and play back agent screen display can be used for a number of purposes, including the
following:

• Troubleshooting
A certain level of skill and knowledge are required to provide an explanation on how problems occur and to
understand such explanations. If records of actual operations are available and can be played back, explanations
supplemented with such records will be more understandable. The efficiency of troubleshooting will be increased.

• User training
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You can record a sequence of operations used to solve a problem or to run an application. This record can be used
as training material. For example, you can record the procedure of operations for a business application. End users
can play back this record any number of times until they obtain a good understanding of the procedure.

4.5.2 Recording agent screen display
You can record information on the screen of an agent that is connected to the controller. This feature allows you to
pause, then restart recording when desired. Thus allowing you to bypass unnecessary information. The figure below
shows how to record the agent screen display.

Figure 4‒61: Recording agent screen display

(1) Starting and stopping recording
The procedure for recording agent screen display is as follows:

(a) Starting recording

1. In the Remote Control window, open the File menu and choose Record Screen, then Start.
The Select Recording File dialog box appears.

Figure 4‒62: Select Recording File dialog box

If the location and name of the recording file is already set in the operating environment of the controller, this
dialog box is not displayed and the recording of the window information will start immediately. For details on the
settings of recording files, see (4) Settings for efficient recording and 3.3.10 Record page.

2. Setting a recording file.
Specify the location and file name of the recording file. The file extension of the recording file is rcr.

3. Click the Save button.
Starts recording of the agent window information.
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(b) Ending recording

1. From the File menu, choose Record Screen, and then Stop.
Recording stops. The operations performed so far on the agent are saved in the recording file.

(2) Recording status display
A status icon indicating the recording status is displayed on the status bar. This icon helps you check the recording
status. The agent screen display recording status is represented by one of the following three icons.

 Not recording (inactive)

 Recording

 Pause

You can set whether to display the status icons using the Record page in the Properties dialog box. For information on
how to display the status icon, see 3.3.10 Record page. Note that the status icon will not be displayed when you are
not connected to an agent.

(3) Pause and restart
This feature allows you to pause and restart recording as desired. This function is useful for recording only the
necessary screen display.

Pause
In the Remote Control window, open the File menu and choose Record Screen, then Pause. Recording pauses.

Restart
In the Remote Control window, open the File menu and choose Record Screen, then Restart. Recording restarts.

(4) Settings for efficient recording
If you have to select which recording file to use each time you begin recording, the recording efficiency will be low.
Therefore, it is advisable to set, in advance, the location and file name for a recording file that will contain records of
information displayed on screens of an agent. This eliminates the need to select a recording file each time you start
recording. You can also configure the controller to start recording when the agent is connected to the controller. To
make this configuration, use the Record page in the Properties dialog box. For further information about the Record
page, see 3.3.10 Record page.

(a) Setting up a recording file

If you set up a recording file from the Record page in advance, agent screen display will be automatically saved in the
specified recording file. If you specify a fixed recording file name, the recording file will be overwritten with new
information each time recording starts. To avoid this, you must reset the recording file each time you start recording.

If you need to manage one individual recording file for each type of record, you can specify variables to represent a
recording file name you want to use. If you specify variables for a file name, values will be assigned to each variable
to form the appropriate file name when recording starts. You can use the following three variables:

• $(Agent)
The agent name variable. This sets the connection destination (IP address, host name, or other name) specified in
the controller.

• $(Date)
The date variable. This sets the date (format: MM-DD-YYYY) when the recording started.

• $(Time)
The time variable. This sets the time (format: hhmmss) when the recording started. hh is displayed in the 24-hour
format.

You can combine these variables to form a file name. You can also select one of the three default templates.
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Examples of file name specification using variables are provided below. In these examples, it is assumed that the
agent name is 10.xxx.xxx.4, the date is April 1, 2003, and the time is 15:05:45. These settings are
performed in the Select Recording File dialog box that is displayed from the Recording page.

Selecting from the default templates
From the Files of Type list, select a template for the file name.

• If you select AgentName.rcr:
Example: 10.xxx.xxx.4.rcr

• If you select AgentName Date Time.rcr:
Example: 10.xxx.xxx.4 04-01-2003 150545.rcr

• If you select Date Time AgentName.rcr:
Example: 04-01-2003 150545 10.xxx.xxx.4.rcr

Specifying a file name using variables
Use a variable and directly specify the file name.

• If you specify $(Agent) $(Date).rcr:
Example: 10.xxx.xxx.4 04-01-2003.rcr

• If you specify user-name (nnn)_$(Date).rcr:
Example: nnn_04-01-2003.rcr

(b) Configuring the setting to starting recording when connection is established

To start recording when the agent is connected, select the Start recording when connected check box.

4.5.3 Playback
Agent screen display is stored in a recording file. To play back this recording file, use Remote Control Player. The
following figure shows how to play back the agent screen display.

Figure 4‒63: Agent screen display playback

(1) Remote Control Player screen components
You can start Remote Control Player from the controller. When Remote Control Player starts, it automatically begins
playing back the recording file.

The following figure shows the layout of the Remote Control Player window.
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Figure 4‒64: Remote Control Player window

View
The display frame of the Remote Control Player that displays the playback screen. If the playback screen is
smaller than the view, the playback screen is displayed in the center.

Playback Screen
The window for the agent playback.

Status bar
A message indicating the current playback status is displayed on the left. On the right, the play time / recording
time is displayed mm:ss/mm:ss.

Seek bar
Indicates the playback progress. The slider moves from left to right according to the progress of the play.

For details on the Remote Control Player window menus, see A.4 Remote Control Player window menus.

(2) Starting and ending playback
This subsection explains how to start and end the playback of a recording file. Note that if you change the resolution
of the agent during the playback, the playback may not perform correctly.

(a) Start

To play back a recording file:

1. In the Remote Control window, open the File menu and choose Play Screen, then Play.
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The Select Recording File dialog box appears. In this dialog box, you can select the recording file you want to
play back.

2. Select the recording file to be played and click Open.
Remote Control Player starts. It automatically begins to play back the recording file.

The playback status is indicated on the seek bar at the bottom of the Remote Control Player screen. When playback
starts, the slider on the seek bar begins to move from the left end to the right.

Figure 4‒65: Seek bar

If the seek bar is not displayed, open the View menu in Remote Control Player and choose Seek Bar.

(b) Ending playback and exiting Remote Control Player

When the playback of a recording file ends, the slide on the seek bar returns to the right end. The status bar reads
Stop. Remote Control Player is still active.

To exit Remote Control Player, proceed as follows:

• Open the File menu in Remote Control Player and choose Exit.

(3) Playback controls
You might suspend playback in order to give a detailed explanation or play back only the screen display needed to
give a detailed explanation about. Remote Control Player includes a number of controls that can be used to pause, skip
certain display, and restart playback.

(a) Pause and restart

Stop
To stop playback, open the Play menu and choose Stop. Playback stops.

Pause
To pause, open the Play menu and choose Pause. Playback pauses.

Restart
To restart playback, open the Play menu and choose Play. Playback restarts. If you choose Play after a pause,
playback restarts from the position of the pause. If you choose Play after a stop, playback starts at the beginning
of the recording file.

(b) Skip

To skip a part of display, use the seek bar. Select the seek bar slider and moves it to the desired position. Playback will
restart at the position where the slider is released. When you move the slider backward as far as it will go, the slider
automatically returns to the beginning of the recording file.

You can use this function when you are playing back or after you have paused. After you stopped playback, the slider
cannot move (skip).

If you skip during playback, playback restarts at the skip-to position. If you skip during a pause, the pause continues at
the skip-to position.

(c) Changing the playback speed

You can select fast forward or slow forward.

Fast forward
Open the Play menu and choose Fast Forward. Playback resumes at three times the normal speed.
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Slow forward
Open the Play menu and choose Slow. Playback resumes at one-third of the normal speed.

(d) Using toolbar buttons

The toolbar buttons simplify use of the playback controls. The following figure shows the functions of the toolbar
buttons.

Figure 4‒66: Toolbar buttons for playback controls

(4) Making the playback screen more readable and easier to operate
Remote Control Player can display playback screens in a more readable format, similar to the way agent screen
display is displayed in the Remote Control window.

Zoom-in and zoom-out
Open the View menu and choose Zoom, then Automatically. The playback frame zooms in or out automatically
to match the size of the Remote Control Player window. You can also select 50%, 100%, or 200%. For this
purpose, open the View menu and choose Zoom, then 50%, 100%, or 200%. The default percentage is 100%.

Full-screen view
To expand the view to the full screen of the controller, open the View menu and choose Full Screen. To exit the
full-screen display mode, choose Full Screen from the pop-up menu or press Alt + Enter.

Adjusting the Remote Control Player window to the playback frame size
In order to scale the Remote Control Player window to fit to the playback frame, open the View menu and choose
Fit to Frame. The Remote Control Player window is then scaled to fit to the playback frame.

Arranging multiple Remote Control Players
If you are running multiple Remote Control Players, you can arrange the multiple Remote Control Player
windows on the controller screen. To do this, open the Window menu and choose Arrange Vertically, Arrange
Horizontally, or Arrange All.

(5) Checking recording file information
To check the information of the displayed recording file, go to the File menu of the Remote Control Player window
and choose Properties. From the displayed Properties dialog box, you can check the following information.

• Location (the location of the recording file)

• Size

• Connection destination (the IP address, host name, or path of the recorded agent)

• Version (the version of the recorded agent)

• Resolution (the version of the recorded agent)

• Color palette (the color palette (colors) of the recorded agent)

• Recording start time (MM/DD/YYYY hh:mm:ss)

• Recording time (mm minutes ss seconds)
Note that the recording time still displays in minutes when the time exceeds one hour.

4.5.4 Converting to an AVI file
Remote Control Player, a controller-provided facility, is required to play back recording files. This means that
recording files can only be played back in an environment where the controller is available. However, you can convert
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recording files to AVI files, which can be played back in environments where the controller is unavailable. The figure
below shows how to convert recording files to AVI files.

Figure 4‒67: Converting recording files to AVI files

If you convert the recording file to an AVI file, you can edit the file, including the addition of a title and comments, by
using the appropriate applications.

Note that a recording file converted to an AVI file may not play back properly if you change the resolution of the
agent while it is being recorded to the recording file.

Use the conversion wizard to convert to an AVI file. The following subsection explains how to use the conversion
wizard to convert recording files to AVI files.

(1) Select a recording file
First, start the conversion wizard, and then select the recording file to convert.

You can start the conversion wizard by one of the following two methods:

• From the File menu of the Remote Control window, choose Play Screen and then Convert.

• Double click the execution file of the conversion wizard.

The following explains each method.

(a) When selecting from the menu

The following Select Recording File dialog box is displayed.

4. Controller Operations

171



Figure 4‒68: Select Recording File dialog box

Selecting the recording file to be converted and clicking the Open button starts the conversion wizard and displays the
Select AVI File dialog box.

(b) When double-clicking the execution file

The execution file of the conversion wizard (dmrcavcv.exe) is located in the \bin folder of the Remote Control
Manager installation directory. Double-clicking the dmrcavcv.exe file starts the conversion wizard and displays
the following Select Recording File dialog box.

Figure 4‒69: Select Recording File

Selecting the recording file to be converted and clicking the Next button displays the Select AVI File dialog box.

(2) Select an AVI file
In the Select AVI File dialog box, select the location and the name for the recording file to be saved after conversion.
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Figure 4‒70: Select AVI File dialog box

You can either directly enter the AVI file name or you can click the Browse button and set the AVI file name in the
displayed Select AVI File dialog box.

Clicking the Next button displays the Select Compression Type dialog box.

(3) Select a compression type
From the Select Compression Type dialog box, select the compression format to be used when converting the file to
an AVI file.

Figure 4‒71: Select Compression Type dialog box

Compression type
The available compression types vary depending on the installation status of compression logic, the color palette
(colors) of the recording file, and the resolution. By default, the Windows standard compression Microsoft
Video 1 is selected.
Selecting Do not compress will not compress the AVI file.

Clicking the Next button displays the Select Frame Rate and Image Quality dialog box.
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(4) Select the frame rate and image quality
From the Select Frame Rate and Image Quality dialog box, you can set the frame rate (that is, the number of frames
per second) and image quality of the AVI file conversion.

Figure 4‒72: Select Frame Rate and Image Quality dialog box

Frame rate
Specify a value from 1 to 10 as the number of frames per second (frame rate). The default is 2. A higher value will
lead to smoother playback rendering, but require longer time for file conversion and cause the conversion result
file to be larger.

Image quality
Specify a value from 0 to 100 as the desired image quality level. The default varies depending on the selected
compression type.
The default varies depending on the selected compression type.
For the Windows standard compression format, Microsoft Video 1, the default is 75%. If you have selected
Do not compress in the Select Compression Type dialog box, the image quality is fixed to 100%.

Clicking the Next button displays the dialog box that displays the conversion progress.

(5) Conversion process
During the conversion process, the progress (percentage) of the AVI conversion is displayed.
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Figure 4‒73: Now Converting... dialog box

Once the conversion has finished, the Conversion Completed dialog box is displayed.

(6) Conversion completed
From the Conversion Completed dialog box, click the Finish or Play button.

Figure 4‒74: Conversion Completed dialog box

Finish
Exits the conversion wizard.

Play
Launches the application associated with AVI files and exits the conversion wizard. The default player in
Windows is Windows Media Player.
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4.6 Aborting an application or process on an agent that
is running on Windows Me or Windows 98

If an application or process hangs up on an agent that is under remote control, you can use the Remote Control Process
Viewer window displayed on the agent to abort the application or process from a controller. You can also use the
Remote Control Process Viewer window to shut down the Windows system running on an agent from a controller.
You can perform these operations when the agent is running on Windows Me or Windows 98.

This section explains how to abort an application or process on an agent from a controller and how to shut down the
Windows system running on an agent.

4.6.1 How to open and close the Remote Control Process Viewer
window

This subsection explains how to open or close the Remote Control Process Viewer window on an agent.

(1) Opening the Remote Control Process Viewer window
When you choose Send Ctrl+Alt+Del from the Tools menu of the Remote Control window on a controller connected
to an agent that is running on Windows Me or Windows 98, or click the Ctrl+Alt+Del button on the toolbar, the
Remote Control Process Viewer window opens on the agent. Note that the Remote Control Process Viewer window
can be opened only when the remote control mode is Exclusive or Shared.

Figure 4‒75: Remote Control Process Viewer window is opened on the agent

The Remote Control Process Viewer window displays a list of the currently running applications (active windows)
and processes.
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(2) Closing the Remote Control Process Viewer window
You can close the Remote Control Process Viewer window by choosing Exit from the File menu in the Remote
Control Process Viewer window.

If the agent is disconnected from the controller or terminates when the Remote Control Process Viewer window is
active, the Remote Control Process Viewer window will remain open. To close the Remote Control Process Viewer
window, choose Exit from the File menu in the Remote Control Process Viewer window.

4.6.2 Aborting an application running on an agent
You can abort an application that is running on an agent, using the Remote Control Process Viewer window.

To abort an application:

1. Select the Application tab of the Remote Control Process Viewer window.
The Application page displays the currently executing application and its status.

Figure 4‒76: Application page

Application
The names of currently running applications (active windows) are displayed. Note that this list includes only
the applications currently indicated on the taskbar.

Status
The status of the application is displayed.
Running
The application is normally running.
No response
The application does not respond.

2. Select an application you want to terminate.

3. Click the End Application button.
The selected application terminates.
When no application is selected, this button is inactive.
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4.6.3 Aborting a process running on an agent
You can abort a process that is running on an agent, using the Remote Control Process Viewer window.

To abort a process:

1. Select the Process tab of the Remote Control Process Viewer window.
The Process page displays the currently running processes along with their process numbers.

Figure 4‒77: The Process page

Process name
The names of currently running processes are displayed.

PID
The process numbers of the processes are displayed in hexadecimal.

2. Select a process you want to terminate.

3. Click the End Process button.
The following message appears.
When no process is selected, this button is inactive.

4. Click the Yes button.
The selected process terminates.

4.6.4 Shutting down the Windows system on an agent
You can shut down the Windows system on an agent, using the Remote Control Process Viewer window.

To shut down the Windows system:

1. In the Remote Control Process Viewer window, click the Shut Down button.
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The Shut Down Windows dialog box appears.

2. Select a shutdown mode.

3. Click OK.
The Windows system will shut down in the specified mode.

4.6.5 Configuring the Remote Control Process Viewer window
This subsection explains how to refresh the Remote Control Process Viewer window and how to specify a frequency
at which the screen display should be automatically updated.

(1) Refreshing the Remote Control Process Viewer window
In the Remote Control Process Viewer window, choose View and then Refresh. The screen will be immediately
refreshed regardless of the current Update Speed menu setting.

(2) Specifying how often the screen display should be automatically updated
In the Remote Control Process Viewer window, choose View and Update Speed, and then select one of the submenu
items displayed.

High
The screen display will be updated twice a second.

Normal
The screen display will be updated at 2-second intervals.

Low
The screen display will be updated at 4-second intervals.

Pause
The screen display will not be automatically updated.

The default is Normal.
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4.7 Notes on using remote control
This section explains items to be noted when remote controlling an agent from a controller. An explanation is
provided for each agent operating system.

4.7.1 Notes on connecting to an agent other than Windows Me or
Windows 98

(1) Notes on Windows 8, Windows Server 2012, Windows 7, Windows Server 2008,
Windows Vista, Windows Server 2003, Windows XP, Windows 2000, and Windows NT
4.0 agents

• You cannot enter the following commands from the controller keyboard to execute them on the agent: Ctrl+Esc
keys, Alt+Tab keys, and Windows key. Use the action key facility. If the controller is running Windows 8,
Windows Server 2012, Windows 7, Windows Server 2008, Windows Vista, Windows Server 2003, Window XP,
Windows 2000, or Windows NT 4.0 Service Pack 3 or later, open the Properties dialog box, open the Window
page, and select the Send input of the system key check box. You can then send these keyboard commands from
the keyboard to the agent.

• If the agent displays an MS-DOS prompt in full-screen, the controller cannot view the agent screen. Before the
remote control facility can be used, the agent must show an MS-DOS prompt in the window.

• Even if the cursor is shown in color on the agent, it is displayed in black and white on the controller.

• The controller may be unable to view graphic images created on the agent using Direct X (Direct Draw) or
OpenGL.

• Animation generally requires a large volume of data and excessive loads for transmission. Therefore, when the
remote control facility is in use, disable any animation on the agent.

• When the controller attempts to reconnect to an agent that has not recognized the controller's disconnection
operation, the Double Connection dialog box appears. If this dialog box appears, disconnect, then reconnect the
agent.

• If the Use local font check box is selected on the Optimize Transaction page in the Properties dialog box, the
controller cannot correctly render characters that are displayed as rotated on the agent.

• If the agent is configured to start automatically, the encryption function on the agent may be unavailable after you
install Internet Explorer and restart the operating system. In this case, restart the operating system or the agent
again.

• If you install or uninstall Remote Control Agent or if you change devices during Remote Control Agent Setup
operations, be sure to reboot the agent system.

• Use 256 colors or more for the window colors (color palette).

• The agent does not support the multidisplay (multiple monitors) function.

• The Allow service to interact with desktop setting is enabled for the Remote Control Agent service. Do not
disable this setting through Windows Control Panel.

(2) Notes on Windows 8, Windows Server 2012, Windows 7, Windows Server 2008,
Windows Vista, Windows Server 2003, Windows XP, and Windows 2000 agents

• If the agent is configured by opening Control Panel, choosing Mouse, selecting the Pointers tab, and selecting
the Enable pointer shadow check box, the mouse cursor display on the controller is duplicated. The mouse
cursor shape may be different between the controller and the agent. To resolve this problem, use one of the
following two methods.

• On the agent, open Control Panel, choose Mouse, select the Pointers tab, and then clear the Enable pointer
shadow check box.

• On the controller, open the Properties dialog box, go to the Optimize Transaction page, and select the Do not
show the window animation, etc. check box.
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• The mode of the agent will change to the shared mode if one of the following occurs while the agent is in the view
mode:

• The Ctrl + Alt + Delete keys are pressed on the agent.

• A hardware error or system error message is displayed or closed.

• A message from the Messenger service of Windows is displayed or closed.

• While the agent is in the view mode, applications that generate keyboard messages or change key assignments will
not work normally.

• Before you apply blacking out of the agent display when the connected controller is in the exclusive mode,
thoroughly check operation in a test environment. When blacking out of the agent display is specified, the CPU
usage might be displayed as 100% on the agent PC, or an unintended image might remain on the screen at
intervals of a few seconds.

(3) Notes on Windows 7, Windows Server 2008, and Windows Vista agents

• During remote control operations, the Windows Aero features such as translucent windows, Taskbar thumbnails,
and Windows Flip 3D are disabled.

• When you are using a Windows Aero mouse pointer, mouse performance deteriorates during remote control
operation. To prevent deterioration, you must change the mouse pointer design to None.
To change the mouse pointer design to None:

1. Open Control Panel, and choose Hardware and Sound and then Mouse.

2. In the Mouse Properties dialog box, display the Pointers page.

3. In the Scheme list box, select (None).

4. Click the OK button.

(4) Note on Windows 8, Windows 7, and Windows Vista agents

• When the controller has already been connected, it is disconnected if any of the following operations is performed:

• The user logs off.

• The user is switched.

• Console connection is established by using the Remote Desktop Feature.

(5) Note on Windows Server 2012 and Windows Server 2008 agents

• When the controller has already been connected, it is disconnected if any of the following operations is performed:

• The user logs off.

• The user is switched.

• Console connection is established by using the Remote Desktop Feature.

(6) Note on Windows Server 2003 agents

• JP1/Remote Control does not support console connections established by the Remote Desktop Feature of
Windows Server 2003. Once a console connection is executed by the Remote Desktop Feature, an attempt to
connect from the security PC will be rejected. If the controller is already connected, it will be disconnected.
To reconnect the controller, release the lock on Windows Server 2003 at the remote connection destination.

(7) Note on Windows XP agents

• JP1/Remote Control does not support the Windows XP User Switching Feature and Remote Desktop Feature.
When either user switching in Windows XP or remote connection in Windows XP Remote Desktop is executed,
connection requests from the controller will be rejected. If the controller is already connected, it will be
disconnected.
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To reconnect the controller, you must take either of the following actions:

• If connection is rejected due to the User Switching Feature:
Log off all users from Windows XP, and then log on again as the first user.

• If connection is rejected due to the Remote Desktop Feature:
Release the lock on Windows at the remote connection destination.

(8) Notes on Windows NT 4.0 agents

• Some display drivers may cause the mouse cursor to be displayed in duplicate on the controller screen.

• If the controller connects to an agent on which a DirectDraw-based application (such as a Java2 application) is
running, you cannot view the screens of that application from the controller. To solve this problem, terminate the
application and then restart the agent.

(9) Notes on Windows 8 and Windows Server 2012 agents

• Even if you select the Display pointer trails check box (Windows Control Panel - Hardware - Devices and
Printers - Mouse - Pointer Options - Visibility), mouse pointer trails are not displayed on the controller screen.

• Do not disable the following applications from Startup in Task Manager, or some functionality might not run
properly:

• Remote Control Agent

• Remote Control Chat

• Windows 8 charms cannot be displayed by moving the mouse on the controller's screen if you select the Send
mouse movement at click in the window check box on the Optimize Transaction page of the Controller's
Properties.

• If a pointer device (such as a mouse) is not connected to an agent PC, an arrow is always displayed for the mouse
pointer on the controller's screen.

• If a controller connects to an agent in exclusive mode, and the blacked-out screen is set on the agent, pressing Ctrl
+ Alt + Delete from the controller will have no effect while logged in to the agent PC.

4.7.2 Items to be noted when connecting to a Windows Me or Windows
98 agent

• The controller cannot send the Num Lock key to the agent.

• You cannot send the Ctrl + Alt + Delete key operation from the keyboard to the agent. To perform a forced
termination of an application that has hung or to shut down the agent PC, click the Ctrl + Alt + Del tool button in
the Remote Control window.

• You cannot send the Ctrl + Esc or Windows key operation from the keyboard to the agent. Use the action key
facility.

• When the Close Program dialog box appears on the agent, the controller user cannot operate the agent.

• Even if the agent is in the view mode, the controller user cannot inhibit key input for an MS-DOS prompt.

• If the agent displays an MS-DOS prompt in full-screen, the controller cannot view the agent screen. When the
remote control facility is in use, the agent must show an MS-DOS prompt in the window.

• Even if a cursor is shown in color on the agent it will be displayed in black and white on the controller.

• The controller may be unable to view graphics images, created on the agent using Direct X (Direct Draw) or
OpenGL.

• Animation data generally has a large volume of data, and thus places an excessive burden on the network. When
using the remote control facility you should disable any animation on the agent.

• When you connect to an agent while the screen requesting you to enter a network password is displayed, and
execute a reboot/shutdown operation from the controller before actually logging on to the network, the operation
may not be processed correctly. Make sure to perform the reboot/shutdown operation after logging on to the
network.
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• If you change the settings in Color Palette (from the Settings page in the Display Properties dialog box displayed
from Control Panel) of the agent machine, you need to restart the Windows system on the agent machine.
Otherwise, screen colors of the agent will display incorrectly on the controller machine.

• If an application that uses DirectDraw is running on the agent (such as a Java2 application), that application
cannot be viewed from the controller. In this case, first exit the application, and then restart the agent.

• If the controller connects to an agent on which a DirectDraw-based application (such as a Java2 application) is
running, you cannot view the screens of that application from the controller. To solve this problem, terminate the
application and then restart the agent.

• When the controller attempts to reconnect to an agent that has not recognized the controller's disconnection
operation, the Double Connection dialog box appears. If this dialog box appears, disconnect, then reconnect the
agent.

• If the agent is configured to start automatically, the encryption function on the agent may be unavailable after you
install Internet Explorer and restart the operating system. In this case, restart the operating system or the agent
again.

• The mouse operation may not always work in 16-bit applications. When operating 16-bit applications, do not use
the mouse.

• The agent does not support the multidisplay (multiple monitors) function.
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5 Agent Operations
A Remote Control Agent is a remotely controlled system that operates via connection
with a controller. Under normal circumstance, no special operations are required to
perform jobs on agents. However, agents can reject remote control when necessary
and check their connection status. They can also issue connection requests to
controllers rather than waiting for connection requests from controllers.

This chapter describes how to start and exit Remote Control Agent and what kinds of
operations can be performed from the agent side.
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5.1 Starting and exiting Remote Control Agent
This section describes procedures used for starting and exiting Remote Control Agent.

For cautionary notes on using agents, see 4.7 Notes on using remote control.

5.1.1 Starting Remote Control Agent
In the Remote Control Agent setup, specify the automatic startup option, to automatically start Remote Control Agent
at Windows startup. For details on the automatic startup settings, see 3.4.1 Start options.

If you do not select the automatic startup option, or when you want to restart Remote Control Agent after exiting it,
you must use the manual procedure. In the situation, open the Remote Control Agent program folder or the JP1/
Software Distribution's program folder and choose the Remote Control Agent icon to start Remote Control Agent.

When Remote Control Agent starts, the task bar will show the Remote Control Agent icon, or the Status window
appears. The figure below shows the Remote Control Agent icon.

Figure 5‒1: Remote Control Agent icon

For details on how to display the Status window, see 5.1.2 Showing the Status window.

If the display icon setting was not specified during setup, neither the Remote Control Agent icon nor the Status
window appears when Remote Control Agent starts.

In Windows 8, Windows Server 2012, Windows 7 and Windows Server 2008 R2, the Remote Control Agent icon is
not displayed on the taskbar. If you want to display the icon on the taskbar, choose Control Panel, Appearance and
Personalization, and then Customize icons on the taskbar. Next, select Show icon and notifications for Behaviors
for the Remote Control Agent icon.

5.1.2 Showing the Status window
You can extract the Remote Control Agent icon from the task bar, and display it as the Status window. The Status
window normally displays information in the following format. This window can be attached to any of the borders on
the desktop.

Figure 5‒2: Status window

This subsection describes how to display, attach, and exit (store in the task bar) the Status window.

(1) Showing the Status window
Perform the following steps to show the Status window:

1. Right-click the Remote Control Agent icon, and choose Show Menu.

2. In the lower level menu, choose Immediately or If Connected.
Choose Immediately to show the window immediately. Choose If Connected to show the window only when the
agent is connected with the controller.

(2) Attaching the Status window to a desktop border
Perform the following steps to attach the Status window to a desktop border:
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1. Right-click anywhere in the Status window, and choose Embedding Menu.

2. Drag the Status window to a desktop border.
The Status window automatically snaps to the border.

(3) Exiting the Status window
Perform the following steps to exit the Status window:

1. Right-click anywhere in the Status window, and choose Minimize.
The Status window closes and the Remote Control Agent icon appears on the task bar instead.

You can also exit the status window by using the  button.

5.1.3 Exiting Remote Control Agent
Remote Control Agent terminates automatically when Windows on the agent machine is shut down. If you have
manually started Remote Control Agent, it terminates when you log off from Windows.

If you wish to exit Remote Control Agent manually while Windows is still running, right-click the Remote Control
Agent icon or anywhere on the Status window, and choose the Exit menu. Note that, if you have not configured the
environment settings to allow the agent to exit, Remote Control Agent's Exit menu is disabled.

When the status window is displayed, you can also use the  button instead of the menu.
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5.2 Connection requests issued from controllers
Agents perform their functions when they are connected to a controller or controllers. A maximum of 255 controllers
can be connected to one agent at the same time.

This section describes the following operations for the controller:

• Accepting or rejecting connection requests from controllers

• Checking the status of connection with controllers

• Changing the remote control mode

• Disconnecting from controllers

5.2.1 Permitting or rejecting remote control
Upon receiving a connection request from the controller, the agent can permit or reject the connection request. Before
the agent can respond to connection requests from the controller, you must set up the agent so that the Confirm
Connection Request dialog box will appear. For further information about this setting, see 3.4.2 Connection options.

For example, suppose that a connection request comes from the controller when you are editing a confidential
document on the agent. In this case, you can reject the connection request to prevent confidential information from
being sent to the controller. Thus, security is maintained.

When the agent receives a connection request from the controller, the Confirm Connection Request dialog box
appears on the agent.

Figure 5‒3: Confirm Connection Request dialog box

In this dialog box, accept or reject the connection request. If you make no reply, the connection request will be
accepted or rejected automatically based on the setup information. If the agent is not logged on, the agent will always
be connected to the controller.

This function can only be used when the versions of the controller and agent are 06-00 or later.

5.2.2 Checking the connection status
You can use the Remote Control Agent icon or Status window, shown at the Remote Control Agent startup to
ascertain the following information:

• Whether the agent is connected to a controller

• The number of controller units connected

• The agent's remote control mode

The following explains how to check the connection status from the Remote Control Agent icon and the Status
window.
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(1) When the Remote Control Agent icon is shown
The Remote Control Agent icon changes color to represents the connection status with the controller.

 (Gray): Unconnected

 (Red): Connected in view mode

 (Yellow): Connected in shared mode

 (Blue): Connected in exclusive mode

You can also check the connection mode by left-clicking the Remote Control Agent icon and, from the displayed
menu, verifying which of the View, Shared, or Exclusive items has the check mark.

Additionally, if you place the pointer on the Remote Control Agent icon, the number of connected controller units
pops up.

(2) When the Status window is shown
The color of the Status window title bar changes to represent the connection status with the controller. The meaning of
each color is the same as those described in (1) When the Remote Control Agent icon is shown. The title bar also
shows the connection status, mode, and the number of connected controller units.

 (Gray)

Unconnected

 (Red)

Connected in view mode

 (Yellow)

Connected in shared mode

 (Blue)

Connected in exclusive mode

You can also check the connection mode by right-clicking anywhere in the status window and, from the bottom of the
displayed menu, verify which of the View, Shared, or Exclusive items has the check mark.

The number in brackets on the title bar is the number of controllers in the connection destination.

5.2.3 Changing the remote control mode
The agent sets and changes the remote control mode after taking into consideration to what extent the controller
should be allowed to operate it. If the controller sets a higher level of permission than the agent does, the agent's mode
may be modified when establishing a connection. For details on the remote control mode, see 3.1 Remote control
mode.

This subsection describes how to change the remote control mode from the agent side, and also describes the
procedures for forcibly releasing the connection mode when connecting to a controller in the view mode.

(1) Changing the mode
You can change the remote control mode from the dialog box for setting the operating environment. However, the
remote control mode cannot be changed while connected to a controller. First disconnect from the controller before
changing the mode.

You can change the remote control mode from the following:

• Startup options setup page of the Remote Control Agent Setup dialog box

• Start Options page of the Remote Control Agent - Properties dialog box
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After changing the remote control mode from these dialog boxes, exit the agent. The specified remote control mode
will take effect after the agent restarts.

You can also make other changes to the operating environment other than changing the remote control mode from
these dialog boxes. For details, see 3.4 Setting up the operating environment of Remote Control Agent.

(2) Forcibly releasing the view mode
When the agent is in the view mode, you will be unable to perform keyboard and mouse operations on the agent
machine. If you do need to operate the local machine from the agent, forcibly release the view mode and set the mode
to shared.

Perform one of the following operations to forcibly release the view mode.

For Windows 8, Windows Server 2012, Windows 7, Windows Server 2008, Windows Vista, Windows Server 2003,
Windows XP, Windows 2000, and Windows NT 4.0

1. Press the Ctrl + Alt + Delete keys.
The agent enters the shared mode, thus allowing the agent's user to operate the machine.

For Windows Me and Windows 98

1. Press the Ctrl + Alt + Delete keys.
The Close Program dialog box appears.

2. Click Cancel.
The agent enters the shared mode, thus allowing the agent's user to operate the machine.

When the agent's mode changes from view to shared as a result of the above procedures, the controller is notified of
this change.

No changes will appear on the controller in the shared mode; however, on the controller in the exclusive mode, a
dialog box appears, asking whether the mode of the controller can be changed from exclusive to shared.

If the controller's user agrees to the change, the controller assumes the shared mode, thus allowing both the agent and
controller to operate the agent machine. However, if the controller's user rejects the change, the agent reverts to the
view mode, thus preventing the agent's user from operating the local machine.

5.2.4 Disconnecting the controller
This subsection describes the procedure for disconnecting the controller from the agent side. You can either
disconnect controllers on an individual basis, or disconnect all of them in a single operation. The description here
focuses on menu operations, but note that you can also use buttons if the Status window is shown.

In addition, you configure the environment settings to automatically terminate Remote Control Agent when the
connection with the last controller is severed. If the system has not been configured to exit automatically, the agent
will be reconnected if a controller requests another connection.

(1) Disconnecting controllers individually
Perform the following steps to disconnect controllers individually.

1. Right-click the Remote Control Agent icon or anywhere in the Status window, and choose Disconnect.
A list of connected controllers appears at the bottom of the menu.

2. Select the controller you want to disconnect.
The connection with the selected controller will be severed.

When the status window is displayed, you can also use the  button instead of the menu.

(2) Disconnecting all controllers
Perform the following steps to disconnect all the connected controllers.

1. Right-click the Remote Control Agent icon or anywhere in the Status window, and choose Disconnect All.
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Connections with all the connected controllers will be severed.

When the status window is displayed, you can also use the  button instead of the menu.
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5.3 Connection requests issued to controllers
Normally, agents wait for connection requests from controllers. However, agents may sometimes desire remote
control assistance from their controller when they encounter a problem. If this occurs, they can issue a connection
request to the controller. This function requires both the controller and agent to be version 06-51 or later.

You can also issue connection requests from an agent to multiple controllers simultaneously. This helps reduce the
time required to solve a problem because the agent can connect to the controller best able to service your request more
quickly. This setting is convenient in situations such as when you access the help desk.

The following gives details on issuing connection requests to controllers.

5.3.1 Connecting to the controller
To issue one or more connection requests from an agent to one or more controllers, first specify a connection method
using the Requester Wizard. Then, double-click the icon created by the Requester Wizard to issue one or more
connection requests to the desired connector(s).

The procedures for setting the connection method in the Requester Wizard vary depending on the connection method
you specify: using a LAN or a dial-up connection, or importing a settings file.

• Using a LAN connection or dial-up connection
Perform the steps shown in Figure 5-4 using the Requester Wizard.

• Importing a settings file
You can complete specification by importing a settings file that contains the settings required for your connection
request. This method is useful when you plan to issue connection requests from multiple agents to one controller
because the agents can share the settings file.
To create a settings file, use the Requester Wizard to perform the same steps as for a LAN or dial-up connection
(see the figure below), and then export the settings to the settings file.
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Figure 5‒4: Procedure for specifying settings using the Requester Wizard

The Requester Wizard setting procedure is as follows:

(1) Start the Requester Wizard
Choose the Requester Wizard from the JP1_Remote Control Agent or JP1/Software Distribution program folder to
start the Requester Wizard and display the Remote Control - Requester Wizard dialog box.

(2) Select a connection method or import a settings file
Select a method for connecting to the controller, or import an existing settings file.

5. Agent Operations

193



Figure 5‒5: Remote Control - Requester Wizard dialog box (selecting a connection method or importing a
settings file)

Connect by using a LAN.
Select this check box to establish direct connection without using a telephone line or modem. By default, this
check box is selected.
Select Connect by using a LAN and click Next. When the dialog box for setting the request destination is
displayed, proceed to (5) Specify the request destinations.

Connect by using a telephone and modem.
Select this check box to use dial-up connection. By default, this check box is cleared. If no dial-up environment is
available, this check box is inactive.
Select Connect by using a telephone and modem and click Next. When the dialog box for setting the dial-up
connection is displayed, proceed to (3) Specify a dial-up connection point.

Import
Click this button to import a previously created settings file.
Clicking this button displays the Import Settings Information dialog box.

Figure 5‒6: Import Settings Information dialog box

Specify a settings file and then click the Open button to start the import. When the import has finished and the
Requester Wizard Complete window is displayed, proceed to (8) Complete the setup or export the settings.
Note that when you import a settings file, the connection method of the settings file is used regardless of the
selection status of the page.

(3) Specify a dial-up connection point
Specify a dial-up connection point.
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Figure 5‒7: Remote Control - Requester Wizard dialog box (specifying a dial-up connection point)

Connection points
Lists all entries registered in the telephone book that is currently used. Select one connection point. The Next
button remains inactive until you select a connection point.

Add
Adds a new connection point.

Edit
You can edit the settings of the connection point selected from the Connection points list.

Delete
Deletes the connection point selected from the Connection points list.

Clicking the Next button displays the dialog box for specifying the dial-up user.

(4) Specify the dial-up user
Specify the user name, password, and domain name used for the dial-up connection.

Figure 5‒8: Remote Control - Requester Wizard dialog box (specifying the dial-up user)

User name
Specify the user name to be used for dial-up connection. This specification is mandatory.
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Password
Specify the password to be used for dial-up connection.

Domain
Specify the domain name to be used for dial-up connection.

Clicking the Next button displays the dialog box for specifying the request destination.

(5) Specify the request destinations
Specify the address and port number of the controller.

Figure 5‒9: Remote Control - Requester Wizard dialog box (specifying the request destinations)

Address
Specify the host name or IP address that identifies the connection request destination controller. This specification
is mandatory. Up to 260 previously specified addresses are recorded on the pull-down list. You can also select one
of these addresses from the pull-down list.

Port number
Specify a port number for the connection request destination controller as an integer from 0 to 65535. The default
port number is 30006. Up to 260 previously specified port numbers are recorded on the pull-down list. You can
also select one of these port numbers from the pull-down list.

Request to multiple controllers
Select this check box for simultaneous connections to multiple instances of Remote Control Manager
(controllers). Also, click the Settings button to display the Settings dialog box, and then set the multiple managers
as request destinations. For details on the Settings dialog box, see (a) Setup for requests to multiple controllers.

Clicking the Next button displays the dialog box for setting the request time. If the specified port number is beyond
the range of allowed values, an error message is displayed. Respecify an acceptable port number, and then click Next.

(a) Setup for requests to multiple controllers

When simultaneously issuing requests to multiple controllers, go to the Settings dialog box and specify:

• Multiple controllers to connect to

• Priority of the requests
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Figure 5‒10: Settings dialog box

Controller list
This lists the address, port number, and comments of each configured controller.

Add
Click this button to add a controller where you want to issue a connection request. Clicking this button displays
the Setting of Address and Port Number dialog box.

Figure 5‒11: Setting of Address and Port Number dialog box

Specify the address, port number, and comments of the controller to be added. You must specify the address and
port number.

Address
Specify the host name or IP address that identifies the connection request destination controller. The address
must be within 260 characters and must not include spaces.

Port number
Specify a port number for the connection request destination controller as an integer from 0 to 65535.

Comment
Enter comments about the controller that is to be the destination of the connection request.

Edit
Use this button to edit the settings of the connection request destination selected on the Controller list.

Delete
Use this button to delete the connection request destination selected from the Controller list.

Shift Upward
Move the selected connection request destination up one line in the Controller list.

Shift Downward
Move the selected connection request destination down one line in the Controller list.

Request in a random order
Select this check box if you want to issue connection requests to the specified destinations in random order. If this
check box is cleared, connection requests are issued in the order in which the destinations are listed in the
Controller list. This check box is selected by default.

(6) Specify the request time
Set the request time and the settings related to automatic cancellation of the connection request.
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Figure 5‒12: Remote Control - Requester Wizard dialog box (specifying the request time and automatic
cancellation of the connection request)

Request time
The connection request can be canceled automatically if the controller does not respond to the request within the
request time specified here. Specify in the Request time text box the number of seconds that can pass until the
connection request is canceled. Specify an integer from 0 to 9,999. If you specify 0, the connection request will
not be canceled and will remain in effect until the controller responds. The default value is 0.

Exclude responses to requests
This setting is used in the situation where connection requests were issued to multiple Remote Control Managers
and one of the connection requests was fulfilled: i.e., the agent is connected to one of the managers. Select this
check box if you want to cancel any other connection request automatically. This check box is selected by default.

Clicking the Next button displays the dialog box for specifying the notification message.

(7) Specify a notification message
Specify the notification message to be sent to the controller.

Figure 5‒13: Remote Control - Requester Wizard dialog box (specifying a notification message)

Message
Enter a message of 260 or fewer characters to be sent to the controller together with the connection request.
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Enter a message when requesting
Select this check box to enter a message to the controller each time you issue a connection request to the
controller. By default, this check box is not selected.
If you select this check box, the Enter Message dialog box is displayed when you click the Remote Control
Requester icon on the desktop, so that you can enter a message.
For details on the Enter Message dialog box, see (a) Enter a message when requesting.

Click the Next button to display the dialog box to finish the Requester Wizard.

(a) Enter a message when requesting

Clicking the Remote Control Requester icon on the desktop displays the Enter a Message dialog box.

Figure 5‒14: Enter a Message dialog box

Message
Enter up to 260 characters for the message to be sent to the controller. When the Enter Message dialog box opens,
it displays the message entered in the Message area of the Requester Wizard by default.

(8) Complete the setup or export the settings
When you finish the setup in the Requester Wizard, the following dialog box is displayed. From this dialog box, you
can execute the connection request, create a shortcut, or export the settings. Select the operation to be executed.

Figure 5‒15: Remote Control - Requester Wizard dialog box (completing the setup or exporting the
settings)

Select here if you want to request immediately.
Select this check box to issue the connection request immediately after setup finishes in the Requester Wizard. By
default, this check box is selected.
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Select here if you want to create a shortcut. You can execute the requester any time you want by double-
clicking the shortcut on the desktop.

Select this check box to create a desktop shortcut for the connection request after setup finishes in the Requester
Wizard.

This shortcut is created as a Remote Control Requester icon ( ). Double-clicking this icon issues the

connection request specified with the Requester Wizard, to the controller.

Export
Click this button to export the settings you made so far. The settings are exported to a file.
Clicking Export opens the Export Settings Information dialog box.

Figure 5‒16: Export Settings Information dialog box

To save the settings, specify the location, file name, and file type.
The next time the wizard is launched, the directory that you specified last is displayed as the default.
Clicking Save begins exporting the settings to the specified file.
When exporting finishes, you will return to the Requester Wizard Complete window.

After you click the Finish button on the Requester Wizard Complete window, you can either issue a connection
request or create a shortcut.

If the connection request is correctly executed (connection to the controller is successful), the Requester Wizard ends.
The Requester Wizard does not end if the connection request is canceled or if the connection request is not executed
correctly.

5.3.2 Canceling a connection request
When a connection request is issued, a Request icon ( ) is displayed on the task bar.

While the Request icon is displayed, the connection request is being issued to the controller. The cancellation of a
connection request is explained below:

(1) Cancellation from the agent
You can use the Request icon to cancel the connection request. You can cancel all outstanding connection requests or
a specific connection request.

The operation used to cancel one or more connection requests is as follows:

1. Right-click the Request icon. From the Disconnect menu, select the controller you want to disconnect from.
Alternatively, choose the Disconnect All menu.
The specified connection request is canceled. If you have chosen Disconnect All, the Request icon is deleted
from the task bar.

You can also use either of the following methods to cancel a connection request:
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1. Quitting the agent.

2. Logging off the agent machine.

(2) Cancellation from the controller
Connection requests can also be cancelled from the controller. When a connection request is canceled from the
controller, a message dialog box indicating that the request has been cancelled is displayed on the agent

5.3.3 Notes on issuing connection requests
The following are notes related to issuing connection requests to a controller.

(1) Relationship with ordinary connections
You can issue a connection request while activating the agent. Conversely, you can activate the agent while issuing a
connection request. If you issue a connection request from an agent while ordinarily waiting for a connection request
from the controller, both the Agent icon and the Request icon are displayed on the task bar.

(2) Notes on security
On agents, you can specify two types of security -- address authentication (permitted controllers) and user
authentication (user IDs and passwords). However, user authentication is only available when you issue a connection
request from an agent.

5.3.4 Error message issued when an error occurs during connection
request issuance

If an error occurs during connection request issuance, an error message is displayed. The format of the error message
varies depending on the number of connection request destinations.

(1) If you have issued a connection request to one controller
If an error occurs in one connection request, the following error message appears:

(2) If you have issued connection requests to multiple controllers

• If an error occurs in all connection requests issued, the following error message appears:

OK
Clicking this button closes the error message window. If you have issued the connection requests from the
Requester Wizard, the Requester Wizard remains open.
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Details
Clicking this button enlarges the error message window to show details of the errors in the order in which the
connection requests were executed.

In the Status column, Normal or Error is displayed for each connection request. Normal indicates that the
connection request was fulfilled and Error indicates that the connection request encountered an error.

• If any connection request was successful, the following error message appears:

Similar to the Details button in the error message window that is displayed when an error occurs in
all connection requests issued, clicking this button enlarges the error message window to show
details of the errors in the order in which the connection requests were executed.
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6 Using Chat
You can use the chat function to facilitate interaction between the controller and
agent. This chapter outlines the chat function and describes how to use it.

If you want to use the chat function, select the chat component when installing JP1/
Remote control.
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6.1 Overview
When a problem occurs on the agent, the controller operates the agent via Remote Control in order to solve the
problem. In this situation, the use of the chat function can help the agent user identify the cause of the problem and
reduce the time required to solve the problem.

6.1.1 What the chat function can do
The Chat window is used to send and receive chat messages. Messages that are entered in the Chat window are sent to
the destination via the chat server. In a chat environment, therefore, the personal computer that runs the chat server
can be considered the server and a personal computer that is connected to the chat server can be considered a client.
The figure below shows how the chat function is used.

Figure 6‒1: Chat function overview

The chat server can run on both the controller and the agent. This means that chat sessions are not only between a
controller and an agent, but also between controllers and between agents. The chat server can be connected to multiple
Chat windows. In this situation, messages can be sent to a specific user and to all users. The following figure shows an
example of sending a message to a specific user.
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Figure 6‒2: Sending a message to a specified user

The above features of the chat function can be combined to serve the following purposes:

• End user support
When a problem occurs on the personal computer of an end user, the chat function can be used to exchange
detailed information about the problem. This helps reduce the time required to solve complex problems. In
addition, end users can use the chat function to ask the system administrator to assume remote control and notify
the system administrator of their IP addresses.
The chat function is also available when Remote Control is not active. Since simple problems can be solved using
the chat function alone, the chat function helps reduce the network loads imposed by Remote Control. Use of the
chat function in providing instructions and advice will encourage users to improve their skills because they are
personally involved in the problem-solving loop when they execute instructions given via chat sessions.

• User training
The chat function can be used to train users as in the case of a training course in which multiple users share a
single agent to receive training on operations regarding an application. Since all trainees are given the same
instructions, a uniform training quality level can be assured. When trainees raise questions, answers can be sent to
specific users or to all users as required.

6.1.2 Components of the Chat window
The figure below shows the Chat window used for chatting.
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Figure 6‒3: Chat window

1. Chat view
Displays messages that have been sent or received using the chat function.

2. User list box
Lists the users who are connected to the chat server. Chat messages are only sent to the users who selected the
check box in this list. By default, all the users will be recipients (the check box is selected).

3. Message input box
Enter the message to be sent, within 512 bytes.
A history of the messages you entered is kept after the Chat window starts. Therefore, you can select past
messages from the pull-down list. This history is cleared when you exit the Chat window.

4. Send Message button
Sends the message entered in the message input box.

For details on the Chat window menus, see A.7 Chat window menus.

6.1.3 Opening and closing the Chat window
The procedure used to open and close the Chat window is as follows:

(1) Opening the Chat window
The following is the procedure for starting the Chat window.

For Controller
Use one of the following methods:

• In the Remote Control window, choose Tools and then Chat.

• In the JP1_Remote Control Manager program folder or JP1/Software Distribution program folder, choose
the Chat icon.

For Agent
In the JP1_Remote Control Agent program folder or JP1/Software Distribution program folder, choose the
Chat icon.

6. Using Chat

206



(2) Closing the Chat window
To close the Chat window:

• In the Chat window, choose File and then Exit.
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6.2 Setting an operating environment for the chat
function

In a chat environment, the personal computer that runs the chat server is the server whereas a personal computer that
is connected to the chat server is a client. The server operating environment needs to be set on the chat server and the
client operating environment needs to be set in the Chat window.

6.2.1 Chat server operating environment setup
When setting up a chat server operating environment, use the Properties dialog box that is displayed by choosing the
Chat Server icon ( ) on the taskbar.

To set up the chat server operating environment:

1. Start the chat server to display the Chat Server icon.
To manually start the chat server, in the Chat window choose Settings, Chat Server, and then Start Chat Server.
You can also set the chat server to automatically start when the PC starts. For details, see 6.3.1(2) Starting the chat
server.

2. Right-click the Chat Server icon to display the popup menu, and then choose Properties.
The Properties dialog box is displayed.

3. Set up the operating environment in the Properties dialog box.
To save the settings without closing the dialog box, click the Apply button.

4. Click the OK button.
The settings are saved, and the dialog box closes.

In the Properties dialog box, you can specify a chat server connection port number and a connection password.

The settings in each page of the Properties dialog box are as follows:

(1) Connection page
In the Connection page, specify a port number that will be used for the chat session.

Figure 6‒4: Connection page
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Port number
Specify the port number to be used on the chat server as an integer from 0 to 65535. The default port number is
30005.
If you specify a value beyond this range, a message dialog box is displayed, prompting you to respecify the port
number.

(2) Security page
In the Security page, specify authentication-related settings.

Figure 6‒5: Security page

Password

Password
Specify a password that will be used for connection to the chat server, using 14 or less one-byte alphanumeric
characters. The password may be NULL (nothing specified). By default, nothing is displayed on this field.

Re-enter password
For confirmation, reenter the password. If the re-entered password does not match the password specified in
the Password field, a message prompting you to re-enter the password is displayed.

6.2.2 Chat window operating environment setup
When setting up a chat window operating environment, use the Options dialog box. Note that the Options dialog box
includes certain items that cannot be set while the Chat window is connected to the chat server. Therefore, set up an
appropriate operating environment at a time when the Chat window is not connected to the chat server.

To display the Options dialog box:

1. In the Chat window, choose Settings and then Options.
The Options dialog box opens.

The settings in each page of the Options dialog box are as follows. To save the settings without closing the dialog box,
click the Apply button. To save the settings and close the dialog box, click the OK button.
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(1) General page
In the General page, specify user information. While chatting, you can view this information of the user you are
chatting with. This page is inactive when the Chat window is connected to the chat server.

Figure 6‒6: General page

Nickname (required)
Specify a nickname to be used during the chat session, using 260 or less characters. The default nickname is the
current logon name.
Do not include a space or the following characters in the nickname.

Characters that cannot be used in nicknames are:
Question mark (?), double quotation mark ("), slash (/), back slash (\), less-than sign (<), greater-than sign
(>), asterisk (*), vertical bar (|), colon (:), and semicolon (;).

Nicknames must be unique. If a user attempts to connect to the chat server when another user with the same
nickname is already connected, the user receives a message stating that another user with the same nickname
exists and the connection request is rejected.

Name
Specify your name, using 260 or fewer characters. The default name is the name that was specified during user
registration when the system was installed.

Unit
Specify the unit (organization) you belong to. The default unit is the company name that was specified during user
registration when the system was installed.

Email address
Specify your email address, using 260 or less characters.

Comment
Write a comment of 260 or less characters.

(2) Connection page
In the Connection page, specify a port number that will be used for connection.
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Figure 6‒7: Connection page

Port number
Specify the port number to be used by the chat function as an integer from 0 to 65535. Be careful not to use a port
number that is being used by another program. The default port number is 30005.

(3) Notification page
In the Notification page, specify an operation that is to be performed when a chat message is received.

Figure 6‒8: Notification page
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Action

Make the displayed title bar blink
Select this check box to make the title bar display blink when a chat message arrives. By default, this check
box is cleared. When the Chat window is brought to the front, the title bar stops blinking.
This setting is ineffective when the Chat window is already in front of any other window or is iconized.

Display in front of all windows
Select this check box to bring the Chat window to the front of the screen when a chat message arrives. By
default, this check box is cleared.
This setting is ineffective when the Chat window is already in front of any other window or is iconized.

Beep
Select this check box if you want your computer to beep when a chat message arrives. When you select this
check box, you can specify the number of beeps as an integer from 1 to 99. The specified number of beeps
will be emitted at 0.5-second intervals. By default, one beep will be emitted.

Suppress display of the messages

Connection to server
Select this check box if you want to suppress messages that report establishment of connection to a server.
This check box is cleared by default.

Disconnection from server
Select this check box if you want to suppress messages that report disconnection from a server. This check
box is cleared by default.

Joining of a new user
Select this check box if you want to suppress messages that report when a new user joins the chat session. This
check box is cleared by default. If this check box is selected, no message will appear even when another user
joins the chat session. Nor will the action specified on the Action area in the Notification page be performed
even when a chat message is received from another user.

Exit of a user
Select this check box if you want to suppress messages that report exit of other users. This check box is
cleared by default. If this check box is selected, no message will appear even when another user exits from the
chat session. Nor will the action specified on the Action area in the Notification page be performed even
when a chat message is received from another user.

Messages from unselected users
Select this check box if you want to suppress chat messages from users who are not selected in the User list
box. This check box is cleared by default. If this check box is selected, chat messages received from users who
are not selected in the User list box will not be displayed. Nor will the action specified on the Action area in
the Notification page be performed even when a chat message is received from a user who is not selected in
the User list box.

(4) View page
In the View page, specify a message display format.
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Figure 6‒9: View page

View
Specify information to be added to the message. You can change this setting event when you are connected to the
chat server. If you change this setting, the change will not be applied to messages that were issued in the past, but
will be applied to any future messages that will be received.
Messages are displayed in the following format.
date time name@host-name > message
Date

Select this check box to display the message reception date. By default, this check box is selected.

Time
Select this check box to display the message reception time. By default, this check box is selected.

Nickname
Select this check box to display the message sender name. By default, this check box is selected.

Host name
Select this check box to display the host name of the message sender. By default, this check box is cleared.

Message format
Specify a message format.

Display message on one line.
Select this option to display the message on one line. If the message is longer than the chat view area, you can
see the message using the scroll bar. By default, this option is not selected.

Wrap text in displayed messages.
Select this option to wrap around the message lines so that the entire message can be fit within the chat view
area. By default, this option is selected.

Fonts
Specify message display fonts.

Received message
Specify a font for received messages. For this specification, use the Fonts dialog box, which is displayed when
you click the Received message button. The default font is as follows:

• Font: MS Sans Serif

• Points: 9
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• Color: Blue

The currently selected font is displayed to the right of Received message. However, the Color setting is not
displayed.

Send message
Specify a font for messages to be transmitted. For this specification, use the Fonts dialog box that is displayed
when you click the Send message button. The default font is as follows:

• Font: MS Sans Serif

• Points: 9

• Color: Black

The currently selected font is displayed to the right of Send message. However, the Color setting is not
displayed.

(5) Window page
In the Window page, specify a display format for the Chat window.

Figure 6‒10: Window page

User list box area

% of size of the entire window
Specify the size of the User list box to the size of the entire Chat window as a percentage from 10 to 90%. The
default percentage is 25%. The new size is saved, and applied the next time the Chat window opens.
You can also change the User list box size by using the mouse.

Message input box

Use the auto-complete function
Select this check box to use the auto-complete function when entering messages. By default, this check box is
cleared.
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6.3 Starting and ending a chat session
A chat session can be started from the controller or from the agent.

This section explains how to start and end a chat session and send messages.

6.3.1 Starting a chat session
A chat session can be started when one of the following conditions is satisfied.

• The Chat window is connected to another chat server.

• The chat server is opened and is available for connection from another Chat window.

The chat starting method is explained below.

(1) Connecting to the chat server
The Chat window can connect to one or multiple chat servers. However, when a chat server is active, it cannot be
connected to another chat server. Connect an inactive chat server to another chat server.

To connect to a chat server:

1. Open the Chat window on the controller or agent.
For additional information on opening the chat window, see 6.1.3 Opening and closing the Chat window. The
Chat window behavior may vary depending on whether it is started from the Remote Control window on the
controller or from the appropriate program folder.

Starting from the Remote Control window
If the chat server is connected to an active agent, it is automatically connected to the chat server for the agent.
If the chat server is not connected to any agent or is connected to an inactive agent, only the Chat window
opens. Accordingly, the operation for connection to the chat server must be performed as explained in step 2
below.

Starting from the program folder
Since connection to the chat server has not been established, connect to the chat server by performing the
operation shown in step 2 below.

2. In the Chat window, choose File and then Connect.
The Specify Connection Destination dialog box is displayed. Use this dialog box to specify a chat server.

Figure 6‒11: Specify Connection Destination dialog box

Address
Specify the IP address or host name of the target chat server. Do not include space characters in the address.
Up to 256 addresses are kept in a history. Therefore, you can select an address from the pull-down list for the
second and subsequent connections.

3. Specify the address of the chat server to be connected and click the OK button.
Connection to the specified chat server is established. The chat view displays a message stating that you are now
connected to the chat server and you can start the chat session.
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If the specified address includes a space or identifies a chat server that is already connected, an error occurs. If this
occurs, re-specify the connection destination address. If a password is set for the destination chat server, the Enter
Password dialog box is displayed.

Figure 6‒12: Enter Password dialog box

4. Enter a password and click the OK button.
If you enter the correct password, you are connected to the chat server. Otherwise, an error occurs. If this occurs,
enter the password again. You can attempt password entry three times. If you fail to enter a correct password three
times in succession, you will be disconnected. Retry connection from the Chat window.

(2) Starting the chat server
When the chat server starts, the Chat window begins to work as the chat server. While the chat server is active, the
Chat Server icon is displayed on the taskbar. Message transmission and reception operations in the Chat window are
similar to operations on the client.

The chat server can be started automatically or manually. Select the method most suitable for the particular situation --
for example, automatic startup of a chat server that is used for chatting on a help desk.

(a) Automatic startup

You can make a chat server resident on the personal computer by specifying automatic startup of the chat server. If the
personal computer is a controller, register the chat server as a program that will start when Windows starts. If the
personal computer is an agent, register the chat server as a program that will start when the agent starts or as a
program that will start when Windows starts.

Registering the chat server as a program that will start when Windows starts
To register the chat server as a program that will start when Windows starts:

1. Start the Chat window on the controller or agent.

2. From the Settings menu, choose Chat Server and then Start When Windows Starts.
A shortcut for Remote Control Chat Server is then added to the user's Startup group. The chat server will
automatically start when the personal computer is logged on next time.

Starting the chat server automatically when the agent starts
When setting up JP1/Remote control, you can specify the chat server as a program that will start automatically
when the agent starts. You can also use the Properties dialog box for this specification. In the Chat page, select
the Start the server when the agent starts check box. For further information about the setting, see 3.4.7 Chat
server settings.

(b) Manual startup

To start the chat server manually:

1. Start the Chat window.

2. From the Settings menu, choose Chat Server and then Start Chat Server.
The chat server starts and the Chat Server icon is displayed on the taskbar.

You can prevent an iconized chat server from being displayed on the taskbar. Since the Chat Server icon is still
displayed though it is not displayed on the taskbar, the chat server will be redisplayed when the icon is double-clicked.
When another Chat window is connected to the chat server, the chat server will pop up automatically.

The operation used to prevent an iconized chat server from being displayed on the taskbar is as follows.

1. In the Chat window, choose Settings, Chat Server, and then Hide When Minimized.
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(c) Function of a Chat window that is automatically started on the agent

A chat server that is automatically started on the agent is different from a manually started chat server in the following
areas:

• The following menu items are unavailable (inactive) in the Chat window:

• Connect in the File menu

• Disconnect in the File menu

• Chat Server in the Settings menu

• You can always change the settings on the General page in the Options dialog box.

• When one of the following operations is performed, the Chat window closes and its icon is not displayed on the
taskbar. The Chat window will be redisplayed when you double-click the Chat Server icon or a message arrives.

• Choosing File and then Exit

• Clicking the x button on the title bar

• Iconizing the chat server

(3) Starting a chat session using a command
The procedure used to start a chat session using a command is as follows:

Format
dmrcchat.exe [/nick:nickname]
             [/client | /server]
             [/port:port-number]
             [/connect:connection-destination-address]

Parameters

/nick:nickname
Specify a nickname. If you omit this specification, the previously specified nickname is assumed. If no
nickname has been specified, the current login name is assumed.
This parameter is valid when /client is specified.

/client | /server
Specify whether the personal computer will function as a server or client. If you omit this specification, /
client is assumed.

• /client
The command will open the Chat window.

• /server
The command will start the chat server.

/port:port-number
Specify a port number. If you omit this specification, the previously specified port number is assumed. If no
port number has been specified, the default value 30005 is assumed.

/connect:connection-destination-address
Specify a connection destination address. If you omit this specification, the command will not establish
connection, but simply opens the Chat window or starts the chat server.

Example
Open the Chat window and connect to a chat server 172.17.11.192 with a nickname of Guest via a port
number 30005.
dmrcchat.exe /client /nick:Guest /connect:172.17.11.192 /port:30005

6.3.2 Sending a chat message
When the Chat window is connected to a chat server, you can start a chat session. The chat view area displays a
message stating that the Chat window is connected to a chat server.

6. Using Chat

217



To send a chat message:

1. Enter a message in the Message input box in the Chat window.
You can enter up to 512 bytes for one message. You can also use the pull-down list to select from a number of
standard and saved messages that have been entered in the Chat window.

2. From the User list box, select the user you want to send the message to.
The User list box displays a list of the users who are connected to the chat server. The message will be sent only to
the users whose check boxes are selected. By default, the check boxes of all users are selected.

3. Choose File and then Send Message (or click the Send button in the Chat window or press the Enter key).
The message is sent to the selected users.

6.3.3 Ending a chat session
The method used to end the chat session depends on whether the personal computer has been active as a chat server or
as a client, as follows:

• Chat server

• Close the Chat window.

• Exit the chat server.

• Client

• Close the Chat window.

• Disconnect from the chat server.

These methods are explained below:

(1) Closing the Chat window

To close the Chat window:

1. Choose File and then Exit.
The Chat window closes. In the following conditions, a message is displayed. Take action as appropriate for the
situation.

• If chat messages have not been saved, a message is displayed, asking you to specify whether to save the chat
messages. For details on how to save chat messages, see 6.4.2(1) Saving.

• If the chat server is active, a message is displayed, asking you if you want to terminate the chat server.

(2) Terminating the chat server

To terminate the chat server:

1. Choose Settings, Chat Server, and then Start Chat Server.
The chat server ends and the Chat window becomes inactive.

(3) Disconnecting from the chat server

To disconnect from the chat server:

1. Choose File and then Disconnect.
The personal computer is disconnected from the chat server. If it is connected to more than one chat server, the
Specify Disconnection Server dialog box is displayed, asking you to select the chat server(s) you want to
disconnect from.
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Figure 6‒13: Specify Disconnection Server dialog box

2. Select the chat server(s) you want to disconnect the personal computer from.
To disconnect a chat server, select the currently connected chat server from the Address list box.

3. Click the OK button.
The personal computer is disconnected from the selected chat server(s). If the disconnection has been normal, the
Chat window displays a message stating disconnection from the chat server. If the personal computer is
disconnected from all chat servers that it has been connected to, the Chat view, User list box, and Message input
box in the Chat window become inactive.
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6.4 Operations in the Chat window
This section explains operations that can be performed in the Chat window except for message transmission and
reception operations.

6.4.1 Checking detailed user information
You can review detailed information about users who are connected to the chat server.

To check detailed user information:

1. In the Chat window, select a user from the User list box.

2. Choose File and then Properties.
The Properties dialog box opens. The title section displays the applicable user's nickname and PC host name in the
format "nickname@host-name".

Figure 6‒14: Properties dialog box

Nickname
Displays the user's nickname.

Name
Displays the user's name. If the user has not specified his/her name, this field is blank.

Unit
Displays the organization to which the user belongs. If the user has not specified his/her department
information, this field is blank.

Email address
Displays the user's email address. If the user has not specified his/her email address, this field is blank. To
send email to this user, click this email address.

Comment
Displays the user's comment. If the user has not specified a comment, this field is blank.

3. Check the displayed information and then click the OK button.
The Properties dialog box closes.
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6.4.2 Saving and printing chat messages
You can save chat messages in files and print them. The procedure used to save and print chat messages is as follows:

(1) Saving

1. Choose File and then Save.
The Save As dialog box opens.

2. Specify the path, file name, and file type.
For the file type, select one of the following three file types:

Text file (*.txt)
Saves the chat contents in a text-format file. All information displayed in the chat view is saved.

Rich text file (*.rtf)
Saves the chat contents in a rich-text-format file. All information displayed in the chat view and its format
information (fonts and colors) are saved.

All files (*.*)
Saves the chat contents in a text-format file. You can specify any file extension.

3. Click the Save button.
The chat messages are saved in a file with the specified file name.

If you save chat messages, continue the chat session, and exit without saving the updated chat messages, a message is
displayed, prompting you to save the chat messages.

(2) Printing

1. Choose File and then Print.
The Print dialog box opens.

2. Specify the necessary parameters such as the output printer and number of copies.
The print range is fixed to All.

3. Click the OK button.
The contents of the Chat view area are printed as specified by the parameters.

6.4.3 Starting Remote Control Manager
If the personal computer is a controller, you can start Remote Control Manager from the Chat window.

To start Remote Control Manager:

1. From the User list, select the user you want to connect to.

2. Choose Tools and then Remote Control.
Remote Control Manager starts and connects to the personal computer of the specified user.
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6.5 Chat Server icon operations
When the chat server starts, the Chat Server icon is displayed on the taskbar. In Windows 8, Windows Server 2012,
Windows 7 and Windows Server 2008 R2, the Remote Control Agent icon is not displayed on the taskbar. If you
want to display the icon on the taskbar, choose Control Panel, Appearance and Personalization, and then
Customize icons on the taskbar. Next, select Show icon and notifications for Behaviors for the Remote Control
Chat icon.

Figure 6‒15: Chat Server icon on the taskbar

You can perform the following operations using the Chat Server icon:

• Checking the users who are connected to the chat server

• Disconnecting from chat users

• Setting properties

6.5.1 Checking the users who are connected to the chat server
You can perform the following operation to check the users who are connected to the chat server. However, this
operation is unavailable if no user is connected to the chat server (the menu item is inactive).

1. Right-click the Chat Server icon on the taskbar. From the displayed menu, choose User.
The connected users are listed in the format of nickname@host-name. The figure below shows an example of a
user name list.

Figure 6‒16: Example of a user name list displayed form the Chat Server icon

6.5.2 Disconnecting from one or more chat users
You can disconnect the chat server from all currently connected users or selected users.

To disconnect the chat server:

1. Right-click the Chat Server icon on the taskbar. From the displayed menu, choose Disconnect.
The Specify Disconnection Server dialog box opens.
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Figure 6‒17: Specify Disconnection Server dialog box

2. Specify the user to be disconnected.
From the User list box that displays the currently connected users, select the user to be disconnected. You can
select multiple users.

3. Click the OK button.
The chat server is disconnected from the specified users. In the Chat window on each disconnected user's
machine, a message is displayed, stating that the user's machine has been disconnected from the chat server.

6.5.3 Setting properties
You can specify a port number and a password for the chat server. Use the Properties dialog box to specify chat server
properties. You can open the Properties dialog box by right-clicking the Chat Server icon and choosing Properties
from the displayed menu.

For further information on the settings, see 6.2.1 Chat server operating environment setup.
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A. Menus
This section describes the menus displayed in each JP1/Remote Control window and the status window of the agent.

A.1 Remote Control window menu
The following subsection displays the menus of the Remote Control window. There are two types of menus:

• Menus displayed from the menu bar

• Menus displayed from the agent buttons

(1) Menus displayed from the menu bar of the Remote Control window
The table below lists the menu items displayed from the menu bar of the Remote Control window.

Table A‒1: Remote Control window menu

Menu bar Menu item Description

File Connect Connects to an agent. If an agent is already connected, a new
Remote Control window opens for connection.

Reconnect Reconnects to an agent previously connected.

Disconnect Disconnects from the selected agent.

Search Searches agents on the network.

Save Screen Saves the agent screen display.

Record
Screen

Start Executes recording-related operations on the agent screen display.

Starts recording the agent screen display.

Pause/Restart Pauses/restarts recording the agent screen display.

Stop Stops recording the agent screen display.

Play Screen Play Executes playback-related operations on the agent screen display.

Plays back the agent screen display.

Convert Converts the file containing the agent screen display to an AVI
file.

Terminate Terminates the Remote Control Manager.

Terminate All Terminates all running Remote Control Managers.

View Toolbar Toolbar Displays/hides the toolbar.

Address Bar Displays/hides the address bar.

Button Text Labels Displays/hides the description of the tool buttons.

Customize Customizes the toolbar, allowing selecting the types of buttons to
be displayed and changing the arrangement.

Status Bar Status Bar Displays/hides the status bar.

Elapsed Time Displays the time which has elapsed since the agent connection is
established.

Transferred Data Displays the number of data items transferred to or from the agent.

• Sent
Displays the number of sent data items.
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Menu bar Menu item Description

View Status Bar Transferred Data • Received
Displays the number of received data items.

Show Data Transfer Status
Icon

Displays/hides the icon indicating the status of data transfer with
the agent.

Show Ctrl/Alt Key Status Displays/hides the icon indicating whether the Ctrl and Alt keys
are pressed at the agent.

Action Keys Displays the registered action keys at the bottom of the screen.

Refresh Updates the agent screen to the current status.

Zoom Cancel Returns the enlarged or reduced agent screen to the original size.

Zoom Out to Fit Reduces the agent screen to fit the Remote Control window.

Auto-zoom Automatically enlarges or reduces the agent screen to fit the
Remote Control window.

Full Screen Displays the agent screen using all the area of the controller
screen.

Tools Properties Enables you to set the operating environment for the Remote
Control Manager.

Control Mode View Selects the View mode.

Shared Selects the Shared mode.

Exclusive Selects the Exclusive mode.

Shut Down Shuts down the agent.

If the agent's version is 06-71 or later and the agent's PC has the
power-off functionality, you can turn off the agent after shutting it
down.

Reboot Reboots the agent.

Send Ctrl+Alt+Del Sends the Ctrl+Alt+Delete key operation to the agent.

If a Windows 8, Windows Server 2012, Windows 7, Windows
Server 2008, Windows Vista, Windows Server 2003, Windows
XP, Windows 2000, or Windows NT 4.0 agent is connected, the
Ctrl+Alt+Delete keys are entered on the agent.

If a Windows Me or Windows 98 agent is connected, the Remote
Control Process Viewer window appears.

Transfer Clipboard Data Transfers data between clipboards.

Transfer File Displays the File Transfer window.

Chat Displays the Chat window.

Agent Add to List Adds the currently connected agent to the agent list and
connection history.

Change List Displays the Agent Manager window to edit the agent list.

Window Arrange Horizontally Displays multiple Remote Control windows horizontally.

Arrange Vertically Displays multiple Remote Control windows vertically.

Arrange All Tiles the Remote Control windows uniformly in the vertical and
horizontal directions.

Minimize All Minimizes all Remote Control windows to icons.

Help Contents Displays the contents of the JP1/Remote Control online help.
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Menu bar Menu item Description

Help Version Displays the version of JP1/Remote Control Manager.

(2) Menus displayed from the agent buttons
The table below lists the menu items (agent menu) displayed from the Agent buttons.

Table A‒2: Agent menus

Menu item Description

Add to List Adds the currently connected agent to the agent list.

Change List Displays the Agent Manager window.

A.2 File Transfer window menus
This following subsection displays the menus of the File Transfer window and the file transfer list window.

(1) File Transfer window menus
The table below shows the menu items of the File Transfer window.

Table A‒3: File Transfer window menus

Menu bar Menu item Description

File Open Opens the selected folder or file.

New Folder Creates a new folder.

Delete Deletes a selected folder or file.

Rename Changes the name of a selected folder or file.

Properties Changes the attributes of the selected folder or file.

Disconnect Terminates file transfer connection to the agent.

End Exits from the File Transfer window.

Edit Register for Copying Registers a file to be copied.

Register for Moving Registers a file to be moved.

Transfer Files Starts file transfer.

Select All Selects all items in the selected drive or folder.

Switch Reverses the selected items and unselected items.

Confirm Files File List Views information about a file registered for copying or moving.

Selected File Views information about a selected file.

Customize Executes customized transfer.

View Toolbar Displays the toolbar.

Status bar Displays the status bar.

Large Icons Displays folders or files in the list area using large icons.

Small Icons Displays folders or files in the list area using small icons.

List Displays folders or files in the list area in a list format.
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Menu bar Menu item Description

View Details Displays folders or files in the list area with details (name, size,
updated date, and attribute).

Parent Folder Displays the contents of the parent folder of the currently
displayed folder.

Refresh Updates the information displayed in the File Transfer window to
the latest information.

File Transfer List Displays the file transfer list window.

Other Options Enables you to set options related to the display of the File
Transfer window and how to transfer files.

Help Contents Displays the contents of the JP1/Remote Control online help.

Version Displays the version of JP1/Remote Control Manager.

(2) File transfer list window menus
The table below shows the menu items of the file transfer list window.

Table A‒4: File transfer list window menus

Menu bar Menu item Description

File Delete Deletes a file saved in the controller.

Automatically Close Specifies whether the file transfer list window is automatically
closed when all the files are deleted from the file transfer list
window.

Close Closes the file transfer list window.

Edit Transfer File Copies a file to the original location in the agent.

Delete After Transfer Moves a file to the original location in the agent.

Select All Selects all the files in the list view.

Switch Toggles the selection status of the selected items and the
deselected items.

View Refresh Updates the display of the list view.

Help Contents Displays the help contents.

Version Displays the version information.

A.3 Agent Manager window menus
The table below shows the menu items of the Agent Manager window.

Table A‒5: Agent Manager window menus

Menu bar Menu item Description

File New Folder Creates a new folder.

Agent Creates a new agent.

Separator Inserts a separator.

Network Creates a network used to define an agent search range.

Request server Creates a new request server.
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Menu bar Menu item Description

File Import From System File Creates an agent list by importing data from a backup file.

Hosts File Creates an agent list by importing data from a hosts file.

Start Starts the selected request server. This menu command is
displayed only when you select an inactive request server.

Stop Terminates the selected request server. This menu command is
displayed only when you select an active request server.

Connect# Connects to a selected agent. This item is not displayed when a
network or request server is selected.

Search Searches for an agent machine according to the settings for a
selected network. This item is displayed only when a network is
selected.

Delete# Deletes a selected item.

Rename Changes the name of a folder, agent or request server.

Properties Displays the properties of a folder, agent or request server,
enabling you to modify them.

Save# Saves the current configuration information into a default backup
file.

Save As Saves the current configuration information into a file named by
the user.

Close Closes the Agent Manager window.

Edit Undo# Cancels the deletion, movement, or modification of data.

Cut Cuts a selected item.

Copy Copies a selected item.

Paste Pastes a cut or copied item to the agent list.

Select All# Selects all items in the selected folder.

Switch# Reverses the selected items and unselected items.

Shift Upward# Moves a selected item one line up.

Shift Downward# Moves a selected item one line down.

Find# Enables you to specify a keyword used to search for an agent in
the Agent Manager window.

Find Next# Searches for an agent in the Agent Manager window using a
keyword.

View List Agents Displays the agent list.

History Displays a connection history to agents.

Toolbar Displays tool buttons.

Status bar Displays the status bar.

Word Wrap# Displays a selected item so that it wraps around.

Separate# Lines Displays separators in line units. You can simultaneously display
column separators.

Rows Displays separators in column units. You can simultaneously
display line separators.
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Menu bar Menu item Description

View Highlight Selected Line# Highlights all sub-items (address, description, and created date/
time) of a selected item.

Adjust Column Position Displays sub-items (address, description, and created date/time) so
that they are accommodated within the window.

Tools Options Customizes operations in the Agent Manager window.

Help Contents Displays the contents of the JP1/Remote Control online help.

Version Displays the version of JP1/Remote Control Manager.

#
These items are available for both the agent list and connection history. Other items are available only for the agent list.

A.4 Remote Control Player window menus
The table below shows the menu items of the Remote Control Player window.

Table A‒6: Remote Control Player window menus

Menu bar Menu item Description

File New Starts a new Remote Control Player.

Open Selects a recording file to play.

Properties If a recording file is open, displays information about that
recording file.

Exit Exits Remote Control Player.

Play Play Starts playing again after being paused or stopped.

Pause Temporarily pauses.

Stop Stops playing.

Fast Forward Fast forwards a recording file.

Slow Plays a recording file in slow motion.

View Toolbar Displays/hides the toolbar.

Status Bar Displays/hides the status bar.

Seek Bar Displays/hides the seek bar.

Zoom Automatically Automatically zooms in/out the screen playback so that it fits in
the Remote Control Player window.

50% Reduces the size of screen playback window by 50%.

100% Displays the screen playback window in actual size (100%).

200% Enlarges the size of screen playback window by 200%.

Full Screen Displays the view in full screen at the controller.

Fit to Frame Fits the Remote Control Player window in the screen-playback
window.

Window Arrange Horizontally Arranges the Remote Control Player windows horizontally from
top to bottom.

Arrange Vertically Arranges the Remote Control Player windows vertically from left
to right.
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Menu bar Menu item Description

Window Arrange All Arranges all Remote Control Player windows uniformly.

Minimize All Minimizes all Remote Control Player windows.

Help Contents Displays the online help for JP1/Remote Control Manager.

Version Displays version information.

A.5 Remote Control Process Viewer window menus
The table below shows the menu items of the Remote Control Process Viewer window.

Table A‒7: Remote Control Process Viewer window menus

Menu bar Menu item Description

File Exit Exits the Remote Control Process Viewer window.

View Refresh Refreshes the screen to reflect the most recent status.

Update Speed High Refreshes the screen twice per second.

Normal Refreshes the screen once every two seconds.

Low Refreshes the screen once every four seconds.

Pause Does not refresh the screen display automatically.

Help Version Displays the version information about JP1/Remote Control
Agent.

A.6 Status window menus (agent)
The table below shows the menu items of the status window of the agent. These menu items pop up when you right-
click anywhere in the status window.

Table A‒8: Status window menus (agent)

Menu item Description

Minimize Reduces the status window to an icon and stores it in the task bar.

Embedding Menu Enables you to embed the status window into any edge of the desktop.

Always on Top Keeps the status window being displayed on top of all other windows.

Auto Hide When the status window is embedded, hides the status window when the pointer is not located
in it.

Disconnect All Disconnects all controllers.

Disconnect Disconnects a selected controller.

Mode Displays the current remote control mode. You can change the mode if a controller is not
connected.

Properties Enables you to set the operating environment for Remote Control Agent.

Version Displays the version of JP1/Remote Control Agent.

Cancel Closes the menu.

Exit Terminates Remote Control Agent.
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A.7 Chat window menus
The table below shows the menu items of the Chat window.

Table A‒9: Chat window menus

Menu bar Menu item Description

File Connect Establishes a connection with the chat server. Even if you are
already connected with a chat server, you can establish a
connection with another chat server.

Disconnect Disconnects from the current chat server.

Properties Displays detailed information about the user that is currently
selected in the user list box.

Send Message Sends a chat message in the message input box.

Send Beep Causes another chat user's PC that is currently connected to beep
once.

Save Saves the current chat contents in the same file.

Save As Saves the current chat contents in a new file.

Print Prints the current chat contents.

Print Preview Previews the current chat contents to be printed.

Exit Exits the Chat window. Connection with the chat server is
automatically terminated.

Settings Chat Server Start Chat Server Toggles the chat server start/stop setting. When the chat server is
active, this option is selected.

Hide When Minimized If the window is minimized during the start of the chat server,
hides the window from the taskbar. When the window is
minimized, this option is selected.

Start When Windows Starts Registers or removes the chat server in the Windows startup
group. If you register the chat server in the Windows startup
group, this option is selected.

Options Setting a chat window operating environment.

View Toolbar Turns on/off the toolbar display.

Status Bar Turns on/off the status bar display.

Tools Remote Control Starts the Remote Control Manager. This option is disabled in the
Chat window that was opened at the agent.

Help Contents Displays the table of contents for the online help.

Version Displays the version information.
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B. Troubleshooting
This section explains how to troubleshoot and view the logs while using the remote control facility.

B.1 Troubleshooting
This subsection explains how to troubleshoot problems. Troubleshooting methods are organized by phenomena.

(1) The installation of Remote Control Agent on a Windows NT 4.0 system fails
When you try to install Remote Control Agent on a Windows NT 4.0 system, the process may fail, outputting the
message Display Driver File not Found.

Response
The Windows NT 4.0 system may be running in the VGA mode. From the Control Panel, choose Display to
display the Display Properties dialog box, and then press Display Type. If the Current Files shows vga.sys,
vga.dll, the system is in the VGA mode. Install the display driver provided by the machine.

(2) The agent's screen does not appear on the controller display
If you create an application in JAVA2 and attempt to activate it on an agent, the agent's screen might not appear on the
controller display because the application uses Direct Draw when rendering drawings.

Response
You can avoid this problem by specifying the following option when starting JAVA2 which will explicitly inhibit
the use of Direct Draw:
-Dsun.java2d.noddraw=true

(3) The agent's screen does not appear correctly on the controller display
In the PC environment where the display board chip-set is 3D RAGE II by ATI, if the agent is running on Windows
Me or Windows 98, some controllers may not be able to display the agent's screen correctly. This will normally
depend on the version of the display driver.

Response
Setting an appropriate value in the agent's registry may eliminate this problem. Start the registry editor
(regedit.exe). Choose Edit, New, and then String Value, create AgentHookOption under
HKEY_LOCAL_MACHINE\SOFTWARE\HITACHI\JP1/RemoteControlAgent, and then set 1 as its data.

(4) The agent's screen is not updated on the controller display (when connected to a
Windows Me or Windows 98 agent)

When connected to a Windows Me or Windows 98 agent, the controller may not be able to update the agent's screen
view in the Remote Control window.

Response
The agent may have run out of memory. If the status bar of the Remote Control window shows the lack of
memory icon ( ), use the Memory Settings dialog box for the Remote Control Agent environment setup and
choose Customize memory allocation rather than Use default settings. Then adjust the memory allocation. For
details on the memory settings used by the agent, see 3.4.8 Memory settings (for Windows Me and Windows 98).
On the controller side, refresh the screen status of the Remote Control window.

(5) The operation on the agent screen performed from the controller or agent does not take
effect

During a remote control operation, some mouse or keyboard operations on the agent screen may not function properly.
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Response
The Ctrl or Alt key may be pressed on the agent machine. In this case, press the Ctrl or Alt key again to free up
the system.
You can configure the controller to display an icon on the Remote Control window's status bar indicating the
status of the agent's Ctrl and Alt keys. For details, see 3.3.5(3) Status bar.

(6) Windows 7, Windows Server 2008, Windows Vista, Windows Server 2003, Windows XP,
or Windows 2000 does not start after agent installation

After Remote Control Agent installation, Windows 7, Windows Server 2008, Windows Vista, Windows Server 2003,
Windows XP, or Windows 2000 may be unable to start.

Response
Remote Control Agent might conflict with non-Hitachi remote control products. Use the following procedure to
correct the problem.

1. Start Windows 7, Windows Server 2008, Windows Vista, Windows Server 2003, Windows XP, or Windows
2000 in safe mode, and then uninstall Remote Control Agent.

2. Restart the PC.

3. If non-Hitachi remote control products have been installed, uninstall them.

4. Restart the PC.

5. Re-install Remote Control Agent.

The following procedure is used to start the PC in safe mode:

1. Restart the PC.

2. A message appears at the bottom of the screen, asking you to press the F8 key to display startup options. Press
the F8 key.

3. Select Safe Mode using arrow keys, and then press the Enter key.
Turn off the Num Lock key if you want to use the arrow keys on the numeric key pad.

4. Use the arrow keys to select the Windows 7, Windows Server 2008, Windows Vista, Windows Server 2003,
Windows XP, or Windows 2000 operating system you want to start up.

(7) The remote control program does not start
If you try to use Remote Control Manager or Remote Control Agent without restarting the PC after installing the
program, the following message may be displayed and the program may fail to start: The ordinal 6907 could
not be located in the dynamic link library MFC42.DLL.

Response
Restart the PC and then start Remote Control Manager or Remote Control Agent.

(8) The Remote Control Agent icon does not display correctly
With a version of Internet Explorer earlier than 5.01 is installed, the icon is displayed incorrectly when the status
window of the agent is docked to the edge of the desktop.

Response
Install Internet Explorer 5.01 or later.

B.2 Collecting resources when an error occurs
This subsection explains the various resources you can collect to investigate causes of problems, and explains how to
collect the resources.
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(1) Log information
Additional detailed log files are output to the directory of the basic log files (i.e. RcHstCtr.log and
RcHstAgt.log). For details on the output directory, see K. Logging Format and Output Information.

(2) Setting information of the remote control program
You can collect setting information of the remote control program from the registry.

To collect the information:

1. From the Start menu, choose Run.

2. Enter regedit to the Open field, and then click the OK button.
This starts registry editor.

3. Select the keys that correspond to the product.
For Remote Control Manager functions of JP1/Remote Control Manager and JP1/Software Distribution:

• HKEY_LOCAL_MACHINE\SOFTWARE\HITACHI\JP1/RemoteControlManager
In Windows Server 2012, the 64-bit version of Windows 8 or Windows Server 2008 R2 (x64), the 64-bit
version of Windows 7, the 64-bit version of Windows Server 2008, the 64-bit editions of Windows Vista, or
Windows Server 2003 (x64), \HITACHI should be replaced by \Wow6432Node\Hitachi.

• HKEY_CURRENT_USER\SOFTWARE\HITACHI\JP1/RemoteControlManager
For Remote Control Agent functions of JP1/Remote Control Agent and JP1/Software Distribution:

• HKEY_LOCAL_MACHINE\SOFTWARE\HITACHI\JP1/RemoteControlAgent
In Windows Server 2012, the 64-bit version of Windows 8 or Windows Server 2008 R2 (x64), the 64-bit
version of Windows 7, the 64-bit version of Windows Server 2008, the 64-bit editions of Windows Vista, or
Windows Server 2003 (x64), \HITACHI should be replaced by \Wow6432Node\Hitachi.

• HKEY_CURRENT_USER\SOFTWARE\HITACHI\JP1/RemoteControlAgent
4. From the menu, select Registry and then choose Export Registry File.

5. Specify the output file for the remote control program's settings, and then click the Save button.
The setting information of the remote control program is output to the specified file.
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C. How to Use the Find Agent Facility
Remote Control Manager offers a facility that allows the user to search for machines running Remote Control Agent
within the network. This section describes how to set the search range, the status of found agents, and how to
customize the search method used when you use this facility to search for agents.

For details on agent search procedures, see 4.1.2(1)(c) Searching for an agent via a dialog box if you want to search
from the Remote Control window, and 4.4.3(3) Searching for and reading the organizational information about
agents if you want to search from the Agent Manager window.

C.1 Setting the search range
You can specify individual IP addresses or IP address groups when setting the search range. There are 5 ways to set
the range.

1. Specifying a single IP address.

Example
172.17.11.10

2. Describe the IP address to the 3rd byte. For the last byte, specify 2 figures joined by a hyphen (-).

Example
172.17.11.10-20
Use this format when you want to perform a search within a group of consecutive IP addresses.

3. Describe the IP address to the 3rd byte. For the last byte, specify multiple figures separated by comma (,).

Example
172.17.11.10,11,100,200
Use this format when you want to search within a group of non-consecutive IP addresses.

4. Combination of the options (2) and (3).

Example
172.17.11.10,50-100,200

5. Describe the IP address to the 3rd byte.

Example
172.17.11
Use this format when you want to conduct a search among all the IP addresses within the same subnet.

The table below shows the actual search range of each of the above specifications. The item numbers, shown in the
table, correspond to the numbers of the search methods used above.

Table C‒1: Examples of agent search ranges

Item
number Example Actual search range No. of addresses subject

to the search

(1) 172.17.11.10 172.17.11.10 1

(2) 172.17.11.10-20 172.17.11.10 to 172.17.11.20 11

(3) 172.17.11.10,11,100,200 172.17.11.10, 172.17.11,11
172.17.11.100, 172.17.11.200

4

(4) 172.17.11.10,50-100, 200 172.17.11.10, 172.17.11.50 to
172.17.11.100, 172.17.11.200

53

(5) 172.17.11 172.17.11.0 to 172.17.11.255 256
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C.2 The status of found agents
The agent status shown in the Search Agents dialog box will be Awaiting connection, Connection rejected, Not
running, or Not responding. The figure below defines each status.

Figure C‒1: Definitions of agent statuses

C.3 Customizing the search method
When searching for agents, you can customize the search method: for example, by using the host name option or
status check setting.

Customize the search method from the following dialog boxes:

• When searching for agents from the Remote Control window:
From the Search Agents dialog box, click the Settings button to display the Settings for Agent Search dialog box.
You can customize the search method from this dialog box.

Figure C‒2: Settings for Agent Search dialog box

• When searching from the Agent Manager window:
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Customize the search method from the dialog boxes listed below. The setting contents are the same as the Settings
for Agent Search dialog box. In Agent Manager, however, you can also set the connection options for a found
agent.

• The New Network dialog box

• The Settings page of the Networks' Properties dialog box.

• The Update Setup dialog box that is displayed from the Properties dialog box for folders and multiple items.

Figure C‒3: Settings page

The following describes the settings in each of these dialog boxes:

Maximum number of threads
Specify the maximum number of threads to be used during an agent search as an integer from 1 and 100. The
default setting is 20.

Show agent host names
Select this option to use gethostbyaddr() and resolve the name from the IP address. This option is not
checked by default. Choosing this option will add the Name field in the Agent page of the Search Agents dialog
box. When the found agent is added on the agent manager, its name is set on the Name field.
When using this option, you need to select the name resolution timing from the following 3 alternatives. The
default setting is Connected.

Connected
Resolve the name upon successful connection. Only the names of the agents in the Awaiting
connection or Connection rejected status will be shown.

Pinged
Resolve the name when the ping confirms that the PC is running. The names of all agents, excluding those in
the Not responding status, will be shown.

All
Resolve the name before the ping confirms that the PC is running. The names of all the agents are shown.

Ping the agent machine before agent status check
Uses the ping to check whether a PC is running. This setting is checked by default.
If you clear this option, the system will check the connection without using the ping. For this reason, machines in
the Not responding status will be identified as Not running.
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Ping time-out:
Specify the maximum time to wait for a response to the ping command as an integer from 1 to 60 (seconds).
The default time is 3 seconds.

Connect to the agent for status check
Select this option when you want to issue the Connect command to check whether Remote Control Agent is
running.
The check is performed by default.
If you clear this option, the system does not connect to the machines subject to the search. For this reason, the
search results will be either Not responding or Not running.

Connect time-out:
Specify the maximum time to wait for a response to a Connect command, and a response to message
transmission following the connection. Specify an integer from 1 to 60 (seconds). The default setting is 3
seconds.

Found agents (this is displayed for Agent Manager only)
Clicking the Setup button displays the Found Agent Settings dialog box, which is used for setting the connection
option to be used when connecting a found agent.

C.4 Notes on agent search
This subsection describes points you should remember when using the find agent facility.

• Versions of Remote Control Agent 05-10 will not be shown.

• When you perform an agent search from the Remote Control window, connecting to a detected agent will erase
the search results. If you wish to save the results you should perform the search from the Agent Manager window
and move the icons of the found agents to other folders.
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D. Notes on Using JP1/Remote Control in a Cluster System
You can only use JP1/Remote control in a cluster system when you are not using the failover function. This means
that you cannot use logical host names or logical IP addresses when configuring permitted controllers on the agent.
Use the actual host names or actual IP addresses of the permitted controllers, instead.
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E. Available NAT Function
This section describes the NAT function available for JP1/Remote Control.

You can use the NAT function when you use JP1/Remote Control in a firewalled network environment, such as when
JP1/Remote Control is used in a cluster system.

The NAT function translates addresses on the network to prevent internal network addresses from being viewed from
the external network and leakage to the public.

The available types of address translation are the fixed address assignment (static mode) and dynamic address
assignment (dynamic mode).

For JP1/Remote Control, use the fixed address assignment (static mode).
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F. Process Information
The table below lists the resident JP1/Remote Control process. When monitoring processes, use this information. The
number in parentheses after the process name is the number of processes that can be executed concurrently.

Process name Function

dmrcagnt(2) The main process activated by the service

You can use the service monitoring function of JP1/Performance Management/SNMP System Observer. When you
use this function to monitor the JP1/Remote Control service installed on a Windows 8, Windows Server 2012,
Windows 7, Windows Server 2008, Windows Vista, Windows Server 2003, Windows XP, Windows 2000, or
Windows NT 4.0 computer, specify the monitoring conditions based on the following information:

Name of the application to be monitored
JP1/Remote Control Agent (service)

Name of the service to be monitored
Remote Control Agent

For details on how to set up the service monitoring function for JP1/Performance Management/SNMP System
Observer, see the manual Job Management Partner 1/Performance Management/SNMP System Observer Description,
Operator's Guide and Reference.
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G. Port Numbers
This appendix lists the port numbers used in JP1/Remote Control and the connection directions of these port numbers.

G.1 Port numbers
The table below lists the port numbers used in JP1/Remote Control.

When the product is shipped, the ports are assigned default port numbers. You can change these default port numbers.

Table G‒1: Port numbers used in JP1/Remote Control

Port number Protocol Service name Explanation

30003 TCP - Remote control

30004 TCP - File transfer

30005 TCP - Chat

30006 TCP - Remote control

(connection initiation from the agent)

30007 TCP - File transfer

(connection initiation from the agent)

Legend:
-: Not applicable

G.2 Connection directions
The table below lists the connection directions.

Table G‒2: Connection directions

Name of the program that requires
configuration Port number/protocol Connection direction

JP1/Remote Control Manager,

JP1/Remote Control Agent

30003/TCP JP1/Remote Control Manager --> JP1/Remote
Control Agent

30004/TCP JP1/Remote Control Manager --> JP1/Remote
Control Agent

30005/TCP JP1/Remote Control Manager <-> JP1/Remote
Control Agent

30006/TCP JP1/Remote Control Manager <-- JP1/Remote
Control Agent

30007/TCP JP1/Remote Control Manager <-- JP1/Remote
Control Agent

Legend:
-->: From left to right
<->: Both directions -- from left to right and from right to left
<--: From right to left

Note
When a port that is not listed in the table above is used for connection, the connection direction of that port is the
opposite of the direction assigned to the currently used port. The range of port numbers that can be used depends
on the operating system.
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H. Combinations of Display Board Chip Sets and Drivers
Tables H-1 to H-3 list the combinations of display board chip sets and drivers for each agent OS. Note that if the agent
is on Windows 8, Windows Server 2012, Windows 7, Windows Server 2008, Windows Vista, Windows Server 2003,
Windows XP, or Windows 2000, no restriction is placed on the combination of the chip set on the display board and
the driver.

For the latest information, see the DRIVERS.TXT.

Table H‒1: Combinations of display board chip sets and drivers (for a Windows NT 4.0 agent)

Chip set manufacturer Chip set name Driver

Cirrus Logic CL5429 Cirrus compatible display adapter#

CL5430 Cirrus compatible display adapter#

CL5446 Cirrus compatible display adapter#

CL-GD5430 Cirrus Logic 5429/30/34/36

CL-GD5446 Cirrus Logic 5446 PCI DirectDraw/VPM(V1.00D)

CL-GD5465 cl546xm compatible display adapter

CL-GD5480 cirrus compatible display adaptor#

Cirrus Logic 5480 Cirrus Logic CL-GD5480 Graphics Adapter 1.10

Cirrus Logic 5480 Cirrus Logic CL-GD5480 Graphics Adapter 1.22

Cirrus Logic 5480 Cirrus Logic CL-GD5480 Graphics Adapter 1.24

Cirrus Logic 5480 Cirrus Logic CL-GD5480 Graphics Adapter 1.25

S3 764 S3 compatible display adapter

Vision 868 S3 compatible display adapter

Vision 868 S3 Vision 868 PCI

Vision 868 Power Window 868PCI/VLB

Vision 968 S3 Vision 968 PCI

ViRGE S3 ViRGE PCI

ViRGE Power Window 3DV

ViRGE S3 Incorporated ViRGE /VX/DX/GX

Trio64 V2 Melco WGP-DX

S3 Incorporated S3 Trio3D S3 Incorporated Trio3D Display Driver Version 3.26.39 Production
Release

S3 Savage4 S3 Inc. Savage4 NT4.0 Display Driver

ATI Technologies 3D RAGE II ATI 3D RAGE II

3D RAGE II ATI 3D XPRESSION+PC2TV (DirectDraw)

3D RAGE LT

(LT-A1S4)

ATI Technologies Inc.

ATI 3D RAGE LT

Unknown ATI

accelerator

ATI 3D RAGE LT
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Chip set manufacturer Chip set name Driver

ATI Technologies 3D RAGE LT PRO AGP2X
(LT-A2U2)

ATI 3D RAGE LT PRO

3D RAGE LT PRO AGP2X
(LT-A2U2)

ATI Technologies Inc. 3D Rage LT Pro

3D RAGE PRO AGP2X (GT-
C2U2)

ATI Technologies Inc. 3D RAGE PRO

3D RAGE PRO TURBO ATI 3D RAGE PRO TURBO

3D RAGE PRO AGP2X(GT-
C2U2)

ATI Technologies Inc. mach64 Graphics Accelerator

ATI 3D RAGE PRO PCI (GT-
C2U2)

ATI Technologies Inc. 3D RAGE PRO

3D RAGE PRO AGP 2X(GT-
C2U2)

ATI Technologies Inc. 3D RAGE PRO

ATI 3D RAGE LT PRO AGP
2X (A2U2/A3U1)

ATI 3D RAGE LT PRO AGP 2X

ATI 3D RAGE LT PRO AGP
2X (A2U2)

ATI 3D RAGE LT PRO AGP 2X

ATI 3D RAGE MOBILITY
AGP-133 (A2U1/2)

ATI RAGE MOBILITY AGP 2X

ATI 3D RAGE MOBILITY
P/M AGP 2X (A2x/A31)

ATI RAGE MOBILITY-M AGP

ATI RAGE XL AGP 2X ATI RAGE XL AGP 2X

ATI RAGE XL AGP 2X
(B22)

XPERT 98 AGP 2X

ATI RAGE XL PCI (B22) RAGE XL PCI

ATI RAGE XL PCI (B41) RAGE XL PCI

ATI RAGE XL PCI (B41) Compatible display driver

ATI 3D RAGE PRO XL
AGP-1X/2X (B2U2)

ATI RAGE XL AGP 2X

mach32 ATI Graphics Wonder (mach32)

Mach 64 VT-A ATI Technologies Inc. 3D PRO TURBO

M3 33MHz(AGP) RAGE MOBILITY-128 AGP 2X

ATI 3D RAGE II C
AGP(A21)

ATI 3D Charger

ATI 3D RAGE II C PCI(A21) ATI 3D Charger

ATI 3D RAGE II C PCI(A21) ati compatible display adaptor

ATI 3D RAGE II C PCI(A21) ati2mpah compatible display adapter

ATI 3D RAGE II C PCI(A21) ATI RAGE IIC

ATI 3D RAGE II C
AGP(A21)

ATI RAGE IIC

ATI 3D RAGE II C (GT-
B3U1)

ATI Technologies Inc. 3D RAGE IIC
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Chip set manufacturer Chip set name Driver

ATI Technologies ATI 3D RAGE II C AGP (GT-
B3U2)

ATI 3D RAGE IIC AGP

ATI 3D RAGE II C PCI (GT-
B3U2)

ATI 3D RAGE IIC PCI

ATI 3D RAGE II C (UMC
GT-B)

ATI Technologies Inc. 3D RAGE IIC

ATI 3D RAGE PRO AGP 2X
(GT-C2U2)

ATI Technologies Inc. 3D RAGE PRO TURBO

Chips and Technology 65550 PCI Chips and Tech. Accelerator

65554 Chips & Technologies Video Accelerator(64300 64310 65545 65548
65550)

65555 Chips Video Accelerator(64300/10 65535/40/45/48/50/54/55)

69000 Chips Video Accelerator(65545/48/50/54/55 68554 69000)

Chips and Technologies, Inc. Chips 65555 Compaq Laptops (69000 65555)

Chips 69000 Chips Video Accelerator (65545/48/50/54/55 68554 69000)

Number Nine Visual
Technologies

Imagine 128 Series 2 Number Nine Visual Technologies Imagine 128 II

S3-ViRGE Reality332

S3 ViRGE/GX2 Number Nine Visual Technology Inc. Reality 334

Accel Graphics AccelPro TX2500 Accel3D AccelPro Video Accelerator

Accel STAR2 AccelSTAR II 3D Video Accelerator

AccelPRO MX AccelPRO MX 3D Video Accelerator

AccelGALAXY AccelGraphics AccelGALAXY

Evans and Sutherland REALimage3000 Evans and Sutherland Tornado 3000

REALimage 1200 Evans and Sutherland Lightning 1200

3Dlabs Inc, Ltd. 3Dlabs GLINT R3 3Dlabs Graphics Professor

Microsoft Corporation Cirrus Logic 5446 Cirrus Logic compatible graphic adapter#

Cirrus Logic 5446 Cirrus compatible display adaptor#

CL 5424 Cirrus compatible graphic adaptor#

S3 765 s3 compatible display adaptor#

NeoMagic Corporation MagicMedia 256AV NeoMagic MagicMedia256AV

SiS SiS630 SiS630

I-O DATA DEVICE, INC. S3 Savage4 GA-SS22P16/AGP4 Display Driver

Savage4 DOS/V: GA-SV4 Series Bus Master Driver

Savage4 DOS/V: GA-SV4 Series None Bus Master Driver

PERMEDIA 2 GA-PII8/PCI

Intel Corporation Intel810 Intel(r) 82810 82810-DC100 82810E or 82815 Graphics Controller

Intel810 Intel(R) 810 Chipset Graphics Driver 4.03.1381.2555

Intel810 Intel(r) Graphics Technology Device
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Chip set manufacturer Chip set name Driver

Intel Corporation Chips 69030 Chips Video Accelerators (65550/54/55 68554 69000/30)

Canopus RIVA TNT2 Canopus SPECTRA Light 1200

GeForce2 GTS Canopus SPECTRA 8400

Trident Microsystems Inc. Trident Cyber9525 Trident Cyber9525DVD PCI/AGP (V4.810.58ML)

Trident Cyber9525 Trident Cyber9525DVD PCI/AGP (V4.810.70ML)

NVIDIA Corporation VANTA NVIDIA Vanta V3.84 NT4

VANTA GIGABYTE GA-620 (Vanta)

VANTA NVIDIA Vanta

VANTA GA-620[Vanta] Windows NT Display Driver

TNT2 Model 64 NVIDIA TNT2 M64 4xAGP

NV3 NVIDIA RIVA 128

NV3 NVIDIA RIVA 128ZX

STB Systems Inc. NV3 STB Systems Inc. Velocity 128 3D (NVidia RIVA 128)

#
The mouse pointer may be shown in double vision during remote control operations.

Table H‒2: Combinations of display board chip sets and drivers (for a Windows Me agent)

Chip set manufacturer Chip set name Driver

S3 Vision 968 S3 Vision 968 PCI

ViRGE S3 ViRGE PCI (325)

ATI Technologies Inc. Mach64LT RAGE LT PRO AGP 2X

Chips And Technologies, Inc. 65554 PCI Chips and Tech. 65554 PCI

Number Nine Visual Technology Imagine 128 Series 2
(VRAM)

Number Nine Imagine 128 (Series 2)

Trident Cyber9525 Trident Cyber9525DVD PCI/AGP (W98.56)

Nvidia NV3 NVIDIA RIVA 128/128ZX PCI/AGP (W98.56)

Canopus GeForce2 GTS Canopus SPECTRA 8400

I-O DATA DEVICE, INC. Savage4 DOS/V: GA-SV4 Series Bus Master Driver

Savage4 DOS/V: GA-SV4 Series None Bus Master Driver

PERMEDIA 2 GA-PII8/PCI

Table H‒3: Combinations of display board chip sets and drivers (for a Windows 98 agent)

Chip set manufacturer Chip set name Driver

Cirrus Logic CL-GD5430 Cirrus Logic 5429/30/34/36

CL-GD5446 Cirrus Logic 5446 PCI

S3 Vision 868 S3 Vision 868 PCI

Vision 868 Power Window 868PCI/VLB
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Chip set manufacturer Chip set name Driver

ATI Technologies 3D RAGE LT PRO
(AGP)

RAGE LT PRO AGP 2X

3D RAGE LT PRO
AGP2X (LT-A2U2)

ATI 3D RAGE LT PRO (DirectX)

ATI 3D Rage Pro ATI 3D Rage Pro (atir3)

3D RAGE PRO TURBO RAGE PRO TURBO 2X (DirectX)

Mach64GT RAGE IIC AGP

Mach64: XL/XC XPERT 98 AGP

Chips and Technology 65550 PCI Chips and Tech. 65550 PCI

65554 PCI Chips and Tech. 65554 PCI

65555 PCI Chips and Tech. 65555 PCI

69000 PCI Chips and Tech. 69000 PCI

F69000 Chips and Tech. 69000 PCI

Trident Trident 9682 PC-9821 TGUI968x, Cyber938x, Providia9685 (Trident)

Cyber9525 Trident Cyber9525DVD PCI/AGP(W98.56)

9385-1 Trident 9660/968x/938x, Linear Accelerated for PCI
(v5.00.10.TWJ1909)

3Dfx Interactive 3Dfx Voodoo Rush AT25 + Voodoo Rush (Single Board)

NeoMagic Corporation NeoMagic NM2160 NeoMagic MagicGraph 128XD

NeoMagic MagicMedia
256AV

NeoMagic MagicMedia 256AV

SiS 540 SiS540

630 SiS630

Silicon Motion Inc. SM710 LynEM Silicon Motion LynxEM

Intel Corporation Intel810E Intel(r) 82810E Graphics Controller 4.12.01.2586

Intel(R)810E Chipset Intel(r) 82810E Graphics Controller

Intel(R)830 Intel(R) 82830M Graphics Controller - 0

Intel(R)830 Intel(R) 82830M Graphics Controller - 1

Canopus GeForce2 GTS Canopus SPECTRA 8400

I-O DATA DEVICE, INC. S3 Savage4 Rev D GA-SV4 Series Display Driver (Default)

Savage4 DOS/V: GA-SV4 Series Bus Master Driver

Savage4 DOS/V: GA-SV4 Series None Bus Master Driver

PERMEDIA 2 GA-PII8/PCI
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I. Connection with a Security PC
This section describes the operation of an agent when a security PC has connected to it, and provides notes on playing
agent sounds on the security PC.

I.1 Operation of an agent when a security PC has connected to it
A security PC is a PC equipped with only minimal functions, and which has no external storage capability, such as a
hard disk or floppy disk.

The security PC connects to the agent, which enables remote control from the security PC.

The figure below provides an overview of the remote control facility when a security PC is connected to an agent.

Figure I‒1: Overview of the remote control facility when a security PC is connected to an agent

The following describes the operation of an agent when a security PC has connected to it:

• The agent screen does not display anything (black screen).

• The wallpaper, window animation, and contents of a window being dragged are not displayed.

• The screen saver does not start. If the screen saver has been set up and no operations are performed on the security
PC during the wait time for the screen saver to start, the computer is automatically locked when the screen saver
starts. The computer is locked even when a password is not set for the screen saver.

• The computer is automatically locked when remote control operation terminates.
The lock is released when the user enters the user name and password.

I.2 Notes on playing agent sound on a security PC
To play sound for an agent other than FLORA bd and FLORA gd on a security PC, the agent must meet prerequisites
described below.

(1) Agent prerequisites
For agent sound to be played on a security PC, the agent must meet the following conditions:

I. Connection with a Security PC

250



• The operating system of the agent is Windows 8, Windows Server 2012, Windows 7, Windows Server 2008,
Windows Vista, Windows Server 2003, Windows XP, or Windows 2000.

• The version of the agent is 08-00 or later.

• A sound board is installed in the agent, and sound from a mixer device is able to be recorded when the speaker
volume is set to 0.

For information about how to check whether it is possible to record sound by using a mixer device when the speaker
volume is set to 0, see (2) Checking whether or not sound from a mixer device can be recorded.

(2) Checking whether or not sound from a mixer device can be recorded
The following procedure describes how to check whether or not sound from a mixer device of an agent can be
recorded when the speaker volume is set to 0:

In Windows Server 2003, Windows XP, or Windows 2000:

1. Open Control Panel, and choose Sounds and Audio Devices (In Windows 2000, click Sound and Multimedia).

2. In the Sounds and Audio Devices Properties dialog box (In Windows 2000, the Sounds and Multimedia Properties
dialog box), click the Audio tab. In the Sound Recording section, click the Volume button.

3. In the Wave In dialog box, from the Options menu, choose Properties.

4. In the Properties dialog box, select Stereo Mixer from the list in the Show the following volume controls
section, and then click the OK button.
If you cannot find Stereo Mixer in the list, select a device that contains Wave or mixer in its name, or any one of
the following devices:

• Mixer

• Monaural Mixer

• Stereo Mix

• Stereo Out

• Wave Out Mix

If none of the above is displayed, no sound can be recorded from a mixer device regardless of the speaker volume.

5. In the Wave In dialog box, select the check box of the device you selected in step 4.

6. In the Sounds and Audio Devices Properties dialog box, click the Volume tab and either select the Mute check
box in the Device volume section or move the slider to Low. Then click the OK button.
In Windows 2000, in the Sounds and Multimedia Properties dialog box, click the Audio tab. In the Sound
Playback section, click the Volume button. When the Volume Control dialog box appears, either select the Mute
check box for the device you selected in step 4 or move the slider down to the bottom.

7. From the Start menu, choose Accessories, Entertainment, and then Sound Recorder.

8. In the Sound - Sound Recorder dialog box, click the  (Record) button.

9. Within 60 seconds, open the Sounds and Audio Devices Properties dialog box, and then click the Sounds tab.
From the Program events list, select any of the listed events such as Start Windows or Exit Windows, and then
click the OK button.
In Windows 2000, within 60 seconds, open the Sounds and Multimedia Properties dialog box, and click the
Sound tab. From the Sound Events list, select any of the listed events such as Start Windows or Exit Windows,
and then click the OK button.

10. In the Sound - Sound Recorder dialog box, check whether the green line is fluctuating.
If the green line is not fluctuating, no sound can be recorded from the mixer device.

In Windows 8, Windows Server 2012, Windows 7, Windows Server 2008 or Windows Vista:

1. Open Control Panel, and choose Hardware and Sound and then Sound.

2. In the Sound dialog box, click the Recording tab.

3. Right-click in the area where recording devices are displayed. From the displayed menu, choose Show Disabled
Devices.

4. Right-click Stereo Mixer, and choose Enable from the displayed menu.
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If you cannot find Stereo Mixer in the list, select a device that contains Wave or mixer in its name, or any one of
the following devices:

• Mixer

• Monaural Mixer

• Stereo Mix

• Stereo Out

• Wave Out Mix

If none of the above is displayed, no sound can be recorded from a mixer device regardless of the speaker level.

5. Right-click to display the menu again, and choose Set as Default Device.

6. In the Sound dialog box, click the Playback tab. Select Speakers, and then click the Properties button.

7. In the Speakers Properties dialog box, click the Levels tab. Then either drag the Levels slider to 0, or click the
speaker icon to mute the sound, and then click the OK button.

8. From the Start menu, choose Accessories, and then Sound Recorder.

9. In the Sound Recorder dialog box, click the button to start recording.

10. Within 60 seconds, open the Sound dialog box, and then click the Sounds tab. From the Program events list,
select any of the listed events such as Start Windows or Exit Windows, and then click the button to the left of
the Browse button to test the sound.

11. In the Sound Recorder dialog box, check whether the green line is fluctuating.
If the green line is not fluctuating, no sound can be recorded from the mixer device.

(3) Notes on transferring sound from Windows 8, Windows Server 2012, Windows 7,
Windows Server 2008 or Windows Vista agent

When a security PC has been connected to a Windows 8, Windows Server 2012, Windows 7, Windows Server 2008
or Windows Vista agent, a mixer device must be enabled beforehand to transfer sound to the security PC.

To enable a mixer device:

1. Open Control Panel, and choose Hardware and Sound and then Sound.

2. In the Sound dialog box, select the Recording tab.

3. Right-click the area where recording devices are displayed. From the displayed menu, select Show Disabled
Devices.

4. Right-click Stereo Mixer (or a device that contains Wave or mixer in its name), and then choose Enable from the
displayed menu.

5. Right-click to display the menu again, and choose Set as Default Device.

6. Click the OK button.

If you performed this operation from a security PC, terminate Remote Controller and then reconnect it.
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J. Setting Permissions for Access via the Network
When you specify authentication information for Remote Control Agent, Windows users and groups using Windows
authentication need user rights for accessing a computer via the network. Use the Windows functionality to set the
user rights.

This section shows Windows user permissions required for setting the user rights, and describes how to specify the
user rights for each type of operating system and usage of the computer.

J.1 Windows user permissions required for setting user rights
Before setting user rights, make sure that the Windows user permissions listed in the table below have been set.

Table J‒1: Windows user permissions required for setting user rights

Operating system and computer Required permissions

Windows NT 4.0 Administrators group permissions, or other
appropriate permissions

Windows 2000 or later# Local computer Administrators group permissions, or other
appropriate permissions. If the local computer
is in a domain, Domain Admins group
permissions are required.

Workstation or server in a domain Domain Admins group or Enterprise Admins
group in Active Directory, or other
appropriate permissions.Domain controller or workstation on which the

Windows Server 2003 Administrative Tool pack is
installed

Domain controller

#
From the point of view of security, consider logging in with a user account other than the system administrator and then using
Execute as another user to set user rights using the system administrator account.

J.2 Procedure for setting user rights
The following describes how to set user rights according to how the computer is being used.

(1) In Windows NT 4.0

To set user rights:

1. Choose Start, Programs, Administrative Tools (Common), and then User Manager (or User Manager for
Domains).

2. From the Policies menu, choose User Rights.

3. In the User Rights Policy dialog box, from the pull-down list of permissions, choose Access this computer from
the network.
Change the security settings.

(2) For local computers (Windows 2000 or later)

To set user rights:

1. Choose Start, Control Panel, and then Administrative Tools.

2. Double-click Local Security Policy.

3. In the console tree, choose Security Settings.
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4. Choose Local Policies, and then User Rights Assignment.

5. In the window area for detailed information, double-click Access this computer from the network or Deny
access to this computer from the network.
Change the security settings.

(3) For workstations and servers in a domain (Windows 2000 or later)

1. Choose Start and then Run.

2. Enter mmc, and then click the OK button.

3. From the File menu for the console, choose Add/Remove Snap-in.

4. In the Add/Remove Snap-in dialog box, click the Add button.

5. In the Add Standalone Snap-in dialog box, choose Group Policy Object Editor.

6. In the Select Group Policy Object dialog box, click the Browse button.
Browse for the policy object you want to change, and then specify the necessary setting.

7. Choose Group Policy Object, and then Computer Name Policy. Choose Computer Configuration, Windows
Settings, and then Security Settings.

8. Choose Local Policies and then User Rights Assignment.

9. In the window area for detailed information, double-click Access this computer from the network or Deny
access to this computer from the network.
Change the security settings. If a security setting has not been defined, select the Define this policy setting check
box.

(4) For domain controllers and workstations on which the Windows Server 2003
Administrative tool pack is installed (Windows 2000 or later)

1. Choose Start, Control Panel, Performance and Maintenance, and then Administrative Tools.

2. Double-click Active Directory Users and Computers.

3. In the console tree, right-click the group policy object for which you want to edit security.

4. Choose the Properties and the Group Policy tabs.

5. To edit an existing group policy object, choose Edit.
To create a new group policy object, choose New and then Edit.

6. Choose Group Policy Object and then Computer Name Policy. Choose Computer Configuration, Windows
Settings, and then Security Settings.

7. Choose Local Policies and then User Rights Assignment.

8. In the window area for detailed information, double-click Access this computer from the network or Deny
access to this computer from the network.
Change the security settings. If a security setting has not been defined, select the Define this policy setting check
box.

(5) For domain controllers (Windows 2000 or later)

1. Choose Start, Control Panel, Performance and Maintenance, and then Administrative Tools.

2. Double-click Domain Controller Security Policy.

3. Choose Group Policy Object and then Computer Name Policy. Choose Computer Configuration, Windows
Settings, and then Security Settings.

4. Choose Local Policies and then User Rights Assignment.

5. In the window area for detailed information, double-click Access this computer from the network or Deny
access to this computer from the network.
Change the security settings. If a security setting has not been defined, select the Define this policy setting check
box.

J. Setting Permissions for Access via the Network

254



K. Logging Format and Output Information
This appendix explains logs that can be output by a controller and agent.

K.1 Remote control facility logs
This subsection describes what logging information is collected while the remote control facility is in use, as well as
the format in which the information is output.

From the log files, you can view basic operation information such as the remote control modes or connected/
disconnected remote control programs. The controller log file is output to RcHstCtr.log. The agent log file is
output to RcHstAgt.log.

You can determine whether the log should be output and what kind of information should be output by configuring the
settings in the Properties dialog box's Logging page on the controller, and in the Remote Control Agent Settings on
the agent. For details on how to configure these settings on a controller, see 3.3.7 Logging page. For agents, see 3.4.5
Settings for logging. For both controllers and agents, the default setting is not to output log information.

Log information is output to the following destinations:

(1) Log output directory
Logging information is output to the following location:

For Windows 8, Windows Server 2012, Windows 7, Windows Server 2008 and Windows Vista

Controller
%SYSTEMDRIVE%\ProgramData\hitachi\jp1rcmgr\log\RcHstCtr.log

Agent
%SYSTEMDRIVE%\ProgramData\hitachi\jp1rcagt\log\RcHstAgt.log

For Windows Server 2003, Windows XP, and Windows 2000#

Controller
%SYSTEMDRIVE%:\Documents and Settings\All Users\Application Data\hitachi
\jp1rcmgr\log\RcHstCtr.log

Agent
%SYSTEMDRIVE%:\Documents and Settings\All Users\Application Data\hitachi
\jp1rcagt\log\RcHstAgt.log

For Windows NT 4.0, Windows Me, and Windows 98

Controller
\remote-control-manager-installation-destination-directory\log
\RcHstCtr.log
If the program is installed in the default directory, the log is output to the following file:
C:\Program Files\hitachi\jp1rcmgr\log\RcHstCtr.log

Agent
\remote-control-agent-installation-destination-directory\log\RcHstAgt.log
If the program is installed in the default directory, the log is output to the following file:
C:\Program Files\Hitachi\jp1rcagt\log\RcHstAgt.log

#
The Application Data directory is not displayed by default.

To display the Application Data directory, change the view settings as follows:

1. Double-click the My Computer icon.

2. From the Tools menu, choose Folder Options.

3. From the View tab, select the Advanced area's Show hidden files and folder option.
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4. Click the OK button.

These settings can also be changed from Windows Explorer or Control Panel's Folder Options.

You can also manage log data by generation. The default generation count is 0. If you set the number 1 or above, the
last 2 characters of the file name will be replaced with the generation number.

Example
Setting 1 :  RcHstC01.log
Setting 20:  RcHstC20.log

When the number of lines in a log file exceeds the maximum, a new log file xxxxxx01.log is created and the old log
file is renamed xxxxxx02.log (xxxxxx is the first six characters of the log file name). Thereafter, each time a new log
file is created, the generation number at the end of the old log file name increases by one. When the number of created
generations exceeds the maximum, the oldest log file is deleted.

(2) Logging format
This section describes, with an output example, the logging format when the remote control facility is used.

Figure K‒1: Logging format when the remote control facility is used

(a) Counter section

Represents the line number for which a log has been output. Columns 1 to 10 contain the counter section's header, and
columns 12 to 15 contain the final logging number. For example, in DATA COUNT 0007, DATA COUNT is the header,
and 0007 represents the final output line number.

(b) Log information section

The log information section is from the second line onwards. It is comprised of the log's line number, the output date
and time, and the log information. They are described in the following format:

Format
0001 MM/DD/YYYY hh:mm:ss:nnn log-type IP-address log-information
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0001
Represents the line number in a value between 0001 and 9999. Set in columns 1 to 4.

MM/DD/YYYY
Represents the date. Set in columns 7 to 16.

hh:mm:ss:nnn
Represents the time. nnn indicates a value in milliseconds. Set in columns 18 to 29.

log-type
Represents the type of the log. Set in columns 33 to 43.

• Information
Indicates information.

• Warning
Indicates a warning.

• Error
Indicates an error.

IP-address
Set in columns 45 to 60.

log-information
Set in columns 62 to 161 (99 characters). If the actual log information is shorter than 99 characters, blank
spaces are added so that the information will be output in 99 characters.

(3) Output information
Table K-1 lists the contents of log information output by a controller. Table K-2 shows the contents of log information
output by an agent.

Table K‒1: Controller's log output information and messages

Information type Contents of log information

Connection start Connect Start. Agent Hostname=host-name,
Port=port-number

Connection shutdown Connect Shutdown Request.

Reconnection Connect Restart. Port=port-number

Connection failure Connect Error Occurred.
Error Code=error-code(brief-description-of-the-error)

Authentication failure (permitting controller) Connect Refuse. Controller Not Permit

Authentication failure (user authentication) Connect Refuse. User (user-name#) Authentication Failed (brief-
description-of-the-error)

Optimize transaction option HighSpeedOption{Request|Change}. CompOption={Yes|No},
CompSize=size, PollingTime=milliseconds, FlowControl={Yes|No}
HighSpeedOption{Request|Change}. WallpaperOption={Yes|No},
AnimationOption={Yes|No}, DragOption={Yes|No}
HighSpeedOption{Request|Change}. BitmapCache={Yes|No},
UseLocalFont={Yes|No},
ConvertBitmapColor
={monochrome|16 Colors|256 Colors}
HighSpeedOption{Request|Change}.
ActiveDesktop={Yes|No}
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Information type Contents of log information

Remote control mode RemoteControlMode{Request|Change}. Request={View|Shared|
Exclusive},
Response={View|Shared|Exclusive}

Shutdown button Agent Shutdown Request.

Reboot button Agent Reboot Request.

Ctrl + Alt + Delete button Ctrl+Alt+Delete Request.

Line disconnection/failure Socket Error(error-function) Occurred.
Error Code=error-code(brief-description-of-the-error)

Manual disconnection made by agent user Connect Refuse. Connection was rejected by Agent user.

Automatic disconnection made by agent user Connect Refuse. No response from the Agent user.

Note
If a number of items separated by a vertical bar (|) are enclosed in braces ({}), one of the items is selected based on the
configuration and/or connection condition and is output.

#
The user name entered from the controller is output.

Table K‒2: Agent's log output information and messages

Information type Contents of log information

Connection start Connect Start. Port=port-number

Connection shutdown Connect Shutdown.

Connection failure Connect Error Occurred. Error Code=error-code

Authentication successful (permitted
controller)

Controller (host-name-or-IP-address)#1 Authentication Success.

Authentication failure (permitting
controller)

Connect Refuse. Controller Not Permit

Authentication successful (user
authentication)

User (user-name#2) Authentication Success.

Authentication failure (user authentication) Connect Refuse. User (user-name#2) Authentication Failed (brief-
description-of-the-error)

Optimize transaction option HighSpeedOption Receive. CompOption={Yes|No},
CompSize=size, PollingTime=milliseconds, FlowControl={Yes|No}
HighSpeedOption Receive. WallpaperOption={Yes|No},
AnimationOption=Yes, DragOption={Yes|No}
HighSpeedOption Receive. BitmapCache={Yes|No},
UseLocalFont={Yes|No}, ConvertBitmapColor
={monochrome|16 Colors|256 Colors}

Remote control mode RemoteControlMode Receive. Request={View|Shared|Exclusive},
Response={View|Shared|Exclusive}

Shutdown button Agent Shutdown Receive.

Reboot button Agent Reboot Receive.

Ctrl + Alt + Delete button Ctrl + Alt + Delete Receive.

Line disconnection / failure Socket Error (error-function) Occurred.
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Information type Contents of log information

Line disconnection / failure Error Code=error-code (brief-description-of-the-error)

Manual disconnection made by agent user Connect Refuse. Connection was rejected by Agent user.

Automatic disconnection made by agent
user

Connect Refuse. No response from the Agent user.

Note
If a number of items separated by a vertical bar (|) are enclosed in braces ({}), one of the items is selected based on the
configuration and/or connection condition and is output.

#1
If the connection is permitted for a host name, the host name is output. If the connection is permitted for an IP address, the IP
address is output.

#2
The user name entered from the controller is output.

K.2 File access logs
This subsection describes the logging information collected for file accesses performed in the File Transfer window,
and the format of the output information.

The file access log files allow you to view a history of operations, such as the copying or deletion files and the
creation of folders. The controller log file is output to RcHstCFT.log. The agent log file is output to 
RcHstSFT.log.

You can select which logs are to be output and what kind of information is to be output. For a controller, you
configure the settings in the Logging page that is displayed by choosing Options in the File Transfer window. For an
agent, you set up Remote Control Agent. For details on how to configure these settings on a controller, see 4.3.9(4)
Logging page. For details on how to configure these settings on agents, see 3.4.6 File transmission settings. For each
controller and agent, the default setting is not to output log information.

(1) Log output directory
Log information about file access is output to the following destinations.

Note that agent log information is also output to the controller.

For Windows 8, Windows Server 2012, Windows 7, Windows Server 2008 and Windows Vista

Controller
%SYSTEMDRIVE%\ProgramData\hitachi\jp1rcmgr\log\RcHstCFT.log

Agent
%SYSTEMDRIVE%\ProgramData\hitachi\jp1rcagt\log\RcHstSFT.log

For Windows Server 2003, Windows XP, and Windows 2000#

Controller
%SYSTEMDRIVE%:\Documents and Settings\All Users\Application Data\hitachi
\jp1rcmgr\log\RcHstCFT.log

Agent
%SYSTEMDRIVE%:\Documents and Settings\All Users\Application Data\hitachi
\jp1rcagt\log\RcHstSFT.log

For Windows NT 4.0, Windows Me, and Windows 98

Controller
\Remote-Control-Manager-installation-directory\log\RcHstCFT.log
When Remote Control Manager is installed in the default directory, log information is output to the following
file:
C:\Program Files\hitachi\jp1rcmgr\log\RcHstCFT.log
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Agent
\Remote-Control-Agent-installation-directory\log\RcHstSFT.log
When Remote Control Agent is installed in the default directory, log information is output to the following
file:
C:\Program Files\Hitachi\jp1rcagt\log\RcHstSFT.log

#
The Application Data directory is not displayed by default.

To display the Application Data directory, change the view settings as follows:

1. Double-click the My Computer icon.

2. From the Tools menu, choose Folder Options.

3. From the View tab, select the Advanced area's Show hidden files and folder option.

4. Click the OK button.

These settings can also be changed from Windows Explorer or Control Panel's Folder Options.

You can also manage log data by generation. The default number of generations is 0. If you set the number to 1 or
above, the file name (RcHCFT or RcHSFT) will be replaced with the generation number.

Example
Setting 1 : RcHCFT01.log
Setting 20: RcHCFT20.log

When the number of lines in a log file exceeds the maximum, a new log file xxxxxx01.log is created and the old log
file is renamed xxxxxx02.log (xxxxxx is RcHCFT or RcHSFT). Thereafter, each time a new log file is created, the
generation number at the end of the old log file name increases by one. When the number of created generations
exceeds the maximum, the oldest log file is deleted.

(2) Logging format
The following describes the logging format of file access logs with the use of an output example.

Figure K‒2: Logging format of file access logs
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(a) Counter section

Represents the line number for which a log has been output. Columns 1 to 10 contain the counter section's header, and
columns 12 to 15 contain the final logging number. For example, in DATA COUNT 0006, DATA COUNT is the header,
and 0006 represents the final output line number.

(b) Log information section

The log information section starts with the second line and is output in the CSV format. Each entry has 14 fields,
including the line number, output date and time, and operation and object names. They are described in the following
format:

Logging format

0001
Represents the line number in a value from 0001 to 9999.

MM/DD/YYYY hh:mm:ss:nnn
Represents the date and time when the operation was performed.
MM/DD/YYYY indicates the date, and hh:mm:ss:nnn indicates the time. nnn indicates a value in
milliseconds.

operation
Represents the type of operation. For details about the displayed items, see Table K-3.

object-type
Represents the type of the object on which the operation was performed.

• D: Folder

• F: File

• Unknown: The object type cannot be identified.

object-name
Represents the name of the object that performed the operation or on which the operation was performed.

Requestor information
Represents information about the machine that performed the operation on the object. This information
corresponds to items 6 to 9 above.

• IP-address (or host-name#1)

• target-folder

• attribute

• user-name#2

Receiver information
Represents information about the machine on which the operation was performed on the object. This
information corresponds to items 10 to 13 above.

• IP-address (or host-name#1)
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• target-folder

• attribute

• user-name#2

details
Represents the authentication user for remote control during connection. If an access error occurs, a system
error code is output.

#1
When a controller is connected by specifying the host name of an agent, the host name is displayed if name
resolution fails.

#2
Information is output only when both the controller and the agent versions are 08-00 or later.

(3) Output information
The table below shows, in alphabetical order by item, the types of logs for items indicated in operation in the log
information section.

Table K‒3: Types of logs for items indicated in operation

Item Log type Meaning

attributes changed Attribute changes The change of a file or folder attribute has finished.

attributes changing Attribute changes The change of a file or folder attribute has started.

canceled# • Forwarded files

• Deleted files

• Created folders

• Rename

• Attribute changes

The operation was canceled.

connected Connection/disconnect Connection was established.

copied Forwarded files Copying of a file or folder has finished.

copying Forwarded files Copying of a file or folder has started.

created Created folders Creation of a folder has finished.

creating Created folders Creation of a folder has started.

deleted Deleted files Deletion of a file or folder has finished.

deleting Deleted files Deletion of a file or folder has started.

disconnected Connection/disconnect Disconnection occurred.

error# • Forwarded files

• Deleted files

• Created folders

• Rename

• Attribute changes

An error occurred.

moved Forwarded files Moving of a file or folder has finished.

moving Forwarded files Moving of a file or folder has started.

renamed Rename Renaming of a file or folder has finished.

renaming Rename Renaming of a file or folder has started.

warning# • Forwarded files A warning occurred.
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Item Log type Meaning

warning# • Deleted files A warning occurred.

# The operation to which canceled, error, or warning applies is shown by the type of log that was output immediately before
this information.

See the explanations in (a) to (f) for details about the information displayed for each type of log. Note that the line
number and date are omitted.

(a) Connection/disconnect log

operation
The output items are as follows:

Item Meaning

connected The receiver (requestor) is connected.

disconnected The receiver (requestor) is disconnected.

object-type
No information is output.

object-name
No information is output.

Requestor information

host-name
Indicates the IP address (or host name) of the machine that requested connection or disconnection.

target-folder
No information is output.

attribute
No information is output.

user-name
Indicates the desktop logon user name of the machine that requested the connection. No information is output
for disconnection.

Receiver information

host-name
Indicates the IP address (or host name) of the machine that accepted connection or disconnection.

target-folder
No information is output.

attribute
No information is output.

user-name
Indicates the desktop logon user name of the machine that accepted the connection. No information is output
for disconnection.

details
Indicates the user name if the connection was established using the user authentication function.

(b) Forwarded files log

operation
The output items are as follows:

K. Logging Format and Output Information

263



Item Meaning

copying Transfer (copying) of an object has started.

moving Transfer (moving) of an object has started.

copied Transfer (copying) of an object has finished.

moved Transfer (moving) of an object has finished.

error An error occurred during transfer of an object.

canceled Transfer of an object was canceled.

warning An object that was being transferred already existed at the destination (a confirmation message for
overwriting the object was displayed).

object-type
Indicates whether the object is a folder or file.

object-name
Indicates the name of the object to be transferred.

Requestor information

host-name
Indicates the IP address (or host name) of the machine (sender) that requested the transfer.

target-folder
Indicates the path of the machine (sender) that requested the transfer (higher path for object-name).

attribute
No information is output.

user-name
Indicates the desktop logon user name of the machine (sender) that requested the transfer.

Receiver information

host-name
Indicates the IP address or host name of the machine (receiver) that accepted the transfer. If the controller
performed the operation locally, the indicated IP address or host name is the same as that of the requestor.

target-folder
Indicates the path of the machine (receiver) that accepted the transfer (higher path for object-name).

attribute
No information is output.

user-name
Indicates the desktop logon user name of the machine (receiver) that accepted the transfer. If the controller
performed the operation locally, the indicated user name is the same as that of the requestor.

details
Indicates a system error code if operation is error, or indicates 80 (a file exists) if operation is warning. No
information is output when operation is neither error nor warning.

If an error occurs when Preparing is displayed in the Progress of the File Transfer dialog box, an error message
appears, although no error is output to the log. Also, an error is not output if the file to be transferred does not exist.

(c) Deleted files log

operation
The output items are as follows:

Item Meaning

deleting Deletion of an object has started.
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Item Meaning

deleted Deletion of an object has finished.

error An error occurred during deletion of an object.

canceled Deletion of an object was canceled.

warning A read-only file was found during deletion of an object.

object-type
Indicates whether the object is a folder or file.

object-name
Indicates the name of the object to be deleted.

Requestor information

host-name
Indicates the IP address (or host name) of the machine that requested the deletion.

target-folder
No information is output.

Attribute
No information is output.

user-name
Indicates the desktop logon user name of the machine that requested the deletion.

Receiver information

host-name
Indicates the IP address or host name of the machine that accepted the deletion. If the controller performed the
operation locally, the indicated IP address or host name is the same as that of the requestor.

target-folder
Indicates the path of the machine from which the object was to be deleted (higher path for object-name).

attribute
No information is output.

user-name
Indicates the desktop logon user name of the machine that accepted the deletion. If the controller performed
the operation locally, the indicated user name is the same as that for the requestor.

details
Indicates a system error code if operation is error, or indicates read only (a read-only file exists) when
operation is warning. No information is output if operation is neither error nor warning.

If an error occurs when Preparing is displayed in the Progress of File Deletion dialog box, an error message appears,
although no error is output to the log. Also, an error is not output if the file to be deleted does not exist.

(d) Created folders log

operation
The output items are as follows:

Item Meaning

creating Folder creation has started.

created Folder creation has finished.

error An error occurred during folder creation.

canceled Folder creation was canceled.
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object-type
Indicates D (folder).

object-name
Indicates the name of the folder to be created.

Requestor information

host-name
Indicates the IP address (or host name) of the machine that requested creation of the folder.

target-folder
No information is output.

attribute
No information is output.

user-name
Indicates the desktop logon user name of the machine that requested creation of the folder.

Receiver information

host-name
Indicates the IP address or host name of the machine that accepted creation of the folder. If the controller
performed the operation locally, the indicated IP address or host name is the same as that for the requestor.

target-folder
Indicates the path of the machine where the object was to be created (higher path for object-name).

attribute
No information is output.

user-name
Indicates the desktop logon user name of the machine that accepted creation of the folder. When the controller
performed the operation locally, the indicated user name is the same as for the requestor.

details
Indicates a system error code if operation is error. No information is output if operation is not error.

(e) Rename log

operation
The output items are as follows:

Item Meaning

renaming Renaming has started.

renamed Renaming has finished.

error An error occurred during renaming.

canceled Renaming was canceled.

object-type
Indicates whether the object is a folder or file.

object-name
Name of the object to be renamed.

Requestor information

host-name
Indicates the IP address (or host name) of the machine that requested renaming.

target-folder
Indicates the path after the renaming.

Attribute
No information is output.
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user-name
Indicates the desktop logon user name of the machine that requested renaming.

Receiver information

host-name
Indicates the IP address (or host name) of the machine that accepted the renaming. If the controller performed
the operation locally, the indicated IP address or host name is the same as that for the requestor.

target-folder
Indicates the path before the renaming.

attribute
No information is output.

user-name
Indicates the desktop logon user name of the machine that accepted renaming. If the controller performed the
operation locally, the indicated user name is the same as that for the requestor.

details
Indicates a system error code if operation is error. No information is output if operation is not error.

Note that when one of the following operations is performed, an error message appears in a window, but no
information is output to the log:

• Renaming was performed with no name entered as the name after renaming.

• Renaming was performed with 255 or more characters entered for the name after renaming.

• Renaming was performed with one of the following symbols entered as a character in the name after renaming:
\, /, :, ,, ;, *, ", <, >, |

(f) Attribute changes log

operation
The output items are as follows:

Item Meaning

attributes changing Changing of the attribute has started.

attributes changed Changing of the attribute has finished.

error An error occurred during changing of the attribute.

canceled Changing of the attribute was canceled.

object-type
Indicates whether the object is a folder or file.

object-name
Indicates the name of the object whose attribute was to be changed.

Requestor information

host-name
Indicates the IP address (or host name) of the machine that requested changing of the attribute.

target-folder
No information is output.

Attribute
Indicates the code of the attribute after the change. For the meaning of the output codes, see Table K-4.

user-name
Indicates the desktop logon user name of the machine that requested to change the attribute.
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Receiver information

host-name
Indicates the IP address or host name of the machine that accepted changing of the attribute. If the controller
performed the operation locally, the indicated IP address or host name is the same as that or the requestor.

target-folder
Indicates the path of the machine where the attribute was to be changed (higher path for object-name).

Attribute
Indicates the code of the attribute before the change. For the meaning of the output codes, see Table K-4.

user-name
Indicates the desktop logon user name of the machine that accepted changing of the attribute. If the controller
performed the operation locally, the indicated user name is the same as that for the requestor.

details
Indicates a system error code if operation is error. No information is output if operation is not error.

The table below shows the meaning of the codes output for Attribute.

Table K‒4: Output attribute codes

Code Meaning

A Archive

C Compression

H Hidden file

R Read-only

S System

(4) Output examples of file access logs
The following provides an example of outputting file access logs. In this example, a controller and an agent are
defined as follows:

Controller

• IP address: 10.100.100.1
• Desktop logon user name: Admin

Agent

• IP address: 10.100.100.2
• Desktop logon user name: User

The example assumes that the following operations were performed between the controller and the agent.

1. ABC.txt in D:\Temp on the controller was moved to C:\temp on the controller.

2. ABC.txt in C:\Temp on the controller was moved to D:\temp on the agent.

3. An attempt to copy ABC.txt in C:\Temp on the controller to A: on the agent failed (The operation was
canceled after the error occurred (error code 21)).

The following indicates the file access logs output in this example.
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(a) File access logs output on the controller

Figure K‒3: Example of file access logs output on the controller

(b) File access logs output on the agent

Figure K‒4: Example of file access logs output on the agent
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L. Version Changes

(1) Changes in version 09-50

• Windows 7 and Windows Server 2008 R2 have been added as applicable operating systems.

• Notes on upgrading the OS have been added.

• The minimum and recommended values for controller CPU performance have been changed.

• FLORA gd has been added as an applicable model for the remote control agent.

(2) Changes in version 09-00

• When user authentication is set on the agent, the dialog box for changing the user name and password can be
displayed when an attempt is made to connect to the agent from Remote Control Manager.

• A note stating that other products must not be installed befor the computer is restarted has been added to the notes
on installation.

(3) Changes in version 08-51

• Notes on using the file transmission functionality when both the English version and the Japanese version of JP1/
Remote Control exist have been added.

• Windows Server 2008 has been added as an applicable operating system.

• The check box for displaying the Readme file when the installation is completed has been deleted.

• Notes on playing sound of an agent in a security PC have been added.

(4) Changes in version 08-10

• Notes on setting authentication information have been added.

• Notes on connecting to a Windows Server 2003 agent have been changed.

• Notes on connecting to a Windows Vista or Windows XP agent have been changed.

• A description of the action to be taken when the OS does not start after an agent was installed has been added.

• JP1/Software Distribution and JP1/Remote Control series products that support Windows Vista have been added
as applicable products.

• A function that blacks out the display of a connected agent when the remote control mode of the controller is
exclusive has been added. A function that locks the agent PC if the blackout display restriction is forcibly lifted
has been added.

(5) Changes in version 08-00

• You can now create a user who is permitted to connect to an agent for only a predefined period of time.

• The contents of operations performed in the File Transfer window can now be obtained as logs by controllers and
agents.

• A function has been added that automatically switches flow control when a security PC connects to an agent.

• A function has been added that automatically locks a computer if a screen saver starts when a security PC has
connected to an agent.

• Windows Server 2003 (x64) has been added to the list of supported OSs for JP1/Remote Control Agent.

• You can now specify parentheses [(...)] in the installation directory name when installing JP1/Remote Control
Agent from JP1/Software Distribution.

• Descriptions have been added to explain that the screen saver does not start when a security PC has connected to
an agent, and that wallpaper, window animation, and the contents of a window being dragged are not displayed.
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(6) Changes in version 07-50

• A description has been added to explain that you must restart the computer if you change the setting of Agent is
started automatically in the start options for Remote Control Agent.

• A note regarding a Windows Server 2003, Windows XP, or Windows 2000 agent running in the monitoring mode
has been added.

• A description about the operations performed when a security PC connects to an agent has been added.

• Wildcards can now be used to register multiple permitted managers in one operation.

• Multiple users can now be managed by passwords and can be set as agent authentication information. In addition,
user authentication linked with the Windows Authentication facility can now be used. Due to this change, a
description about how to use the Windows functionality to set permissions for access via a network for Windows
users and groups has been added.

(7) Changes in version 07-11

• Notes on using the Windows authentication function for setting user information have been added.

• Windows Server 2003 (x64) has been added to the list of supported OSs for JP1/Remote Control Manager.

• You can now specify parentheses [(...)] for the installation directory name when installing JP1/Remote Control
Manager from JP1/Software Distribution.

• The dialog box that is displayed when Remote Manager attempts connection during user authentication on an
agent has been changed.

• The type of log information output by a controller and agent has been changed from Authentication failure (user
ID/password) to Authentication failure (user authentication). Accordingly, the contents of log information have
also been changed. Agent log information that is output when authentication for the permitted controller and user
authentication is successful has been added.

• A description of the NAT function available for JP1/Remote Control has been added.

(8) Changes in version 07-00

• Windows Server 2003 was added to the list of supported OSs. Windows 95 was removed from the list of
supported OSs.

• You can now specify whether to install the online help when installing JP1/Remote Control.

• You can now save and read controller properties.

• You can now specify that the amount of data to be sent to the controller from the agent is to be adjusted
automatically.

• From the operating environment of the controller, you can now specify that the agent window size is to be zoomed
to fit the window size of the controller.

• The Properties and Control Mode menus of the Remote Control window have been moved to below the Tools
menu.
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M. Glossary
action key

A key which the controller user can execute on agents to perform operations normally performed with function keys or shortcut keys.

agent
A PC on which Remote Control Agent is running.

agent list
A list used to manage connected agents arranged in a hierarchy.

agent manager
A function that is used to manage agent lists and connection history lists.

Agent Manager window
You can start this window from the Remote Control window. This is where you will be able to manage agents. You can organize the
configuration of agents by assigning names or grouping them.

Application page
A page that appears when the Application tab is selected in the Remote Control Process Viewer window. This page displays information
on the currently running applications.

connection history
A list that contains a chronological record of connected agents.

connection option
A connection-related option, such as a port number or optimization.

controller
A PC on which Remote Control Manager is running.

conversion wizard
A program used to convert a recording file to an AVI file.

customized transfer
A method used to transfer files to or from multiple agents at one time. The transfer destination folder may be the default folder or the
same folder as the transfer source folder.

Exclusive
A remote control mode. In this mode, an agent can be operated only by the local machine and rejects control from any controller or agent
to which the agent is connected. Other machines that are connected are all in view mode.

export
To write the settings required to issue connection requests from an agent to controllers. The settings are written from the agent to a
settings file, using the Requester Wizard.

file transfer list window
A window that lists the transfer files. The window is displayed when you open an agent file from the File Transfer window. From this
window, you can return files to agents or remove files left in the controller.

File Transfer window
A window that displays, in a tree view, the controllers and file information of agents connected to the controller. The window is started
from the Remote Control window. From this window, you can transfer files by simple operations such as drag-and-drop. You can also
create a folder or remove and delete files.

found agent
One of the agents that are included in the list obtained by a search performed in the Agent Manager window. A found agent is temporarily
displayed under the Network icon. When a found agent is moved to another folder, the found agent becomes an ordinary agent that can
be renamed and/or reconfigured.
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import
To load a settings file, which contains the settings required to issue connection requests from an agent to controllers, into an agent using
the Requester Wizard.

permitted controller
A controller that has given an agent permission to perform remote operations.

Process page
A page that appears when the Process tab is selected in the Remote Control Process Viewer window. This page displays information on
the currently running processes.

recording file
A file that contains screen information records storing the operations performed on the connected agent and the actions taken by the user
attending the agent.

remote control
A facility used to call the screen of a remote PC (agent) into the local PC (controller) via a telephone line or LAN, so as to operate the
remote PC as if it were a local machine.

Remote Control Agent
The program that runs on a machine subject to remote control operations. It executes operation instructions received from the controller
on the screen of the local PC.

Remote Control Manager
The program that runs on a machine which issues the remote control operation instructions.

remote control mode
The mode representing the level of permission a machine has in operating the agent. There are 3 modes; view, shared and exclusive. Both
the controller and agent sides can set their own remote control modes. The mode used in actual remote control operations will be
determined when the controller and agent establish a connection.

Remote Control Player
A program that is activated from the Remote Control window and used to play back recording files.

Remote Control Process Viewer window
A window used to abort applications and processes on an agent from a controller. This window opens on the agent when so instructed by
a controller.

Remote Control window
A window used for viewing and operating the agent window when performing remote control of the agent from the controller.

request agent
An entry that appears in the Agent Manager window (agent list) when an agent issues a connection request to a controller.

request server
An entity that can receive connection request from agents. By creating a request server in the Agent Manager window (agent list) on a
controller, you enable the controller to receive connection requests from agents.

Requester Wizard
A program that is used to configure a request for connection from an agent to a controller.

Security PC
A PC with an OS installed in read-only compact flash memory instead of a hard disk. A security PC can connect to an agent to remotely
control application software and files. Since the security PC does not have external storage such as a hard disk or a floppy disk, it provides
protection against information leakage resulting from lost or stolen media.

Shared
A remote control mode. In this mode, an agent can be operated from a controller or agent that is connected to the agent and shares
resources with the agent.
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View
A remote control mode. In this mode, the controller can view agent screens, but cannot operate on the agent.
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Index

A
abbreviations for products II
aborting

application or process on agent that is running on
Windows Me or Windows 98 176

application running on agent 177
process running on agent 178

acronyms V
action key 57, 105

input bar 94
list 108
registering and executing 107

adding
component 29

address bar 94
connecting with agent 96

agent 3
aborting application running on 177
aborting process running on 178
connecting to 149
connection request from 144
connection request to controller 7
disconnecting from 121
managing 136
rebooting 106
shutting down Windows system on 178
supervising 5

agent's log output information and message 258
agent attribute

changing 157
agent file

editing 124
manipulating 124

agent list 136
creating 138

agent list and connection history
editing 153

Agent Manager window
connecting from 149
customize operations in 159
exiting 137
screen components 136
starting 137

agent menu 136
agent path

recording 150
agent screen

making more readable and easier for operation 112
operating 3
recording and playing back display 5
recording and playing back display: overview 164
saving 113

agent screen display 165
recording: pause and restart 166
recording: starting and stopping 165
recording file: playback 167

recording file: setting up 166
recording status: display 166

Application page 177
argument defined as JP1/Remote Control reserved word 162
attaching Status window to desktop border 186
attribute of multiple items

batch change 158
attribute setting

request server 145
authentication

setting 72
authentication function

status according to combinations of version,
applicable OS, and user type 82

automatic dialing connection 40, 99
setting up 40

automatic disconnection 102
automatic transmission 111
auto-scroll 114
available NAT function 242
avi file

converting to 170

B
batch change

attributes of multiple items 158

C
canceling connection request 200
central manager 24
changing

agent attribute 157
device file 90
folder attribute 156
installation contents 29
network attribute 158
playback speed 169
remote control mode 189
remote control mode of agent in view mode 36
request server attribute 158

changing and viewing
item attributes 155

chat
overview 204
sending message 217

chat function 6, 203, 204
chat messages

saving and printing 221
chat server 204

operating environment setup 208
setting 87
starting 216

Chat Server icon
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